# Table of Contents

1. Introduction .......................................................................................................................... 1
2. Installing and Updating Origin ......................................................................................... 3
3. Origin Resources ................................................................................................................. 9
4. OriginPro ............................................................................................................................ 13
5. What’s New in 2018b ........................................................................................................ 17
6. The Origin Interface .......................................................................................................... 21
7. Origin File Types ............................................................................................................... 37
8. Import Data ....................................................................................................................... 39
9. Workbooks Worksheets Columns .................................................................................... 49
10. Matrix Book Matrix Sheet Matrix Objects ....................................................................... 75
11. Graphing .......................................................................................................................... 91
12. Customizing Graphs ....................................................................................................... 129
13. Graphical Exploration of Data ....................................................................................... 161
14. Gadgets .......................................................................................................................... 179
15. Data Analysis .................................................................................................................. 183
16. Statistics .......................................................................................................................... 207
17. How to Handle Repetitive Tasks .................................................................................... 217
18. Publishing and Export ..................................................................................................... 231
19. Apps for Origin ................................................................................................................ 241
20. Programming in Origin .................................................................................................... 247
21. Customizing Origin ........................................................................................................ 253
22. Sharing Origin Files ........................................................................................................ 263
23. Origin Toolbars ............................................................................................................... 267
Index .................................................................................................................................. 285
1 Introduction

Welcome, and thank you for using Origin!

Origin is a powerful data analysis and publication-quality graphing software, tailored to the needs of scientists and engineers. What sets Origin apart from other applications is the ease with which you can customize and automate your data import, analysis, graphing and reporting tasks.

Customizations can range from simple modifications to a data plot, saved as a graph "template" for later use, to customized data analyses which produce publication-quality reports, saved as an Analysis Template. Batch plotting and analysis operations are also supported, wherein templates are used for repeat analysis of multiple files or datasets.

We are confident that you will find Origin to be an effective tool for analyzing your data and presenting your findings. And to help you get the most from Origin, we offer first-class customer and technical support, training and consulting services.

In this guide, unless otherwise noted, "Origin" will refer to both Origin and OriginPro. OriginPro offers all the features of Origin, plus extended analysis tools for Peak Fitting, Surface Fitting, Statistics, Signal Processing and Image Handling.

The purpose of this guide is to try and present a broad overview of Origin's capabilities. We hope that new users will find this to be a valuable orientation to the Origin workspace and its primary features. For those who are already using Origin, we hope you will find useful information on new features and perhaps learn a thing or two about Origin that you had overlooked previously.

More detailed information is provided in the Origin Help file (Help:Origin from your Origin software's main menu) and numerous other learning resources exist. For a complete listing of available resources, see the Origin Resources chapter of this guide.

Some things to look for in this guide:

![File Icon]

We have added short tutorials to numerous topics throughout this guide. These short tutorials are intended to give you a quick introduction to a key Origin feature. These tutorials will be marked with this icon.

![Light Bulb Icon]

Also, sprinkled throughout this guide, you'll find tips on using Origin. These tips are marked with this icon.

![New Icon]

Features that are new to this version of Origin will be marked with this icon.

We like to get feedback from our users on ways to improve and expand Origin's data analysis and graphing capabilities. We would love to hear from you. You can find contact information in the Origin Resources chapter of this guide.
2 Installing and Updating Origin

2.1 Notes for Upgrade Users

Origin 2018b is a release for Maintenance Customers. If your Origin Maintenance has expired, visit this page for information on renewing your Maintenance.

- The Origin upgrade installs into a new program folder - it does not update a previous version. It is therefore not necessary to install or uninstall a previous version of Origin before upgrading.
- If you are upgrading from Origin 2018, the process should be pretty painless. Origin 2018 and 2018b share a common license file and User Files Folder. The first time you run Origin 2018b, it should be licensed and know where your User Files are located.
- If you are upgrading from Origin 2017, you will be prompted to pick a new User Files Folder (see Selecting a User Files Folder, below). You will also be asked if you want to transfer your User Files and other workplace settings. Origin 2017 and 2018/2018b all share a common license file so provided your Maintenance has not expired, you should not have to re-license your software. If your Maintenance has expired, you will need to re-license your Origin 2018b software (See Registering Origin, below).
- If you are upgrading from Origin 2016 or earlier, you will need to complete the license management process. When your upgrade is launched for the first time, a license dialog will display asking for your Product Key. If you have custom Origin files from your previous version, you can transfer them to your new User Files Folder. From the Tools menu, select Transfer User Files.

Lastly, we want to point out that your Origin software has some great new features. For more information on key features by version, see the originlab.com/VersionComparison page on our website.

2.2 Notes for Administrators of Multi-user Packages

Instructions for getting started with the multi-seat node-locked and concurrent network packages are available on the OriginLab website (originlab.com/GetStarted).

In addition to the InstallShield setup that runs from the Product DVD, an MSI installer and sample transform are available. The MSI installer is ideal for use at multi-user sites, as it can be used to build an Origin installation package for distribution. Information on the MSI installer and alternate deployment techniques can be found on our website:

- MSI Installation
- Silent Install
- Building an Installation Package
- Installing Origin on a Remote Access Server such as Windows Terminal Server or Citrix.

2.3 Installing Origin

Origin is a Windows application. You can run Origin on an Intel-based Mac from Boot Camp or by running a virtualization software. For more information, see the Running Origin on Mac using Virtualization Software, on the OriginLab website.

There are three steps that must be completed to prepare Origin for use:
Installation

Selecting a User Files Folder

License management

Both the Origin upgrade and the newly-purchased products install into a new program folder. Origin does not overwrite previous versions when upgrading, so your old version continues to function. Likewise, your original version does not have to be installed when running the upgrade.

If you are installing from a DVD, the startup program that launches when you insert the Origin DVD includes an Origin installation button. If the startup program does not automatically run, you can browse the DVD to launch the setup.exe.

2.3.1 Installing on a 64-bit Computer

When installing on a 64-bit computer, you have the option to install 32-bit or 64-bit Origin, or both. The 64-bit version has much more memory at its disposal, so it will handle larger data sets. See the Support area of the OriginLab website (originlab.com/Support) for more information about 32-bit versus 64-bit installations.

If you install 32-bit only (or 64-bit only), and you later want to install 64-bit (or 32-bit), run the Origin Add or Remove Files program located in the Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator permissions). When the Origin setup program starts, select the Modify option.

2.3.2 How to Proceed if You Already Have the Origin Evaluation Installed

If you already have the evaluation version of Origin installed on your computer, you can convert it to the full product or upgrade:

- If you have purchased the Origin package with node-locked license management, open Origin and then select Convert Evaluation to Product... from the Help menu.
- For all other license management packages, run the Origin Add or Remove Files program located in the Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator permissions). When the Origin setup program starts, select the Modify option and then select Install Product (requires serial number).

2.3.3 How to Correct or Change your Serial Number After you Complete an Installation

If you installed Origin with an incorrect serial number, you can correct it by running the Origin Add or Remove Files program located in your Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator permissions). When the Origin setup program starts, select the Modify option and then click Yes to change your serial number.

Note: If you are upgrading to Origin 2018b from Origin 2018, the 2018b installer will automatically use your Origin 2018 serial number. You will not see a serial number page when you choose to Install or Modify. If you need to change your serial number, you must uninstall Origin 2018 first and do a fresh install.

2.4 Selecting a User Files Folder

Each Windows login user must maintain a User Files Folder (UFF) for storing Origin user data:
• If you are upgrading from Origin 2018, your User Files Folder (UFF) location is unchanged.
• If you are upgrading from Origin 2017 or earlier, you will be prompted to pick a location for a new UFF. You must choose a different path from your old UFF.
• If you are upgrading from Origin 2017, you will also be prompted to transfer the contents of your old UFF and your toolbar and workspace configurations.
• If you initially decline to copy your user files from an earlier version, you can do so by running the Origin software and selecting Tools: Transfer User Files. For more information, see Transfer User Files.

Consider these points in selecting your UFF:

• If you have a mobile computer, it is best to select a location on your computer rather than on your network.
• For non-mobile computers, you can select a location on the computer or on the network, as long as you have stable access to the folder.
• Do not select the same UFF as other Origin users. To learn how to share custom files with other Origin users, please see the chapter on Sharing Origin Files, later in this Guide.

Each time Origin starts, the program checks to see that your UFF is accessible. If Origin cannot connect to the UFF, you will be prompted to select a new location for the UFF. Note that you can change the location of your UFF at any time while running Origin. From the Tools menu, select Options and then click the System Path tab.

2.5 Licensing Origin

All Origin packages include license management. The type of license management provided with your package is determined at the time of your Origin purchase.

2.5.1 Node-locked

Each Origin computer requires a license to run Origin. The license is obtained from the OriginLab website by entering a Product Key in the License Activation dialog when you start Origin. In-dialog instructions are provided for computers with no internet access.

2.5.2 Concurrent Network

Each Origin computer must connect to a FLEXnet license service to run Origin. Your IT department or Origin administrator installs a FLEXnet license server provided by OriginLab (available from the Origin DVD), obtains a license for this server from the OriginLab website, and then sets up a license service. The license service counts and restricts the number of Origin computers that can run concurrently. For more information, see the Help Center on the OriginLab website (originlab.com/HelpCenter).

2.5.3 Dongle

A dongle (USB hardware key) is provided with the Origin package and must be present in the computer’s USB port to run Origin. Dongles are version-specific. The dongle license is installed by Origin.

2.6 Registering Origin

Registering Origin is required to obtain product support from OriginLab and the team of Origin distributors. Registration also activates Origin's Check for Updates menu command (Help: Check for Updates), allowing
you to obtain patch and help file updates directly from your Origin software. In addition, Origin's App Center
dialog, which provides direct access to Apps and App updates from your Origin software, requires that your
installation be registered.

For Node-locked licenses, registration is completed automatically when you enter a Product Key into the
License Activation dialog box that opens when you start Origin. To verify that you are registered, select About
Origin from the Help menu. The dialog should display the Registration ID that is assigned to your Origin
installation.

For all other license management packages, open Origin, and then select Register on-line... from the Help
menu to open the Registration dialog box. Use the Registration dialog to register your Origin installation on
the Origin website. During this process, a Registration ID is issued. Enter or copy and paste this Registration
ID into the Registration dialog to complete the process. The About Origin dialog should now display your
Registration ID.

2.7 Maintenance

Most Origin packages are sold with the first year of Maintenance included. Maintenance provides you with free
Origin upgrades, and may also include priority technical support, discounts on Origin training and consulting
services, and a home-use license.

- To check if your Origin package includes Maintenance, select the Help menu and then select About
  Origin. If your package includes Maintenance, the About Origin dialog will show your Maintenance
  expiration date.
- To learn about the benefits of Maintenance, contact OriginLab or your local Origin distributor.
- As your maintenance expiration date approaches, Origin will display a maintenance expiration message
  with a link to the OriginLab website to learn how to renew your maintenance. This reminder message
  provides a check box to prevent showing in the future.

2.8 Service Releases

When called for, OriginLab publishes free service releases (patches). A service release typically provides bug
fixes and may include some minor improvements. All customers are encouraged to apply service releases to
ensure that your Origin software performs correctly. To check if a patch is available, select the Check for
Updates command from the Help menu. Patches are also available from the Support area of the OriginLab
website (originlab.com/Support).

2.9 Upgrading your Origin Version

OriginLab regularly releases new versions of Origin, adding features and feature improvements based on
customer input. Customers with maintenance are entitled - and encouraged - to use the most recent Origin
version. After a new version release, OriginLab and the team of Origin distributors notify maintenance
customers by email. However, to make sure you receive notification of a new version release, please create an
account on the OriginLab website (originlab.com) and select the check box in your user profile to receive
"product updates".
2.10 Setting the Origin Display Language

Origin packages sold to organizations in a limited number of countries, including Japan, Germany, Switzerland, Austria, and Liechtenstein, may support running Origin with English display, or with Japanese or German display. To access this language control, select Change Language from the Help menu.

2.11 System Transfers - Deactivating a License

2.11.1 Node-locked Licenses (Computer ID-based)

A system transfer is required if you plan to replace your licensed Origin computer with a different computer.

- If Origin can still be used on your computer:
  
  Open Origin and then select Deactivate License from the Help menu. After successful deactivation, your Computer ID will be removed from OriginLab’s server so that you can install and activate on another computer.

- If your licensed Origin computer is no longer available:
  
  Complete the "System Transfer Request Form" available from the Support area of the OriginLab website.

2.11.2 Concurrent Networks

A system transfer is only required if you need to replace the FLEXnet license server. A system transfer is not required when replacing an Origin computer.

To obtain a replacement FLEXnet server license file, complete the "System Transfer Request Form" available from the Support area of the OriginLab website.

2.11.3 Dongles

A system transfer is not required when replacing a dongle-managed Origin computer.

2.12 Uninstalling Origin

To uninstall Origin, run the Origin Add or Remove Files program located in the Origin program icon folder, or use the Windows Uninstall or change a program tool. In both cases, the Origin Setup program displays providing options to Modify, Remove, or Repair. Select the Remove option and complete the wizard as prompted.

The Remove program deletes all folders and files that were installed by the Origin setup program. It also deletes folders and keys created by the installer in the Windows registry.
3 Origin Resources

The following tables list key Origin resources available to you. If you purchased Origin from a local distributor, your Origin distributor may provide additional resources. Please contact your distributor to learn more.

### 3.1 Direct Support Resources for Origin

<table>
<thead>
<tr>
<th>Technical Support</th>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Contact information for OriginLab or your Origin Distributor • Report a bug • Suggest a feature</td>
<td>originlab.com/Support</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chat Online</th>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Chat online with an OriginLab representative</td>
<td>originlab.com... and click the Chat icon in the upper-right corner</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Forum</th>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Share information with and get help from the Origin user community</td>
<td>originlab.com/Forum</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Training and Consulting</th>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Making optimal use of OriginLab products • Help in developing custom tools for your particular application</td>
<td>originlab.com/Support</td>
</tr>
</tbody>
</table>

### 3.2 Resources Installed with your Origin Software

<table>
<thead>
<tr>
<th>Origin Central</th>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Load graphing and analysis samples • Open recent and autosaved files • Find Origin Apps • Learning Center for access to tutorials, videos, blog and forum</td>
<td>Help: Origin Central (or press F11)</td>
</tr>
</tbody>
</table>
For Information On ... | Go Here
--- | ---
**Help Files**<br>• Online or local (CHM) Help for<br>Origin (GUI, Programming) | Help: Check for Updates (to update Help files)<br><br>**Context-sensitive Help**<br>• Control-by-control explanation of<br>Origin dialog boxes<br>• The dialog box must be open<br>• Some dialogs have multiple<br>sections/tabs and you may have<br>to click on that section/tab to set<br>the focus | Press F1<br>or<br>Click [?] in the upper-right corner of the dialog box<br><br>**Quick Help**<br>• Problems or questions that arise<br>while using Origin | View: Quick Help<br>or<br>Help: Origin: Quick Help<br><br>**Tutorials**<br>• Step-by-step instructions on<br>performing many Origin<br>operations, from the simple to<br>the complex | Help: Origin: Tutorials

### 3.3 Online Resources for Origin

<table>
<thead>
<tr>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Online Documentation</strong>&lt;br&gt;• Product documentation</td>
<td>originlab.com/Doc</td>
</tr>
<tr>
<td><strong>Help Center</strong>&lt;br&gt;• Resources list&lt;br&gt;• Installation and License Documentation&lt;br&gt;• Contact Info</td>
<td>originlab.com/HelpCenter</td>
</tr>
<tr>
<td></td>
<td>For Information On ...</td>
</tr>
<tr>
<td>---</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Video Tutorials</td>
<td>Help with a wide range of Origin’s key features</td>
</tr>
<tr>
<td>Webinars</td>
<td>Live and recorded webinars highlighting key features</td>
</tr>
<tr>
<td>Origin Blog</td>
<td>Blog posts with plenty of software tips and tricks</td>
</tr>
<tr>
<td>Case Studies</td>
<td>How others are using Origin in their work</td>
</tr>
<tr>
<td>Graph Gallery</td>
<td>Outstanding examples of Origin graphs, many of them submitted by the Origin community</td>
</tr>
</tbody>
</table>

Information on key Origin features often can be found by just doing a quick web search. Open a browser and search on phrases such as... “Origin shortcut keys”, “LabTalk graph legend”, or “OriginC NAG functions”. 
4 **OriginPro**

**OriginPro**, the professional version of Origin, provides all of the features of Origin, plus additional analysis tools and capabilities.

If you don't know which product you have -- **Origin** or **OriginPro** -- look to the title bar.

If you have already purchased the standard version of Origin, you can upgrade to OriginPro by contacting your Origin representative.

### 4.1.1 Curve Fitting

In addition to Origin's linear and nonlinear curve fitting capabilities, OriginPro includes support for the following:

- Linear fitting with X error.
- Nonlinear fitting with X and Y errors (orthogonal regression).
- Fitting with implicit functions (orthogonal distance regression).
- Fitting Comparison: Fit and rank all functions in a category, compare two models to one dataset or two datasets to one model.
- Global fitting of multiple curves using different functions, with the option of sharing parameters.

For more information, see these web pages: [Linear and Polynomial Fitting](#) and [Nonlinear Fitting](#).

### 4.1.2 Surface Fitting

With OriginPro, you can perform 3D Surface Fitting. Choose from 21 built-in surface fitting models including Gauss2D, DoseResponse2D, Exponential2D, and Polynomial2D; or define your own function.

- Fit worksheet data (XYZ) or matrix data (Z values).
- Locate and fit multiple peaks using one of several peak identification methods.
- Automatic peak parameter initialization.
- Apply constraints and bounds to parameters and fix parameter values.
- Output parameter and statistical results plus residual curves.
- Find specific Z values along the fit surface and include them in your output.
- Option for automatic recalculation of results and saving tool settings to a Theme file for repeat use.

For more information, see this web page: [Surface Fitting](#).
4.1.3 Peak Fitting

OriginPro includes the Peak Analyzer tool with support for the following:

- Peak finding (Local Max, Window Search, 1st Derivative, 2nd Derivative, Residual after 1st Derivative).
- Detect and subtract baseline (Constant, Dataset, XPS, End Points Weighted, Straight Line, User-Defined, None).
- Fit Peaks with built-in or user-defined functions.
- Fit individual peaks with different fitting functions.
- Fit Baseline as part of the peak fitting process (user-defined or built-in functions).
- Control fit parameters (fix, share, set bounds).
- Batch peak analysis using a predefined Theme file.

For more information, see this web page: Peak Fitting.

4.1.4 Statistics

OriginPro includes support for advanced statistical analyses in these areas:

- Descriptive statistics (cross-tabulation, distribution fit, correlation coefficient, partial correlation coefficient).
- ANOVA (one-/two-way repeated measures, three-way).
- Multivariate analysis (principal components, cluster, discriminant/canonical discriminant analyses; partial least squares).
- Survival analysis (Kaplan-Meier, Cox Proportional Hazards, Weibull Fit, test of equality of survival functions)
- Parametric hypothesis tests (two-/pair-sample t-Test on rows, one-/two-sample test for variance, one-/two-sample proportion test).
- Nonparametric tests (one-/paired-sample Wilcoxon signed rank, paired-sample sign test, Mann-Whitney, two-sample Kolmogorov-Smirnov, Kruskal-Wallis ANOVA, Mood's median test, Friedman ANOVA, support for simultaneous tests).
- Power and sample size (one-/two-/paired-sample t-test, one-/two-proportion test, one-/two-variance test, one-way ANOVA).
- ROC curve analysis.

For more information, see this web page: Statistics.

4.1.5 Signal Processing

In addition to Origin's standard suite of signal processing tools, the following are available in OriginPro:

- Signal transforms (short-time Fourier analysis, Hilbert transform, 2D FFT/2D IFFT).
- Filtering (IIR filter design, 2D FFT filter).
• Correlation (2D correlation).
• Wavelet Analysis (continuous wavelet transform, discrete wavelet transform, inverse discrete wavelet transform, multi-scale wavelet decomposition, smoothing, noise removal, 2D wavelet decomposition, 2D wavelet reconstruction).
• Rise-time Gadget (linear search, histogram, largest triangle).
• Decimation (moving average, finite impulse response).
• Coherence.
• Envelope curves (upper and/or lower, smooth during envelope detection).

For more information, see this web page: Signal Processing.

4.1.6 Gadgets

Origin Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. While there are specific Gadgets for each analysis, all work by allowing you to graphically and interactively position a region-of-interest (ROI) object around the data that you wish to analyze. OriginPro includes these additional Gadgets:

• Cluster Gadget (stats on points inside/outside the ROI; with support for masking, editing, copying and deleting points).
• 2D Integration Gadget (integration on image plot or contour plot from matrix or worksheet data).
• Rise-time Gadget (analyze rise/fall time of stepped signals).

For more information, see this web page: Exploratory Analysis.

4.1.7 Image Processing

Origin and OriginPro include a collection of easy-to-use image processing tools. OriginPro includes additional tools in the following areas:

• Image adjustments (function lookup table, leveling).
• Image conversion (dynamic binary, threshold, RGB merge/split, image scale).
• Spatial filters (user filter).
• Arithmetic transforms (alpha blend, extract to XYZ, image simple math, math function, morphological filter, pixel logic, replace background, subtract background, subtract interpolated background).

For more information, see this web page: Image Processing.

4.1.8 Apps

Many add-on Apps require an OriginPro license to run. Some of these Apps are listed below. OriginPro-only Apps will be listed in the Origin File Exchange with a red PRO symbol beside them.

• Allan Variance
• Cyclic Voltammetry
• Logistic Regression
• Piecewise Fit
• Simple pCLAMP Analyzer
• Advanced pCLAMP Analyzer
• Piecewise Smooth
• Chi-Square Test
• Equivalence Test
• Sequential Fit
• Redundancy Analysis
• 2D Confidence Ellipse
• 3D Confidence Ellipsoid

For general information on Apps visit www.originlab.com/apps.
5 What's New in 2018b

5.1 Origin 2018b New Feature Highlights

- **Workbook and Matrix Preview**: Preview in Project Explorer and Windows File Explorer.
- **Matrix book as Embedded Worksheet**: Add Matrix Book as embedded sheet in a Workbook.
- **Enhanced Master Page**: Adds menu item to open and customize improved Master Template and apply it to selected graphs for print or export.
- **Multi-layer Graph Customization**: Customize layer and plot properties, axis scale and style, and show/hide plots in multiple layers, simultaneously.
- **New Fit Layers to Page Dialog**: Fit all layers to the page while maintaining layer relationships, relative size, and object scaling. Easier exporting of graphs with exact width and height specifications.
- **New Window View**: Allow the preview window in analysis dialogs and Apps to be resized by the user.
- **Active Window Indicator**: The active window will have a customizable border around it for quick identification.
- **Multi-page PDF Export**: Export multiple graphs, such as all graphs in a folder or in an entire project, to a single, multi-page PDF file.
- **Improved Audit Log**: LabTalk commands and system variables to turn on an Audit Log for all newly-created projects, for consistent project management.
- **Individual Project Backups**: Backup folder and individual file backup for each project.
- **New Python API**: Origin API for calling Origin from Python.
- **General App Improvements**: Better support for installation of bundled fitting functions (*.FDF) and templates (*.OTPU,*.OTWU,*.OTMU, etc) and new Apps for 2018b.

5.2 New Features by Category

5.2.1 Ease of Use

- In addition to Graph windows, Workbooks and Matrix Books now support Extra-large icon view, Previews and tooltips in Origin’s Project Explorer; Extra-large icon view and Previews in Windows Explorer.
- Backup folder (\Backup) parallel to User Files Folder with easy menu access (Help:Open Folder:Project Backup Folder).
- Every project now gets its own backup file. Previously, there was only a single backup of the most-recently saved project file.
- User-customizable active window "halo" in the Origin workspace and in Project Explorer.
- For simplicity, project folders now shown only in top panel of Project Explorer. Restore the previous behavior by setting LabTalk System Variable @PEF = 1.
- Master Page improvements including new menu access (File: New: Master Page), customizable root folder Master template with buttons for applying same dimensions to
other graph windows and toggling orientation (landscape or portrait) of Master template, plus mechanism to selectively skip Master objects.

- Support **natural naming of custom colors** in the Colors dialog box (previously, colors were identified only by their hex values).
- **English date format** support in Chinese and Japanese Origin.
- **Transfer** equation image and sample curve files with function definition files (*.FDF) when transferring **User Files**.
- Greatly improve the speed of (ETAS INCA) **MDF file import**.
- Worksheet-embedded graphs with **gadget results** are updated on changes to source data.
- Red dot on the **Add Apps** icon in the Apps gallery adds another notifier that updates are available for installed Apps.
- Autosave **UNTITLED** projects.

### 5.2.2 Graphing

**Graph Customization**

- When labeling a data point with the **Annotation tool**, Alt + drag moves the label to another point; Ctrl + Shift + drag allows copying the label to another data point.
- Support for **tick label tables** in Trellis Plots.
- Support for a **Box Chart variant for Trellis Plots**.
- Support for extending **axis arrows** beyond axis ends.

**Labels, Legends, Color Scales**

- Support for **scaling of fill patterns**.
- More flexibility for **color scale** (2D plot support, independent color scales).
- System variable to control **double-click legend behavior** (@LDC=1 opens Properties, @LDC=0 invokes in-place edit mode).

**Plot Manipulation**

- **Object Manager shortcut menu commands** to show or hide error bars and data labels.
- Object Manager support for grouping or ungrouping of plots.

**Graph Page and Layer**

- New **Fit Layers to Page** and **Fix Scale Factors** dialogs, useful for removing white space around outside of layers of panel graphs, with option to maintain aspect ratios.
- New **Layers** tab at the Page-level in **Plot Details** allows applying customizations to multiple layers simultaneously.
- Improvements to adding labels to graphs in the **Merge Graph Windows** dialog, including support for Roman numerals.
• **Scale In** toolbar button now **zooms all linked plots**.
  • Plot Details Page-level **Print/Dimensions** tab check box to **Keep Aspect Ratio** when adjusting page size.

**3D and Contour Plots**

• "**Total**" label for 3D Stacked Column and Bar graphs.
• More **arrow shapes** for 3D OpenGL graphs.
• Two-dimensional **annotation** of 3D Scatter plots.
• Customize a **single bar** in 3D XYZ Bar graphs
• Improved **preview** of 3D OpenGL graphs in X-Function dialog boxes.
• **Dynamic size** (number of rows & columns) support for **Virtual Matrix**.

**Batch Plotting**

• Improvements to batch plotting **user-interface**.
• Add data from different sheets or books into an **existing graph**.
• Combine data from different sheets or books into **one new graph**.

**Graph Export**

• Export graphs as a multi-page **PDF** file.
• Rename exported graphs with **Project Explorer folder name**.

**5.2.3 Analysis**

• Support for **embedding matrix sheets** in the workbook, extends Analysis Template concept.
• Output of **standard error of derived parameters** in analysis summary tables.
• Improved calculation of **P value** in nonlinear fitting tools.
• Addition of two built-in implicit functions, **SolarCellIV** and **ModDiode**.
• Support for defining **implicit functions using integrals**.
• Improved labeling of Principal Components **loading plots** and **biplots**.
• Improved labeling of **Frequency Counts** and **2D Frequency Counts/Binning** output sheet.
• Addition of **Fourier Self-deconvolution** method for finding peaks (OriginPro Only).

**5.2.4 Workbook and Worksheet**

• **Sheet Copy** and **Paste** across Origin sessions.
• Parameter and User-defined Parameter rows in worksheet now allow **data format options** (Text & Numeric, Time, Date) to be set in the **Worksheet Properties** dialog, **Format tab**.
5.2.5 Batch Processing

- Save Batch Processing dialog settings into an Analysis Template.

5.2.6 Programming

- LabTalk command to turn on general Audit Log.
- Improved LabTalk support for install and uninstall of files installed by drag-and-drop.
- Default value of second parameter of Origin C function `GetParameterResults()` changed to 0.
- Support accessing page properties by Origin C functions: `Pagebase::SetProp()` and `Pagebase::GetProp()`.
- LabTalk support for control of Master Items on screen.
- LabTalk command to remove or restore dividers.
- `finFiles` X-Function variable recursive for finding files in recursive folders.
- System Variable control of project format (*.OPJ or *.OPJU).
- Origin API for calling Origin from Python.

5.2.7 New Apps for 2018b

- **Distributed Batch Processing**: Distribute multiple data files to multiple cores for faster batch analysis (Pro Only).
- **OPJ Packer**: Pack all relevant files such as Fitting functions along with the OPJ, to share with colleagues.
- **2D Smoother, 3D Smoother**: Smooth 2D or 3D data using various methods (Pro Only).
- **Fit Convolution**: Perform fitting with convolution of data and response function.
- **Rank Models**: Fit multiple models and rank results to explore best fitting model for your data (Pro Only).
- **Graph Maker**: Build a multi-panel graph with categorical data by drag-and-drop, with plot style assignments from columns for color, shape, size etc.
- **Factor Analysis**: Supports Principal Components and Maximum Likelihood methods (Pro Only).
- **Dynamic Time Warping**: This app calculates the warping distance of 2 series (Pro Only).
- **Movie Creator**: Improved to support creating movies from multiple selected graphs.
6 The Origin Interface

6.1 The Origin Workspace

This chapter contains basic information on navigating the Origin workspace. Long-time Origin users can skim this chapter.

6.1.1 Windows File Explorer Previews

While not part of the Origin interface, you can use Windows File Explorer (previously "Windows Explorer") to preview graphs in a project file.
• Windows Explorer’s **Large** or **Extra large icons** views (right-click in File Explorer and choose **View**: **Large Icons** or **Extra Large Icons** or select from the Explorer **View** menu) will show an image of the last active graph before the project file was saved.

• Open the Preview Pane (**ALT + P**) and scroll through all graphs in the project file.

### 6.1.2 Origin Menus and Menu Commands

- **Context-sensitivity of menu bar and menus**: The menu bar and menu commands are context-sensitive; they change as you change window type (from worksheet to graph to matrix, for instance). Only menus pertinent to the active window will display.

- **Menu bitmaps, toolbar buttons and shortcut keys**: Some menu commands also have bitmaps that display to the left of the command. Additionally, you may see a shortcut key combination listed to the right of a menu command. The button bitmap and the shortcut keys indicate alternate ways to access the same functionality.

- **Shortcut menu commands**: Many commands are available from shortcut menus. To open a shortcut menu, right-click on an Origin object (worksheet window, graph axis, text object, etc.). Only pertinent menu commands will show.

- **Collapsible menus**: By default, main and shortcut menus in Origin are “collapsed”, meaning they display an abbreviated set of commands. When you use a menu item which isn’t included, it is added to the menu.
• **Most frequently used analysis menu commands**: Most-recently used menu commands will appear at the bottom of the analysis menus (Worksheet, Analysis, Statistics, Image, etc.). This gives you quick access to tools when performing repeat operations.

• **Custom Menu Organizer**: Since Origin 8.1, Origin users have been able to use the **Custom Menu Organizer** to add or remove menu items. To learn more, see the chapter **Customizing Origin**, later in this Guide.

### 6.1.3 Origin Toolbars

Use the **Customize Toolbar** dialog box (**View: Toolbars**) to control toolbar display and reset or reinitialize toolbars.

- **Customize toolbar button appearance**: Use controls on the **Options** tab of the **Customize Toolbars** dialog box to modify button and toolbar appearance.
- **Dock/Float a toolbar**: Toolbars can be undocked and made to float on the workspace. To float a toolbar, hover over the left-end of the toolbar. When the pointer becomes a four-headed arrow, drag the toolbar off of the toolbar space. To return the toolbar to its former docked position, double-click the toolbar title bar.
- **Hide/Show a toolbar**: Clicking the **Close** button on a toolbar removes the toolbar from view. To restore a hidden toolbar, open the **Customize Toolbars** dialog box and select the toolbar.
- **Hide/Show a button**: Clicking the tiny arrow at the end of toolbar to turn on/off some buttons on a toolbar.
- **Move button location**: Alt+drag a button to move it to a new location within or among toolbars. Alt+drag to blank workspace to create a new toolbar. Alt+drag a button to child window till X shows to remove a button.

### 6.1.4 Origin Central

**Origin Central** is a "startup" dialog intended to give you quick access to key files and support information. Origin Central was introduced in Origin 2017 and was updated for 2018.

To open the dialog, choose **Help: Origin Central** or press F11.
• Create a new workbook or matrix book.
• View and load sample graphs, including sample data and notes on re-creating the graph.
• Load analysis samples and templates.
• Quick links to recent Origin files, including Unsaved Files†.
• Browse the Learning Center tab for tutorials and videos.
• Move files from your previous User Files Folder to your new User Files Folder.

† If you have closed a project without saving your changes, you may be able to recover your work if you have Autosave Unsaved Project enabled (default setting in Tools: Options > Open/Close tab). Open Origin Central and click on the Projects tab and look for your file under Unsaved Files. Alternately, click Help: Open Folder: Autosave Folder and look for your file. By default, projects are kept for 7 days.

6.1.5 Project Explorer

Project Explorer (PE) is a tool to help you organize the contents of your Origin project files (OPJ).
Project Explorer is split into two panels. The primary panel shows the OPJ folder structure. The sub-panel shows windows contained in the folder that is highlighted in the primary panel.

- Right-click the PE title bar or click the drop-down menu to display the panels stacked (Vertical Alignment) or side-by-side (Horizontal Alignment).
- Context menus in both panels provide options to delete, hide, print, etc. Menu options vary depending on what is selected or where you have right-clicked.
- Multiple-selection of windows in the sub-panel is supported (press Shift or Ctrl while clicking with your mouse).
- The sub-panel supports differing views of windows: Details (default), List, Small Icons, Large Icons, Extra Large Icons.

In any view, mousing over a window icon shows a popup preview of the graph, worksheet, matrix or layout window. Notes window content is shown in a tooltip.

When displaying windows as Extra Large Icons, the PE sub-panel displays a thumbnail of graphs, layout windows, workbooks and matrix books. Notes window content is shown in a tooltip.
To disable PE previews, open the Script Window (Window: Script Window) and type one or both of the following, then highlight the text and press Enter:

@PESS=-1; //turn off window preview in PE, show window comments as tooltip

@PESH=0; //turn off window comments tooltip

When you set the value of a system variable using the Script Window, you are altering Origin's behavior for the current session only. To set the value of a system variable across sessions, see this FAQ.

1. Select Help: Open Folder: Program Folder, click the Samples subfolder, then drag the file Tutorial Data.opj to your Origin workspace.

2. By default, Project Explorer is docked to the left side of the Origin workspace in auto-hide mode. Mouse over the Project Explorer tab to show the PE window.

3. Click on the "push pin" icon on the PE title bar to pin the window in the docked position.

4. By default the sub-panel is in Details view. In this view, window metadata such as Name, Size and Comments show below these column headings. Try dragging column headers to reorder them.
5. Right-click on the column headings and show or hide any of the headings by checking or unchecking the box beside each.

6. To add a comment in the Comments field, click once, pause briefly and click a second time. This puts you into edit mode. Enter a comment.

7. To change the Name of a window, right-click in the row and choose Rename. By default, the Name field displays the window Short Name (all windows must have a Short Name; Long Names are optional). To have the Name field display the window Long Name, click the SN button to the right-side of the editable Name field. If the Long Name does not exist, you can enter one.

8. In the top panel of Project Explorer, scroll to the folder 3D Surface with Point Label and click on it. The sub-panel shows that there are three windows in the folder. Note that the worksheet window eastcali3053 is bold indicating that it is the “active” window - the window that is being acted upon as well as the window that determines what operations are available. There is also a Notes window and a matrix window named MBook4.

9. In the sub-panel, double-click on MBook4 and note that it is now bold and has a magenta “halo”, indicating that it is the active window. You will also see that the whole window (in the workspace) displays with a halo which can be customized in color with the system variable @AWC-- another indicator that this is the “active” window. Double-click on this MBook4 icon again and note that the icon is now dimmed. Note also that the actual window disappears from the workspace. This is because MBook4 is now hidden. Double-click the MBook4 icon again and the window is restored and made active.

10. With MBook4 active, click Plot > 3D: Surface: 3D Colormap. This creates a 3D colormap surface graph (close the attention message). Note also that a new window -- Graph1 -- has been added to the sub-panel of Project Explorer.

11. Right-click in an empty portion of the sub-panel and choose View: Extra Large Icons. Note that Graph1 now displays a graph thumbnail.

12. Right-click again and choose View: Large Icons. Note that windows are now represented by icons but if you hover on them, you can see the window contents as a pop-up.
6.1.6 Apps Gallery and App Center

Apps are add-on applications for Origin that perform specific graphing and/or analysis tasks. A small number of Apps that are broadly applicable to science and engineering fields are pre-installed with your Origin software.

Origin 2018 introduced the App Center dialog for browsing, updating or downloading Origin Apps. This new dialog gives you direct access to all of the Apps on the OriginLab File Exchange without you having to open a browser and navigate there.

To launch the App Center, click the Add Apps button that appears on all tabs of the Apps Gallery, docked at the right-side of your Origin workspace.

- Installed and Up-to-date Apps will appear in the App Center with a green check mark beside them
- Installed Apps for which there is a newer version will appear with an Update icon beside them
- Those not installed will appear with a clickable Download and Install icon beside them

You can also see a list of installed Apps by browsing the Apps Gallery. Click View: Apps to open the Gallery if it is not open.

For more information on Apps, please visit www.originlab.com/apps.
6.1.7 Object Manager

The Object Manager is a dockable panel that opens to the right side of the workspace, by default. Use the Object Manager for quick manipulation of graph layers and data plots in the active graph window:

- Select an element (layer, plot group, data plot or special point) in the Object Manager to select the corresponding element in the graph window and vice versa.
- Hide or show plot elements by clearing or selecting the corresponding check box in the Object Manager.

Right-click on an element in the Object Manager panel and choose from additional actions, including:

- At the graph level, change Object Manager list order.
- At the layer level, change layer order.
- At the plot level, show or hide plots of the same name.
- Within a plot group (labeled as gN), ungroup, toggle plot dependency, change plot type or re-order plots by dragging or by shortcut menu command.
- Remove a plot from the graph window (not the same as hiding).
- Access the Plot Details, Layer Contents and Plot Setup dialog boxes.

6.1.8 Origin Child Windows

Beginning with Origin 2018b, active windows -- the window that will be acted upon by graphing and analysis operations -- displays a colored frame to make the active window more obvious. You can customize the active window indicator properties (frame color, where the frame shows, frame line style) with "@ System Variables" @AWC (color) and @AWI (style).
• **Origin Workbooks**: The Origin workbook provides a framework for importing, organizing, analyzing, transforming, and plotting your data. The tabbed workbook contains between 1 and 1,024 sheets. Each sheet may contain more millions of rows and more than 65,000 columns of data. In addition to your data, workbook windows may also store graphs, annotations, column-based functions, scripts and programmable button objects, LabTalk variables and import filters.

• **Origin Matrix Books**: Like the worksheet, a matrix sheet is a grid of cells, arranged in rows and columns. The primary difference is that in the worksheet, each column is a dataset and each dataset can be configured to contain various types of data (text, text & numeric, numeric (double), numeric (int), etc). In contrast, the matrix is a single, numerical dataset of Z values, related in the XY plane by row (Y) and column (X) index numbers. The matrix book contains between 1 and 1,024 sheets. Each sheet can contain multiple matrix objects (up to 65,504 on a 64-bit OS).

• **Graphs**: The graph window is the primary container for your data plots. Origin supports over 100 chart types, chosen specifically for their applications in various technical fields. Each chart is created using a built-in, user-modifiable graph template that can be saved with your custom settings. In addition to data plots, the graph may also contain annotations (text and drawing objects) or button objects that, when triggered, perform some custom graphing or analysis task. Graph windows can be inserted into worksheet cells or "floated" on worksheets (outside the grid) in a workbook window.

• **Function Graphs**: The function graph is a specialized graph window that displays a curve described by a function. The function graph differs from other Origin graphs in that it is not produced from a dataset of discreet values (though you can generate data after plotting).

• **Layout Pages**: The layout window allows you to combine and arrange graph and worksheet windows and various annotations onto a single "display panel." It is used primarily for creating presentations.

• **Excel workbooks**: Excel workbooks can be opened or created in Origin. Workbooks can be saved separately or as part of your Origin project file.

• **Notes**: The Notes window is a text-only window used for recording analysis procedures, making notes to students and colleagues, and cutting and pasting text from other applications.

**Note**: For more information on Origin's child windows, see


**To save an Origin child window independently of the Origin project file:**

• Select File: Save Window As... to save active window. File extensions OGW(U), OGG(U), OGM(U) are for Origin Workbook, Graph and Matrix windows, respectively.
• Right-click any window title bar and choose Save as... context menu.

Note: To save an Excel window as an external Excel file, right-click the Excel window title in Origin and choose Save Workbook as... context menu.

Origin 2018 added Unicode (UTF-8) support for Origin projects, child windows and templates. When you save a window file, you will have the option of saving a file with or without a "u" appended to the file type (*.opj or *.opju). If you intend to use the file only in the latest version of Origin, you should choose the Unicode-compliant (appended "u") option as it offers some performance advantages.

To open a worksheet, graph, matrix, or notes window that was saved to a file:

• Select File: Open or click the Open button on the Standard toolbar to open window files.
• Select File: Recent Books, File: Recent Graphs to open recently saved workbook and graph window files.

Note: Origin supports window Short Name, Long Name and Comments and the Short Name must be unique in the Origin project. The window Short Name will be renamed if such a name has already exists in the project. If you open window file in the current project, then save the project, the window will be included in the project.

To open an Excel workbook file:

• Select File: Open Excel menu to open a external Excel file. Or, you can click Import Excel button in the Standard toolbar or select File: Import: Excel (XLS, XLSX, XLSM)... from the main menu to import the Excel file.

Note: If you choose Open Excel, the Excel file is opened as an Excel workbook, in an Excel session that runs inside Origin. In this mode, you have only limited access to Origin features. If you choose Import Excel, the Excel file is imported into an Origin workbook and all Origin features are available.

6.1.9 The Command Window and Script Window

The Command Window can be used to issue LabTalk commands to Origin, to do simple mathematical calculations, or to check the value of LabTalk variables. The Command Window maintains a time-stamped command history that can be carried over from session to session, and intellisense which provides auto-completion features when writing x-function command.

The Command Window is dockable and has two panels. The left-hand panel displays the command history, while the right-hand panel provides the command line.

The Script Window provides some of the same functionality as the Command Window. It lacks some of the Command Window's features (no intellisense, no command prompt, no command history) but it is handy for issuing LabTalk commands and running Python scripts. The window's Tools menu also opens the LabTalk Variables and Functions dialog box where you can view a list of Origin variables, functions, macros, loose datasets, etc.

To open the Command Window:

• Click the Command Window button on the Standard toolbar. Alternately, select Window: Command Window menu or press ALT+3.
To open the Script Window:

- Select **Window: Script Window** menu or press SHIFT+ALT+3.

### 6.1.10 The Status Bar

The **Status Bar** is located at the bottom of the Origin workspace. It reports multiple parameters, including:

- Help messages and tool descriptions.
- Statistics on the current workbook, matrix or graph selection.
- Whether the **AutoUpdate** analysis feature is turned on.
- The name of the **System Theme**, if any.
- Information pertinent to the active window.
- Angular unit (radians, degrees, or gradians).
- Tool tips for functions listed in the **Set Values F(x)** menu.
- **Notifications from OriginLab**, represented by a small red flag to the right side of the Status Bar.

**Note:** You can select what shows in the Status Bar by right-clicking on the Bar and selecting (or clearing) items from the context menu. You can copy displayed statistical values by selecting **Copy Statistics** from the context menu. The copied data are TAB separated between quantity and values, with each key value pair separated by a CRLF delimiter.

### 6.1.11 Smart Hints and the Smart Hint Log

**Smart Hints** are triggered by user actions and are intended to give the user help with current task. These hints may appear briefly inside a dialog box, as in this example.
Alternately, Smart Hints may appear in the lower left corner of the Origin workspace, as in this example.

Unless you hover over a Hint, it will quickly fade. You can prevent display of individual Smart Hints by checking the "Do not show this message in the future" box at the bottom of a Smart Hint.

Hints are logged for the current Origin session and can be reviewed by clicking the **Smart Hint Log** tab, docked at the edge of the Origin workspace (Note that in-dialog Hints are not logged).

To open (and close) the Smart Hint Log window:

1. From the Origin menu, select **View: Smart Hint Log** or press ALT+7.

To prevent a particular Smart Hint from displaying again in the current session, right-click on the hint in the Smart Hint Log window and check **Do not show this hint again** from the context menu. A message asks you to confirm that you do not want to show or log this message.

To turn off all Smart Hint display in the session, open the **Script Window** and type the following:

```
@SHS = 0;
```

To turn on Smart Hint display (including those were individually hidden), type `@SHS = 1`, and click **Help: Reactivate All Hints**.

You can customize general properties of Smart Hints by setting system variables `@SHG` and `@SHO`. See the system variable list for details.

When you set the value of a system variable using the Script Window, you are altering Origin’s behavior for the current session only. To set the value of a system variable across sessions, see this FAQ.
6.1.12 Code Builder

Origin's programming language is called **Origin C**. Origin C's integrated development environment (IDE) is called **Code Builder**. Code Builder provides tools for writing, compiling, and debugging your Origin C functions.

To open Code Builder:


6.1.13 Quick Help

As the name implies, the **Quick Help** window is intended to provide help with specific Origin tasks.

To open (and close) the Quick Help window:

1. From the Origin menu, select View: Quick Help or press ALT+5.

To use the Quick Help window, start typing in the **Find** box. Generally speaking, typing in a few keywords works best. Like several other Origin tools, the Quick Help window can be floated, docked or set to auto-hide.

6.1.14 Messages Log

The **Messages Log** window shows messages about operations including Output Information, Results and Errors. It displays messages that are not sent to the **Script Window** or the **Command Window**.

To open (and close) the Messages Log window:

1. From the Origin menu, select View: Messages Log or press ALT+6.

6.1.15 Results Log

Origin automatically types many analysis and fitting results to the **Results Log**. Each entry in the Results Log includes a date/time stamp, a window name, a numeric stamp which is the Julian day (see Dates below), the type of analysis performed, and the results.

In most cases, when results are reported to the Results Log, it opens automatically. Manually open (or close) the Results Log by doing one of the following:

1. Click the Results Log button on the Standard toolbar. Alternately, from the Origin menu, select View: Results Log or press ALT+2.

Right-click in the Results Log to open a shortcut menu with commands to **Copy**, **Print**, **Clear...**, and **View Results**.

6.1.16 Float, Dock and Auto-Hide Windows

There are several Origin windows, which can be floated, docked, auto-hidden, or hidden. These windows include Project Explorer, Results Log, Command Window, Messages Log, and Quick Help. This allows you to customize your Origin workspace so as to maximize utility and save screen space.
6.2  Numbers in Origin

- **Displayed vs. Actual Cell Value**: When you import or type your data into a workbook or matrix book, Origin uses a combination of user-specified settings to determine how to display the data in each cell. What displays is a visual representation of the data value. The actual data values are stored with the full precision allowed by the dataset’s Data Type (see table below). When you perform calculations, it is the actual data values that are used and not the displayed values.

- **Display of Numbers that Exceed Cell Width**: If a workbook or matrix book contains data that exceed the cell (column) width, Origin displays values as series of pound signs (#####). This avoids confusion caused by a truncated display of cell values. Pound signs ##### will revert to numbers when you enter cell editing mode.

- **Missing Values in the Worksheet**: When spreadsheet programs first appeared it was recognized that there was a need for a special number that was "not a number" which would - when used in a calculation - generate itself. Origin has such a number and its internal value is \(-1.23456789E-300\). Because Origin recognizes this value as a special value, it can be used to enter a missing value into a worksheet or matrix and it can be used in calculations or scripts (for instance, to return a missing value unless some condition is met). Origin displays missing values in a worksheet or matrix sheet as "--". However, you shouldn’t confuse this display (output) with what you enter as a missing value (input).

- **Decimal, Scientific and Engineering Notation**: You can display workbook or matrix book data in **Decimal:**1000, **Scientific:**1E3, **Engineering:**1k, and **Decimal:**1,000 notations. You can manually choose from these data display options but you can also pre-define thresholds for automatic display of scientific notation. By default, these thresholds are set to 6 (upper) and -3 (lower).

- **Dates and Times in Origin**: Origin interprets dates based on the Gregorian Calendar. Origin’s mathematical system for dates and time is based on Astronomical Julian Day Numbers. This defines January 1, -4712 (January 1, 4713 BCE), 12 hours Greenwich Mean Time as zero.

**Note**: For more information on numbers, see **Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Numbers in Origin**

Origin workbooks and matrix books support the following **Data Types**:  

<table>
<thead>
<tr>
<th>Workbook</th>
<th>Matrix Book</th>
<th>Bytes</th>
<th>Range of Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>double</td>
<td>double</td>
<td>8</td>
<td>±1.7E±308 (15 digits)</td>
</tr>
<tr>
<td>real</td>
<td>float</td>
<td>4</td>
<td>±3.4E±38 (7 digits)</td>
</tr>
<tr>
<td>short</td>
<td>short</td>
<td>2</td>
<td>-32,768 to 32,767</td>
</tr>
<tr>
<td>Workbook</td>
<td>Matrix Book</td>
<td>Bytes</td>
<td>Range of Values</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>-------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>long</td>
<td>int</td>
<td>4</td>
<td>-2,147,483,648 to 2,147,483,647</td>
</tr>
<tr>
<td>char</td>
<td>char</td>
<td>1</td>
<td>-128 to 127</td>
</tr>
<tr>
<td>byte</td>
<td>char, unsigned</td>
<td>1</td>
<td>0 to 255</td>
</tr>
<tr>
<td>ushort</td>
<td>short, unsigned</td>
<td>2</td>
<td>0 to 65,535</td>
</tr>
<tr>
<td>ulong</td>
<td>int, unsigned</td>
<td>4</td>
<td>0 to 4,294,967,295</td>
</tr>
<tr>
<td>complex</td>
<td>complex</td>
<td>16</td>
<td>±1.7E±308 (15 digits), each 8 bytes</td>
</tr>
</tbody>
</table>

### 6.3 Topics for Further Reading

- [Project Explorer](#)
- [The Object Manager](#)
- [Finding Data in your Origin Project](#)
- [Basic Child Window Operations](#)
- [Numbers in Origin](#)
- [Dates and Times in Origin](#)
- [FAQ: How do I turn off the collapsible menus and show full menus?](#)
- [Customizing Toolbars](#)
- [Setting Your Preferences](#)
- [The Numeric Format Tab of Tools: Options](#)
7 Origin File Types

7.1 Roundup of Origin File Types

A series of Unicode-compliant (UTF-8) file types was added for Origin 2018. Long-time users will recognize that some of the old familiar file types now have a Unicode counterpart, denoted by an appended ‘u’ (e.g. *.opj => *.opju). Origin versions 2018 and 2018b will read and write the older, non-Unicode file types. As the default is to save to Unicode-type files, be sure to set the **Save as type** drop-down when saving to the older file types.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Extension</th>
<th>Used As</th>
</tr>
</thead>
<tbody>
<tr>
<td>Origin Project Files</td>
<td>*.opj(u)</td>
<td>A container for all data.</td>
</tr>
<tr>
<td>Child Window Files</td>
<td><em>.ogw(u);</em>.ogg(u);<em>.ogm(u);</em>.txt</td>
<td>The child windows for workbooks (.ogw(u)), graph (.ogg(u)), matrix(.ogm(u)), notes (.txt).</td>
</tr>
<tr>
<td>Template Files</td>
<td><em>.otp(u);</em>.otw(u);*.otm(u)</td>
<td>A stored customizable suite of data-handling and format options: graphs(.otp(u)), worksheets (.otw(u)), matrix(.otm(u)).</td>
</tr>
<tr>
<td>Theme Files</td>
<td><em>.oth;</em>.ois;<em>.odt;</em>.ofp</td>
<td>A saved suite of user-defined settings with multiple applications in Origin. A *.oth file applies to a graph/worksheet/matrix sheet/report table; A *.ois applies to analyses and dialogs; A *.odt applies to dialogs; A *.ofp applies to function plots.</td>
</tr>
<tr>
<td>Import Filter Files</td>
<td>*.oif</td>
<td>An external file which handles basic import file parsing and data extraction.</td>
</tr>
<tr>
<td>Fitting Function Files</td>
<td>*.fdf</td>
<td>A fitting function definition file.</td>
</tr>
<tr>
<td>LabTalk Script Files</td>
<td>*.ogs</td>
<td>A text file organized in sections of LabTalk script.</td>
</tr>
<tr>
<td>Origin C Files</td>
<td><em>.c;</em>.cpp;*.h;etc</td>
<td>A file used for developing Origin C programs.</td>
</tr>
<tr>
<td>X-Function Files</td>
<td><em>.oxf;</em>.xfc;</td>
<td>An Origin tool with a flexible mechanism for performing a wide variety of data manipulation tasks.</td>
</tr>
<tr>
<td>File Type</td>
<td>File Extension</td>
<td>Used As</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Origin Package Files</td>
<td>*.opx</td>
<td>A package file created for distributing custom applications.</td>
</tr>
<tr>
<td>Origin Menu Files</td>
<td><em>.xml;</em>.omc;</td>
<td>A file that contains Origin menu information. An *.xml can be edited outside of Origin for menu customization purposes. An *.omc file contains the configuration of customized menus.</td>
</tr>
<tr>
<td>Initialization Files</td>
<td>*.ini</td>
<td>A file that controls the configuration of some Origin features on startup.</td>
</tr>
<tr>
<td>Configuration Files</td>
<td>*.cnf</td>
<td>A text file that contains LabTalk script commands.</td>
</tr>
<tr>
<td>Custom Plot Symbols</td>
<td>origin.uds</td>
<td>A binary file that holds the bitmap images of custom symbols.</td>
</tr>
</tbody>
</table>

### 7.2 Topics for Further Reading

- [Opening, Closing and Backing Up the Origin Project File](#)
- [Protecting Origin Projects](#)
- [Origin Template Files](#)
- [The Theme Organizer](#)
- [System Themes](#)
- [Import Wizard, Save Filters Page](#)
- [Origin Fitting Functions, the Fitting Function Organizer and the Fitting Function Builder](#)
- [OGS Files and Getting Started with LabTalk](#)
- [Running LabTalk Script from OGS Files](#)
- [Using X-Functions in LabTalk](#)
- [Packaging Multiple Files as an OPX File](#)
8 Import Data

Origin imports many file types: ASCII, CSV, Excel, binary files, and many third-party formats, including Matlab, pClamp, NI TDM and NetCDF. When working with Excel files, you have the choice of importing Excel data into Origin workbook (recommended) or open Excel file inside Origin. Origin also supports importing database files.

Data files can be directly drag-and-dropped into Origin workspace, workbook, matrix or graph window to import them or by File: Import menu which will open dialog for user to customize the import further. For many import routines, multiple data files can be imported at once.

If data are changed inside Origin or data file is changed, use the File: Re-Import Directly menu to reload the data, or use File: Re-Import... menu to change the import settings and reload the data. Starting with Origin 2015, reimport also supports Excel files with multiple sheets.

Import settings can be saved inside the window to speed up the import process of data files with similar structure or saved as a dialog theme file (*.oth) for future use or share with others. When imported via the Import Wizard, settings can be saved to an Origin Import Filter file (*.oif) along with post-import processing instructions (in the form of LabTalk script).

Finally the File: Import menu can be customized to show only the data types or saved import Themes that you use.
8.1 ASCII Import

The File: Import: Single ASCII... and File: Import: Multiple ASCII... methods are generally satisfactory for importing text files having a simple structure. These methods are also accessible from the buttons located in the Standard toolbar. These methods will typically handle files with commonly-used delimiters and a simple header structure, without adjustments.

If a file imports with only minor complications, select the Show Options Dialog checkbox when selecting your files in the ASCII dialog (File: Import: Single ASCII... and File: Import: Multiple ASCII...). This will open the impASC dialog box prior to file import, allowing you to tweak the way that the files are handled.

Once you've adjusted import settings, you can save them in one of two ways: (1) with the worksheet template or (2) as a Theme file from within the impASC dialog box. Saving import settings with the worksheet template offers portability. Saving import settings as a Theme offers the option of adding your import routine to the Import menu (File: Import).

For more information on Themes and templates, see the Customizing Origin chapter later in this User Guide. Additionally, see topics listed under "Topics for Further Reading", below.

Note: For a more in-depth discussion of simple ASCII import, see the help topic:

Help: Origin: Origin Help > Importing and Exporting Data > Importing Simple ASCII Data Files

For import of complex ASCII files -- those not satisfactorily handled by the methods previously mentioned -- you can use the Origin Import Wizard (File: Import: Import Wizard...). The Wizard is also accessible from the button located in the Standard toolbar. Apart from its advantages for import of complex files, the Wizard also offers the following:

- Using wild cards, you can create filename-specific filters that are targeted to a group of similarly-named files. This is especially useful for drag-and-drop import operations because all you do is drop the files onto
the workspace. Origin looks at the file name, matches it with the correct custom import filter and imports the file according to your specifications.

- Import data from the web pages using the Clipboard.
- Extract variables from the import file name and header.
- Specify custom delimiters and date formats.
- The ability to post-process your imported data using a custom LabTalk script.

**Note:** For more information, view the help topic:

**Help: Origin: Origin Help > Importing and Exporting Data > The Import Wizard**

**Tutorial: Importing Multiple Files into Worksheets**

1. Click on the **New Workbook** button on the **Standard** toolbar to open a new workbook.

2. With the new workbook active, click on the **Import Multiple ASCII** button on the same toolbar. This opens the **ASCII** dialog.

3. In the **ASCII** dialog, select the files **Sensor01.dat**, **Sensor02.dat**, and **Sensor03.dat** from the **\Samples\Curve Fitting** subfolder of your Origin installation folder, and click the **Add File(s)** button. Then check the **Show Options Dialog** check box and press **OK**.

4. The **impASC** dialog will open. Under the **Import Options** node, change **Import Mode** to **Start New Sheets**. Expand the **(Re)Naming Worksheet** node and clear **Rename Book with (Partial) Filename**.

5. Press the arrow button at the top right of the dialog box, then select **Save As...** from the shortcut menu. In the dialog box that opens, enter a name such as **Import to sheets** and press **OK**. This will save your settings as a Theme that you can later use with other files.

6. Press **OK** to close the **impASC** dialog.

The three files will be imported, each into a worksheet, and the sheets will be renamed with the file name.
You can quickly access your custom import theme from the **File: Recent Imports** menu item. You can also use the **File: Import: Customize...** menu to open the **Import Menu Customization** dialog box where you can select and add **User Themes** to the **File: Import** menu.

### 8.2 CSV Import

You can use **File: Import: Comma Delimited (CSV)...** to import comma delimited files into an Origin workbook file. Modifications to import file handling are made in the **impCSV** dialog box and changes can be saved as a Theme file for later use. Alternately, once you've successfully imported your .csv file into an Origin workbook, you can save the workbook as a workbook template file (*.ogw) and reuse the template for re-importing files of like structure.

You can skip columns or rows, when doing a partial file import of CSV files. For information, choose **File: Import: Comma Delimited (CSV)**, check **Show Options Dialog** and choose a file for import. In the **impCSV** dialog, expand the **Partial Import** branch and note the in-dialog syntax hints under **Custom**.

### 8.3 Binary Import

Files with an optional header section followed by a sequential binary structure, can be imported using the Origin Import Wizard (**File: Import: Import Wizard...**).

If the binary file format is commonly used in your field of work, please contact your Origin representative so we can consider adding support for such files in future versions.
8.4 Copy/Paste the Clipboard Data

One obvious way to get data into Origin is simply to copy data to the Clipboard and paste it into Origin. This can be as easy as selecting a block of data in an Excel workbook and pasting it into an Origin workbook. However, Clipboard data may not be formatted, arrayed or delimited in a way that makes it easy to paste your data into Origin. Here are some things you should know:

- Data copied from Excel and pasted to Origin will be brought over with full precision, regardless of the number of displayed decimal digits in Excel.
- When working with Excel files with header information, paste the Clipboard data into data row 1 in Origin (not into the column label rows), then select a row and use the (right-click) shortcut key commands **Set as Long Name, Set as Units, Set as Comment**, etc. to tag your header information.
- Data copied from the web can be formatted in various ways. You may have to experiment a bit to find a method that brings the data over cleanly. If a simple copy and paste doesn't work, try using the **Import Wizard**. The Import Wizard provides an interactive interface for parsing Clipboard data, with the added benefit that you can save your procedure to an import filter file (.oif) for reuse with identically formatted data. For more information, see the tutorial [Using the Import Wizard to Import Clipboard Data](#).
8.5 Excel

There are three ways to work with Excel data in Origin:

- You can import your Microsoft Excel workbook into an Origin workbook. To do this, use the **File: Import: Excel (XLS, XLSX, XLSM)...** menu command, or click the button located in the **Standard** toolbar. You can also update the imported data by using **File: Re-Import Directly** or use Ctrl+4 keys to re-import Excel sheets with same settings as before.
- You can copy Excel data to the Clipboard and paste or paste link that data into Origin.
- You can open your Excel workbook in Origin as an Excel workbook. To do this, use the **File: Open Excel...** menu command.

When you import or paste your Excel workbook data into an Origin workbook, you have full access to Origin's powerful graphing and analysis features. When you open your Excel workbook as an Excel workbook, you are actually running an OLE instance of Excel inside of the Origin workspace. In this case, you have access to Excel’s menus and features, but limited access to Origin’s graphing and analysis features.

**Things to know:**

- To re-import multiple sheets from Excel to Origin, you need to have Origin 2015 or later.
- To open an Excel file in Origin as an Excel workbook, you need to have Office 97 or later installed on your computer.
- To import an Excel file in Origin, the file needs to be of file type .xls, .xlsx or .xlsm.
- Starting with Origin 2017, you can import Excel files without having MS Excel installed (open as Excel still requires Office 97 or later).
- Origin does not support dynamically linking a formula in an Excel workbook to source data in another Excel workbook.
- You can link your Origin project file to an external Excel file. That way updates to the Excel file will trigger updates to dependent graphs etc. when you open the Origin project file.

**Note:** To learn more about working with Excel data, see the Origin Help:

**Help: Origin: Origin Help > Working with Microsoft Excel**

Origin 2018 added more naming options on the Excel import (**(Re)Naming Worksheet and Workbook** branch of the impMSEexcel dialog).

In addition, you can now do partial import of your Excel data by defining rows and column ranges. A flexible syntax is provided for including or excluding data ranges. For information, choose **File: Import: Excel (XLS, XLSX, XLSM)**, check **Show Options Dialog** and choose a file for import. In the **impMSEexcel** dialog, expand the **Partial Import** branch and note the in-dialog syntax hints under **Custom**.
8.6 Third Party Formats

Origin imports many widely-used third party data formats, including pClamp, NI TDM, and NetCDF. As with ASCII import, you can customize third-party file import options and save your settings with the worksheet template or as a dialog Theme for later use.

As with other supported file types, you can import third party files by drag and drop.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Method</th>
<th>To Learn More, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermo (SPC, CGM)</td>
<td></td>
<td>Help: Origin: Origin Help &gt; Importing and Exporting Data</td>
</tr>
<tr>
<td>pClAMP (ABF, DAT, AB?)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Princeton Instruments (SPE)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sound (WAV)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NetCDF (NC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CDF (CDF)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDF5 (H5, HE, HDF5)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NI DIAdem (DAT)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NI TDM (TDM, TDMS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Famos (DAT, RAW)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ETAS INCA MDF (DAT, MDF)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IgorPro (PXP, IBW)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prism (PZFX, XML)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MATLAB (Mat)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minitab (MTW, MPJ)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>KaleidaGraph (QDA)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SigmaPlot (JNB)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MZXML(mzData, mzXML, mzML, imzML)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EarthProbe (EPA)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDF (EDF, BDF, REC, HYP)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Somat SIE (SIE)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JCAMP-DX (DX, DX1, JDX, JCM)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HEKA (DAT)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SPSS (SAV)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BRUKER OPUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAS (sas7bdat)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tektronix (ISF)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Translation (DCF, HPF)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Binary 2D Array</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Some of these 3rd party file formats are hidden by default. Turn them on by choosing File:Import:Add/Remove File Types. This will add file types to the File:Import menu. To insert separators between menu commands, right-click in the right-hand panel of Import Menu Customization and choose Add Separator.
Drag-and-drop support for various file extensions can be customized using the Filter Manager dialog accessible from the Tools: Import Filter Manager... menu item.

8.7 Database

File: Database Import menu and Database Access toolbar are provided to import data from database. There are two ways to build the query:

- SQL Editor: A simple SQL editor to setup database connect and enter SQL query. It's available in both Origin 32-bit and 64-bit.
- Query Builder: A graphical query builder that assists you in creating an SQL query. It's only available in Origin 32-bit. The query built by it can be loaded and run in Origin 64-bit.

Note: For more information, see the Origin Help

Help: Origin: Origin Help > Importing and Exporting Data > Importing Data from a Database

8.8 Digitizer

At times, you may only have a graphic representation of some data that you would like to explore further. In such cases, Origin's Digitizer tool may prove handy. Use the Digitizer to import an image file, then digitize the plots, converting your image to numeric data that you can study and re-plot using Origin's analysis and graphing tools.
• Import most common image formats.
• Rotate the imported image, remove noise and calibrate scales by picking start and end values.
• Pick points on curves manually or automatically.
• Manually add curve inflection points, as needed.
• Interactively remove points that you do not want digitized.
• Support for Cartesian, polar and ternary coordinate systems.

To open the Digitizer:

1. Click the **Digitize Image** button on the Standard toolbar or choose **Tools: Digitizer...** from the main menu.

### 8.9 Re-Importing Data Files

There are two re-import commands in the **File** menu:

- **Re-Import Directly.** When you import a file into an Origin worksheet or matrix sheet, by default a number of parameters, including file path and name, are saved in the sheet. If you have an external data file that is periodically updated, direct re-import is a quick way to update your Origin project file.
• **Re-Import**... This menu command opens the corresponding X-Function import dialog box for the file type so that you can adjust your import options before re-importing.

**Notes:**

- Only one file can be re-imported at a time. When you use either of these two menu commands, only the file associated with the active worksheet or matrix sheet, will be imported. If the selected data are imported from multiple files, re-importing will fail.
- If you import an ASCII file via the **Import Wizard** and select **File: Re-Import...**, the **Import Single ASCII** dialog will open instead of the **Import Wizard**.
- Re-import does not work for **Binary or User Defined** data types brought in using the Import Wizard.

### 8.10 Topics for Further Reading

- [Importing Simple ASCII Data Files](#)
- [Customizing the ASCII Import Options](#)
- [Import and Reimport Excel Data](#)
- [Importing Third Party Files](#)
- [Tutorial: Updating Graphs by Re-importing Data from a Database](#)
- [Importing Data from a Database](#)
- [Drawing or Deleting Data Points](#)
- [Tutorial: The Digitizer](#)
9 Workbooks Worksheets Columns

9.1 Workbook, Worksheet and Column Basics

The Origin workbook is a nameable, moveable, sizeable window that provides a framework for importing, organizing, analyzing, transforming, plotting and presenting your data. Each workbook is a collection of one or more worksheets. Each worksheet contains a collection of columns and each column contains rows of cells.
9.1.1 Naming Workbooks, Worksheets and Columns

- A Workbook has a **Short Name** and an optional **Long Name** and **Comments**. Origin uses the **Short Name** for internal operations.
- **Short Name** must be unique within the project file, can contain only alphanumeric characters (letters and numbers), must begin with a letter and are limited to 13 characters.
- A Workbook **Long Name** is optional, need not be unique within the project file, can use any characters in any order and has a limit of 5,506 characters (including spaces).
- To name a workbook, right-click on the window title bar and choose **Properties**. Here you can edit Long name, Short name and Comments. Use the Window Title drop-down to control which name(s) show on the window title bar.
### Workbooks

By default, when you start an Origin session, Origin loads an empty project with a single, one sheet, two-column workbook created from the default ORIGIN.otwu workbook template. You can add workbooks to your Origin project file by clicking the **New Workbook** button on the **Standard** toolbar.

An added workbook window is assigned a Short Name of BookN, with N reflecting the order of window creation. You can rename the workbook with something more meaningful:

1. Right-click on the workbook window title bar and choose **Properties**.
2. Give your workbook a **Long Name** (optional) and/or a **Short Name** and choose to display either or **Both** in the window title bar. See the above table for rules on workbook naming.

### Worksheets

- A Worksheet has a **Short Name** and optional **Long Name** and **Comments**.
- The **Short Name** must be unique in a workbook.
- A Worksheet **Short Name** has a 64 character limit, including spaces. It can contain special characters but must begin with an alpha-numeric character. These special characters are not allowed: `{}`''<>()![].
- A Worksheet **Long Name** is optional, need not be unique within the project file, can use any characters in any order and has a limit of 5,506 characters (including spaces).
- To name a worksheet, double-click on the sheet tab, then right-click on the tab and choose **Sheet Name to Show**. Alternately, right-click on the tab and choose **Name and Comments**.

### Columns

- A Column has a **Short Name** and an optional **Long Name**.
- The **Short Name** must be unique within the worksheet. When spreadsheet cell notation is enabled, as indicated by this icon, you cannot edit the column Short Name (see Column Short Name Restriction). When cell notation is disabled, you can edit the column Short Name. When editing Short Names note that they cannot contain special characters, must begin with a letter or number, use only alphanumeric and cannot exceed 18 characters.
- A Column **Long Name** is optional, need not be unique within the project file, can use any characters in any order and has a limit of 30,000 characters. The **Long Name** can be edited directly by clicking in the **Long Name** cell or by right-clicking on the column header and choosing **Properties** from the shortcut menu.
- Dialog box and Status Bar references to data range will use **Long Names**, provided that (1) **Long Name** exists and (2) you have selected **Use Long Names when available** (Tools: Options: Miscellaneous). Otherwise, **Short Names** are used.
The Window Properties dialog has a **Spreadsheet Cell Notation** check box that is enabled by default. When enabled, the icon displays in the upper-left corner of the book (applies to all sheets in the book). Spreadsheet cell notation is useful for defining column formulas and must be enabled to make use of cell-level formulas. This is explained in more detail, below.

The Window Properties dialog has a **Comments** box for entering text. These Comments display as a *workbook window tooltip* in Project Explorer and become searchable when using the **Edit: Find in Project** tool.

### 9.1.3 Worksheets

Prior to Origin 2018, an Origin workbook could a maximum of 255 worksheets. That number is now increased to 1024. When you have more than 255 sheets in a book, you will need to save your file using one of the new Unicode-compliant formats (opju, oggu, otwu).

To add worksheets to the workbook, right-click on a worksheet’s tab and choose one of the following:

- **Insert**. Inserts a single worksheet ahead of the active sheet.
- **Add**. Appends a single worksheet.
- **Duplicate Without Data**. Duplicates the active worksheet without duplicating the data.
- **Duplicate**. Duplicates the active sheet, including the data.

Each sheet in a workbook can have its own set of customizations. When you **Insert** or **Add** a worksheet, the new sheet is based on the ORIGIN.otwu file, specifically the version of ORIGIN.otwu that is saved to your **User Files Folder** (found in UFF if you have customized this file). To add a sheet that is based on another sheet in the workbook (including number of columns and special formatting), you would use the **Duplicate** or **Duplicate Without Data** shortcut command.

To control worksheet tab name display:

1. Right-click on the worksheet tab.
2. Select **Sheet Name to Show: Long Name if available/ Short Name/ Long Name** from the shortcut menu.

To change the **Short Name** or **Long Name** that displays on the worksheet tab:

1. Double-click on the worksheet name or right-click on the worksheet tab and choose **Name and Comments**. See the above table for rules on worksheet naming. If you are editing the **Short Name** and you exceed 64 characters, Origin automatically truncates your entry to create the **Short Name**. If **Long Name** did not previously exist, the unmodified text becomes the **Long Name**.
**Note:** When mousing over the worksheet tab, the worksheet Short Name, Long Name and Comments appear as a tooltip.

### 9.1.3.1 Worksheet Properties

The Worksheet Properties dialog box is used to customize properties of the sheet, including...

- Display of row labels, header labels and grid lines (**View** tab).
- The number or rows and columns and other sheet dimensions such as column or row header height (**Size** tab).
- Enabling of rich text, text wrap, how to display truncated cell content, sheet font and color (**Format** tab).
- Auto add rows, ignore hidden rows in plotting and analysis, cell resizing (**Miscellaneous** tab).
- Printing/exporting of grid lines, headers and footers, background color (**Print/Export** tab).
- Script to run after import or upon data change (**Script** tab).

Note that many of the sheet customizations can be applied at the cell level by right-clicking on a selected cell. For more information, see [The Worksheet Properties dialog box](#).

### 9.1.4 Worksheet Columns

- **To add a new column** to the right end of an existing worksheet, right-click in the gray area to the right of the worksheet columns and choose **Add New Column** or Click the Add New Column button on the **Standard** toolbar.

- **To add multiple columns** to the worksheet, make the worksheet active then choose Column: Add New Columns... from the main menu. Specify the number of columns to add in the Add New Columns dialog box and click **OK**; or use the Format: Worksheet... menu item or the F4 hot key to open the Worksheet Properties dialog, then set the desired value for **Column Number** in the **Size** tab.

- **To insert a column** into the worksheet, highlight a column, then right-click and choose Insert. A column is inserted ahead of the selected column and column Short Names are adjusted accordingly.

Worksheet columns can be renamed by:

- Double-clicking on the column heading opens the Column Properties dialog box. Enter/edit **Short Name** and/or **Long Name**.
- Type a **Long Name** directly into the worksheet header cell by double-clicking in the cell.
- Import a data file and specify that the workbooks, worksheets, and columns be named upon import.
- Use the Enumerate Labels tab of the Worksheet Properties dialog to enumerate or duplicate column names and labels.
• Type names into a few columns (e.g. Peak 1 and Peak 2), then highlight the cells and drag the bottom-right corner of the selection to auto fill and enumerate the names for other columns. This also works for other column label rows such as Comments.

See the above table for rules on worksheet column naming.

9.1.4.1 The Column Properties Dialog Box

The Column Properties dialog box is used to customize properties of the column including...

• Long Name, Short Name, Units, Comments, etc.
• Format (Numeric, Text, Time, Date, etc.).
• Plot Designation.

To open the Column Properties dialog box:

1. Double-click on the column header.
2. Right-click the selected column(s) and choose Properties....

Use the Properties tab to edit the column Short Name, if desired. Other properties -- Long Name, Units and Comments -- can be edited here or entered directly into the column label row cells.

9.1.5 Column Label Rows

Column label rows store metadata -- data that is used to describe other data. Typically, this metadata may be brought in as header information in imported files, or it may be manually entered. Display of column label rows is optional and the user can selectively show them or hide them, as needed.

Column label row information is often used in plotting operations (e.g. worksheet Long Names used as graph legend text or Axis titles). The F(x)= row is used in performing math operations on columns of data. Data stored in User-defined Parameter rows might be used in labeling or grouping of datasets in plotting, data manipulation, statistical analysis or math operations.
Display of column label rows is controlled by shortcut menu commands:

1. Right-click here and choose **View** from the shortcut menu.
2. Right-click here and choose **Edit Column Label Rows** or other label row command.
3. Right-click here for global control of row labels and row and column header display.

Numeric data stored in a column will graphically display in the column header in a special label row called **Sparklines**. A sparkline is, by default, a small inset line plot of the data in a column, plotted as the dependent variable (Y) against the row number or the associated X column as independent variable (X). When importing data, Origin displays sparklines by default when the number of columns is less than 50.
Origin User Guide

Turn on sparklines for selected columns by clicking **Column: Add or Update Sparklines** or for all columns by right-clicking on the Sparklines row label and choosing **Add or Update Sparklines**. Sparklines can be deleted by clicking the **Sparklines** row label and pressing the delete key.

In addition to the default line plot, Sparklines can display as Histogram or Box Charts. Highlight one or more columns by clicking on the column header, then right-click and choose **Add or Update Sparklines**. In the dialog box that opens, set the **Plot Type** to **Histogram** or **Box**.

Sparkline plot properties can be customized. Double-clicking on a sparkline pops open a graph window. Double-clicking on the pop-up window opens the Plot Details dialog box where you can customize the plot. When you close the pop-up window, your customizations are applied to sparkline.

**9.1.6 The Workbook Organizer**

As mentioned, the workbook commonly stores metadata, some of which is visible in the column label rows. Other metadata may be hidden in the workbook. Such hidden metadata might include things like import file path and name, date and time of data import, file header information not written to the column label rows, variable names and values, etc. This hidden metadata can be viewed in the **Workbook Organizer** panel.

To show a workbook's Organizer panel right-click on the workbook title bar and select **Show Organizer** (note that this action toggles the panel on or off). The Organizer provides a tree-view listing of metadata stored with a particular workbook.
9.1.7 Some Workbook, Worksheet and Column Limits

<table>
<thead>
<tr>
<th>Maximum Number of...</th>
<th>32Bit OS</th>
<th>64Bit OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheets in a workbook</td>
<td>1024†</td>
<td>1024†</td>
</tr>
<tr>
<td>Rows in a worksheet, 1 column</td>
<td>90,000,000</td>
<td>90,000,000</td>
</tr>
<tr>
<td>Rows in a worksheet, 5 columns</td>
<td>14,000,000</td>
<td>90,000,000</td>
</tr>
<tr>
<td>Rows in a worksheet, 32 columns</td>
<td>3,700,000</td>
<td>90,000,000</td>
</tr>
<tr>
<td>Columns in a worksheet, 1 row</td>
<td>65,500</td>
<td>65,500</td>
</tr>
<tr>
<td>Columns in a worksheet, 100 rows</td>
<td>65,500</td>
<td>65,500</td>
</tr>
<tr>
<td>Columns in a worksheet, 1,000 rows</td>
<td>65,500</td>
<td>65,500</td>
</tr>
</tbody>
</table>

† > 255 sheets requires saving file to Unicode-compliant (e.g. *.opju) file format. Unicode formats not compatible with Origin versions prior to Origin 2018.

9.2 Workbook Templates

Origin workbook windows are created from a workbook template file with an .otwu extension. By default, Origin uses the ORIGIN.otwu template when creating new workbook windows. ORIGIN.otwu contains a single, two-column worksheet. You can customize this workbook template and save it for repeat use. All customized templates get saved to your User Files Folder (UFF) by default.

1. To save the active workbook as a template, choose File: Save Template As. This opens the template_saveas dialog box.
2. Use Category = UserDefined or create your own.

3. Give the template a name. By default, the name is the name of the template used to create the window. If the template is a System template (e.g. the Origin.otwu file used to create new workbooks), saving the file to your UFF will make this your new default template.

4. You can also give the customized template a new name and recall it for use whenever it is needed, either by loading manually in the user-interface or by calling for it programmatically.

5. Provide a **Template Description** if desired and save either to File Path = **User Files**, or browse to a new location.

The System templates that ship with Origin are stored in the EXE folder and cannot be overwritten. If you have saved a customized System template to your User Files Folder, this becomes the default template associated with new workbooks, etc. If, at some point, you want to restore the original, uncustomized System template, you’ll need to remove your customized template from the UFF.

**Note:** Data are NOT saved with a template file.

The following table lists some of the kinds of things that are saved with the workbook template file. Click the dialog box link for more information.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>What is Saved?</th>
<th>Menu Command</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Worksheet Properties</strong></td>
<td>• Display of row/column heading labels.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Display of worksheet grid lines.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Number of rows/columns in the worksheet.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Auto addition of worksheet rows, when needed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Creation and naming of worksheet column heading user-defined parameters.</td>
<td><strong>Format: Worksheet</strong>…</td>
</tr>
<tr>
<td></td>
<td>• The order of worksheet column heading row labels.</td>
<td></td>
</tr>
<tr>
<td><strong>Column Properties</strong></td>
<td>• Column Short Name, Long Name, Units, Comments.</td>
<td><strong>Format: Column</strong>…</td>
</tr>
<tr>
<td></td>
<td>• Formula (if any) used for calculating column values.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Column width settings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Column Plot Designation. (X,Y,Z, Label, etc.).</td>
<td></td>
</tr>
<tr>
<td>Dialog Box</td>
<td>What is Saved?</td>
<td>Menu Command</td>
</tr>
<tr>
<td>------------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td></td>
<td>• Column data Format (text, numeric, date, etc.).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Column number Display (decimal, scientific, engineering).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Column Digits and data storage requirements.</td>
<td></td>
</tr>
<tr>
<td>Column Formulas and Scripts (Set Column Values)</td>
<td>• Formulae used to create or transform column values.</td>
<td>Column: Set Column Values...</td>
</tr>
<tr>
<td>Properties</td>
<td>• Any annotations along with their settings in the Properties dialog box.</td>
<td>Format: Text Object Format: Object Properties</td>
</tr>
<tr>
<td></td>
<td>• Any scripts associated with the object’s Properties dialog, Programming tab.</td>
<td></td>
</tr>
<tr>
<td>Worksheet Query</td>
<td>• Equations in the Worksheet Query dialog box.</td>
<td>Worksheet: Worksheet Query</td>
</tr>
<tr>
<td>Worksheet Properties, Script tab or Script Panel</td>
<td>• Scripts entered in the Script tab of the Worksheet Properties dialog box.</td>
<td>Worksheet: Worksheet Script Show Script Panel</td>
</tr>
<tr>
<td></td>
<td>• Scripts in the worksheet Script Panel.</td>
<td></td>
</tr>
<tr>
<td>Query Builder</td>
<td>• Option to save database queries with the workbook template.</td>
<td>File: Database Import: New</td>
</tr>
</tbody>
</table>

### 9.2.1 Creating a New Workbook from a Custom Template

As mentioned, Origin ships with a number of System Templates (workbook, matrix, graph) that are installed to the Origin EXE folder and cannot be overwritten. When you customize a window that is created from a System Template and save the template with the same name to your User Files Folder, this customized template then becomes the new default template associated with a particular toolbar button or menu command. For instance, if you customize the default workbook and do a File: Save Template As and save
Template Name = ORIGIN, to File Path = \User Files, each time you click the New Workbook button on the Standard toolbar, you will open a workbook that is based on your customized workbook.

Other ways to open a workbook that is based on your custom template (OTW, OTWU):

- If the template was recently saved, look under File: Recent Books.
- Click Help: Origin Central or press F11 to open Origin Central. Look for your custom template file on the Books tab.
- Click File: Open..., set file type to Origin Template (*.otpu, *.otwu, *.otmu) and browse to the file.
- Click the Open Template... button on the Standard toolbar and change the file type to Workbook Template (*.otwu), then browse.
- Click File: New: From Template: More... This menu command opens the Load Template dialog box. In the Type group, select Workbook. If necessary, use the browse button in the Path group to locate the .otwu file, then select the worksheet template from the Name drop-down list. Optionally, specify this as the default workbook template by clicking Set Default.

9.3 Simple Utilities for Filling Columns with Data

Origin provides several utilities for filling a worksheet range or column, with data. The simplest of these use a menu command to fill a worksheet column with either row index numbers, uniform random numbers or normal random numbers. This is useful for generating quick datasets to test and try out other Origin features.

These simple procedures create a dataset in a pre-selected worksheet range or column(s):

<table>
<thead>
<tr>
<th>Action</th>
<th>Toolbar Button</th>
<th>Menu Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fill a range or column with row numbers</td>
<td></td>
<td>• Column: Fill Column With: Row Numbers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Right-click and select Fill Range/Column(s) With Row</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Numbers</td>
</tr>
<tr>
<td>Fill a column with uniformly distributed random numbers between 0 and 1</td>
<td></td>
<td>• Column: Fill Column With: Uniform Random Numbers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Right-click and select Fill Range/Column(s) With Uniform Random Numbers</td>
</tr>
<tr>
<td>Action</td>
<td>Toolbar Button</td>
<td>Menu Command</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Fill a column with normally distributed random numbers</td>
<td><img src="image" alt="Random" /></td>
<td>• Column: Fill Column With: Normal Random Numbers or • Right-click and select Fill Range/Column(s) With Normal Random Numbers</td>
</tr>
<tr>
<td>Fill a column with a patterned or random set of numbers</td>
<td>--</td>
<td>• Right-click and select Fill Range/Column(s) With A set of Numbers...</td>
</tr>
<tr>
<td>Fill a column with a patterned or random set of Date/Time Values</td>
<td>--</td>
<td>• Right-click and select Fill Range/Column(s) With A set of Date/Time Values...</td>
</tr>
<tr>
<td>Fill a column with arbitrary set of Text&amp;Numeric values</td>
<td>--</td>
<td>• Right-click and select Fill Range/Column(s) With Arbitrary set of Text&amp;Numeric values...</td>
</tr>
</tbody>
</table>

Datasets can also be generated quickly using LabTalk script. As an example:

1. With a new worksheet active, open the Script Window from the Windows menu, and copy-paste the following lines of script code into that window:
2. Highlight the two lines and press ENTER to execute them. The first two columns of the worksheet will be filled with data.

## 9.4 Setting Column Values

The **Set Values** dialog box is used to set up a mathematical expression that creates or transforms one or more columns of worksheet data. The dialog box includes a menu bar, a control used to define output range, a tool for searching and inserting LabTalk functions into your expression, a column formula box used to define a one-line mathematical expression and a **Before Formula Scripts** panel (usage optional) intended for data pre-processing and defining of variables used in your one-line expression.

Since Origin 2017, the column formula box (the upper box) in **Set Values** has supported a simplified **spreadsheet cell notation** like is used in MS Excel and Google Sheets. A cell is addressed using column Short Name + row index number (e.g. the first cell in column A -- formerly represented as “col(A)[1]” -- is now simply “A1”).

When this spreadsheet cell notation is enabled (default), you will see an icon in the upper-left corner of the workbook (applies to all sheets). Spreadsheet cell notation can only be used in defining the column
formula. It cannot be used in the Before Formula Scripts panel of Set Values, nor can it be used in your LabTalk scripts. Note that the "old" column and cell notation will work in spreadsheet mode, so if you are an experienced user and you prefer to use the old notation, you may enter it as you always have. For an introduction to the spreadsheet cell notation syntax as well as a contrast with the “old” methods, see Column Formula Examples.

To open the Set Values dialog box for a single column:

1. Select a worksheet column or a range of cells in a worksheet column.
2. From the menu, choose Column: Set Column Values... or right-click on the worksheet column and choose Set Column Values... from the shortcut menu.

To open the Set Values dialog box for multiple columns:

1. Select multiple, contiguous worksheet columns (skip no columns) or the entire worksheet.
2. From the menu, choose Column: Set Multiple Column Values... or right-click on the worksheet column and choose Set Multiple Column Values... from the shortcut menu.
### 9.4.1 Set Values Menu Commands

<table>
<thead>
<tr>
<th>Menu Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Formula</strong></td>
<td>Load a saved formula into the column formula box. Formulas are saved using <strong>Formula: Save</strong> or <strong>Formula: Save As</strong>....</td>
</tr>
<tr>
<td>• <strong>wcol(1)</strong></td>
<td>Use the menu to include worksheet columns in either your column formula or your Before Formula Scripts (column reference is inserted at the cursor). A Column Browser is available to help in selecting the correct columns. Columns are listed by column index.</td>
</tr>
<tr>
<td>• <strong>Col(A)</strong></td>
<td>Similar to wcol(1) menu functionality but columns are listed by column name (including Long Name, if it exists).</td>
</tr>
<tr>
<td>• <strong>Function</strong></td>
<td>Add LabTalk functions to your expressions (function name is inserted at the cursor). Note that when you hover over a function in the menu list, the function description will be shown in the Status Bar. When a function is selected, its description will be displayed in a pop-up Smart Hint.</td>
</tr>
<tr>
<td>• <strong>Variables</strong></td>
<td>Add a variable or a constant to Column Formula or Before Formula Scripts; Add range variables (including by selection) or file metadata, to Before Formula Scripts.</td>
</tr>
<tr>
<td>• <strong>Options</strong></td>
<td>Allow direct editing of column formula in worksheet Formula row; add a comment about the column formula; or preserve text in Set Values columns (do not treat as text as missing values).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column Formula</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Add a single line expression for generating data. Functions, conditional operators and variables can be used.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Before Formula Scripts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• LabTalk scripts to be executed before the expression in the column formula box is executed.</td>
<td></td>
</tr>
</tbody>
</table>

When you mouse over one of the functions listed in the **Function** menu in Set Values dialog, a one-line tooltip is displayed in the **Status Bar**. If you select the function, a Smart Hint appears with a more detailed explanation and a link to the full function description, syntax, examples, etc.

Additionally, you can click the **Search and Insert Functions** button to search for available functions by keyword and, once found, insert the function into your expression.

Use the **Before Formula Scripts** panel to define variables, LabTalk functions, or run LabTalk scripts before the expression in the upper panel is evaluated.

To learn more, see **Set Column Values - Quick Start**
9.4.2 The "F(x)=" Worksheet Column Label Row

For simple expressions, you can use the F(x)= row to set column values. Any expression you enter here is directly entered into the Set Values dialog and vice versa. Note that the simplified spreadsheet cell notation that works in the formula box in Set Values also works in F(x)=:

1. Double-click in a cell in the F(x)= column label row.
2. Enter an expression to enter output in the data column below.

<table>
<thead>
<tr>
<th>F(x)=</th>
<th>A(X)</th>
<th>B(Y)</th>
<th>C(Y)</th>
<th>D(Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5.30</td>
<td>-152.66</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>189.41</td>
<td>0</td>
<td>194.71</td>
<td>-152.66</td>
</tr>
<tr>
<td>2</td>
<td>189.77</td>
<td>155.88</td>
<td>195.07</td>
<td>3.2</td>
</tr>
<tr>
<td>3</td>
<td>190.13</td>
<td>156.44</td>
<td>195.43</td>
<td>3.76</td>
</tr>
</tbody>
</table>

9.4.3 Set Column Values Tutorials

Tutorial 1: A Quick Units Conversion using F(x)=

1. Start with a new workbook and import the file \Samples\Graphing\WIND.DAT.
2. We will assume that column B contains Speed values in miles per hour (MPH). Click on the column heading for column C, then right-click and choose Insert. Origin inserts a new column C and moves Power values to column D.
3. Now, we'll convert the MPH values in column B to kilometers per hour (KPH). Double-click in the F(x)= cell of column C and enter B*1.6

and press Enter. Column C is filled with values in units of KPH.

Tutorial 2: Computing Moving Average and Moving Standard Deviation

1. Import the file Samples\Signal Processing\fftfilter1.DAT.
2. Add two more columns to the worksheet by clicking the + twice.
3. Click on the header of the 3rd column to select it, then right-click and select Set Column Values... from the context menu.
4. In the Set Values dialog, enter the following in the upper panel:
and press Apply. Column 3 is filled with an 11-point moving average of the data from column B (note that you can insert functions such as movavg from the Function menu of the Set Values dialog box).

5. Click the >> button above the edit box to switch to the 4th column.
6. In the edit box for the 4th column, enter the formula:

\[
\text{movrms}(B,5,5)
\]

and press OK. This 4th column will be filled with root-mean-square (RMS) values, using a window size of 11 at each point.

**Tutorial 3: Set Values for Multiple Columns**

1. Create a new project by clicking the New Project button on the Standard toolbar.
2. Click the Import Multiple ASCII button to import the files F1.dat and F2.dat in the <Origin Folder>\Samples\Import and Export\path. In the impASC dialog, set Multi_File (except 1st) Import Mode to Start New Books and click OK.
3. Two workbooks are created, named as F1 and F2. Click the New Workbook button on the Standard toolbar to create another workbook.
4. With the 3rd workbook active, click the Add New Columns button to add a column. Highlight all columns and select Column: Set Multiple Columns Values from the main menu or right-click the columns and select Set Multiple Columns Values from the shortcut menu to open the Set Values dialog box.
5. Expand the bottom panel by clicking the Show Scripts button. Enter this script in the Before Formula Scripts edit box,

\[
\text{range } r1=[F1]F1!wcol(j); //"j" is the column index.
\]

\[
\text{range } r2=[F2]F2!wcol(j);
\]

6. Enter \( (r1+r2)/2 \) in the Column Formula edit box.
7. Select **Options: Direct Edit Formula Cell** to clear this option.
8. Select **Options: Formula Text**... and enter \((F1+F2)/2\) in the **Formula Text** dialog, then click **OK**.
9. Click the **OK** button in the **Set Values** dialog box. You will see the results in the worksheet, and \((F1+F2)/2\) will display in the **F(x)** column label row instead of the formula.

### 9.5 Setting Cell Values

Beginning with version 2018, Origin supports cell-level expressions similar to those used by spreadsheet programs. Cell-level expressions which return a single value (numeric, string or date/time) can be entered into any worksheet data cell or into cells in a **User-Defined Parameter** row of the column label row area. When Edit Mode (**Edit: Edit Mode**) is toggled on, cell formulas display. When Edit Mode is toggled off, the formula result is displayed. Cell content can be edited regardless of Edit Mode state.

- To use cell formulas, **Spreadsheet Cell Notation** must be enabled ( appears in upper-left corner of sheet).
- Cell formulas begin with an equal sign (e.g. \(=B1 - C1\)).
- Cell formulas can return a numeric, a string or a date-time value.
- Cell formulas can incorporate cell references, variables, operators, LabTalk-supported functions and constants.
- Cell formulas can reference values in other sheets or books.
- Cell formulas can be extended to other cells by dragging with your mouse.

To learn more, see **Using a Formula to Set Cell Values**.
9.5.1 Set Cell Values Tutorials

Tutorial 1: Extending a cell formula to other cells

1. Click the New Workbook button to open a new book.
2. Click on the column A heading to select, then right-click and choose Fill Column with Row Numbers.
3. Click on cell B1 and enter:
   \[=A1+A[1]\]
4. Press ENTER. This adds the value in A1 to the value in A1.
5. With the cell still selected, hover on the selection handle in the lower-right corner of the cell and drag to the end of the column, extending your cell calculation to other cells. This will add the quantity in A1 to values in column A.
6. Click the Add New Columns button to add column C.
7. Click on the Cell in C1 but this time enter (omitting the square bracket on the second "1"):
   \[=A1+A1\]
8. Press ENTER. This adds the value in A1 to the value in A1.
9. With the cell still selected, hover on the selection handle in the lower-right corner of the cell and drag to the end of the column, extending your cell calculation to other cells. Note that this time, the resulting values are different.
10. Click Edit: Edit Mode to display the underlying cell formulas. Note that the square brackets in column B "protected" the second cell A1 reference so that it didn't change but that the A1 reference in column C changed as we extended the cell calculation to other cells.

![Cell Formulas](image)

Tutorial 2: Quickly finding maximum values in multiple columns of data

The only place where you can use cell formulas in the worksheet column label rows (worksheet header rows), is in a User Parameter row.
1. Create a new workbook and then choose File: Import: Single ASCII and import the file \Samples\Import and Export\S15-125-03.dat.
2. With your mouse, hover just to the left of the F(X)= row label and when the pointer becomes an arrow, right-click and Add User Parameters.
3. In the dialog box that opens, enter "MaxValue" and click OK.
4. In column A(X), in the MaxValue cell, enter:

   =Max(This)

5. Click outside the cell and cell should now display "10".
6. Click back on this cell, then grab the selection handle in the lower right corner of the cell and drag to the right to extend the cell formula to MaxValue cells in columns B(Y), C(Y) and D(Y). All MaxValue cells should now display the maximum values in their respective columns.

Tutorial 3: Use a column label row value in a cell calculation

All data in the worksheet column label rows, including User Parameter rows, is stored as string data. To use a "number" stored in a column label row in a cell calculation, you must convert the string to a numeric value. In the following example, we use the LabTalk value() function to convert column label row data to a numeric so that it can be used in a cell calculation:

1. Create a new workbook and then choose File: Import: Single ASCII and import the file \Samples\Import and Export\S15-125-03.dat.
2. With your mouse, hover just to the left of the F(X)= row label and when the pointer becomes an arrow, right-click and Add User Parameters.
3. In the dialog box that opens, enter "Correction" and click OK.
4. In column D, enter the value "0.2" into the Correction cell.
5. Click the Add New Columns button to add column E.
6. In cell E1, enter:

   =D1+value(D[Correction]$

7. Press ENTER. This converts the Correction value to a numeric and adds the numeric to the value in cell D1. The cell should display 101.9.
## 9.6 Processing Worksheet Data

Origin provides a number of utilities for manipulating worksheet data. Most of these are found on the **Worksheet** menu while some are on the **Edit**, **Column** or **Analysis** menus. Note that a worksheet must be the active window.

<table>
<thead>
<tr>
<th>Utility</th>
<th>Menu Access</th>
</tr>
</thead>
</table>
| • Sorting Data | **Worksheet: Sort Range**  
**Worksheet: Sort Columns**  
**Worksheet: Sort Worksheet**  
**Worksheet: Sort Columns by Label** |
| • Find  
• Replace  
• Go To (sheet row/column) | **Edit: Find in Project**  
**Edit: Find in Sheets**  
**Edit: Replace**  
**Edit: Go To** |
| • Hide Column  
• Hide Rows | **Column: Hide/Unhide Columns**  
**Hide/Unhide Rows** (shortcut menu only) |
| • Move Columns  
• Swap Columns | **Column: Move Columns** or **Column toolbar**.  
**Column: Swap Columns** |
| • Query Worksheet Data | **Worksheet: Worksheet Query** |
| • Copy Columns to (new locations) | **Worksheet: Copy Columns to** |
| • Append Worksheet | **Worksheet: Append Worksheet** |
| • Split Columns  
• Split Worksheet  
• Split Workbook | **Worksheet: Split Columns**  
**Worksheet: Split Worksheet**  
**Worksheet: Split Workbooks** |
| • Worksheet Transpose | **Worksheet: Transpose** |
| • Stack Multiple Columns into One with Grouping | **Worksheet: Stack Columns**  
**Worksheet: Unstack Columns** |
<table>
<thead>
<tr>
<th>Utility</th>
<th>Menu Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Unstack Grouped Data into Multiple Columns</td>
<td></td>
</tr>
<tr>
<td>• Summarize Data with Pivot Table</td>
<td>Worksheet: Pivot Table</td>
</tr>
<tr>
<td>• Filter data by defining conditions on one or more columns</td>
<td>Column: Filter menu, or Worksheet Data toolbar</td>
</tr>
<tr>
<td></td>
<td>See Also: Data Masking</td>
</tr>
<tr>
<td>• Data Reduction</td>
<td>Worksheet: Remove/Combine Duplicated Rows</td>
</tr>
<tr>
<td></td>
<td>Worksheet: Reduce Columns</td>
</tr>
<tr>
<td></td>
<td>Worksheet: Reduce Rows</td>
</tr>
<tr>
<td></td>
<td>Analysis: Data Manipulation: Reduce Duplicate X Data</td>
</tr>
<tr>
<td></td>
<td>Analysis: Data Manipulation: Reduce by Group</td>
</tr>
<tr>
<td></td>
<td>Analysis: Data Manipulation: Reduce to Evenly Spaced X</td>
</tr>
<tr>
<td>• Reverse Order</td>
<td>Column: Reverse Order</td>
</tr>
</tbody>
</table>

Some of these worksheet data processing utilities are available from a shortcut menu. For access, right-click on your data selection.

### 9.6.1 Workbooks for Analysis and Reporting

Apart from containing text and numeric data, worksheet cells support storage and display of various other types of data such as graphs, graphic objects, notes, hyperlinks to documents and web pages, and links to project variables.

This makes the worksheet an ideal medium for presenting analyses and reporting results. You can link to cells in other worksheets and report sheets. You can also embed graphs, images from external disk files, or image plots corresponding to matrix objects in your Origin Project. Groups of cells in a worksheet can be merged, allowing for larger objects to be displayed at a comfortable viewing size. Graphs can be embedded in worksheet cells or they can be placed on worksheets as floating objects.
Previously, you could right-click on a worksheet tab and add a graph or notes window as a sheet in the workbook. Now, in Origin 2018b, you can Add Matrix as Sheet, giving you even more flexibility in building your Analysis Templates.

Once created, such custom reports can be exported as image files (for instance, as PDF or JPEG), and they can also be used in the creation of an Analysis Template.

You have the option of generating custom reports by exporting data to a custom MS Word template, and optionally, a PDF file. This is done by running an output-generating analysis in Origin, then associating key results with bookmarks in a Word template, and, finally, saving the workbook as an Analysis Template. To generate your report, you open the Batch Processing tool, point to both your Analysis Template and your Word template, run the batch process and generate your reports.

- For information on generating custom reports using an MS Word Template, see the tutorial Batch Processing with Word Template for Reporting.
- For information on batch analysis and generating custom reports, see the Batch Analysis section of the "How to Handle Repetitive Tasks" chapter of this Guide.
9.7 Topics for Further Reading

- The User Files Folder
- Origin Template Files
- What is Saved with the Workbook Template?
- Arranging the Worksheet
- Displaying Supporting Data in the Worksheet Header Rows
- Controlling How Numeric Data Display
- Dates and Times in the Worksheet
- Generating Simple Worksheet Datasets
- Using Formulae to Set or Transform Worksheet Column Values
• Using a Formula to Set Cell Values
• Simple Manipulation of Worksheet Datasets
• Inserting Graphs, Images and other Objects into Worksheet Cells
• Inserting Links into Worksheet Cells
• Inserting Variables into Worksheets
• Analysis Report Sheets and Columns
10 Matrix Book Matrix Sheet Matrix Objects

10.1 Matrix Books, Matrix Sheets and Matrix Objects

A matrix is a dataset of Z values arranged as an array of columns and rows which are linearly mapped to X and Y values. The following table summarizes some important matrix book limits:

<table>
<thead>
<tr>
<th>Maximum Number of...</th>
<th>32Bit OS</th>
<th>64Bit OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matrix sheets in a matrix book</td>
<td>1024†</td>
<td>1024†</td>
</tr>
<tr>
<td>Matrix objects in a matrix sheet</td>
<td>65,527</td>
<td>65,527</td>
</tr>
<tr>
<td>Cells in a matrix (Note)</td>
<td>90,000,000</td>
<td>90,000,000</td>
</tr>
</tbody>
</table>

† > 255 sheets requires saving file to Unicode (e.g. *.opju) file format. Unicode formats not compatible with Origin versions prior to Origin 2018 SR0.

**Note:** The product of any combination of rows and columns must not be greater than 90,000,000.
10.1.1 Naming Matrix Books, Matrix Sheets and Matrix Objects

- **Matrix Book**
  - The matrix book has a **Short Name** whether you display it or not. Origin uses the **Short Name** for internal operations.
  - **Short Names** must be unique within the project file, cannot contain spaces, must begin with a letter, consist only of alphanumeric characters (A to Z and 0 to 9), and limited to 13 characters. You can use lowercase characters and the text will appear as such, but upper and lower case are not unique characters. (You cannot name one matrix MBOOK1 and another mbook1.)
  - **Long Names** are optional, need not be unique within the project file, can contain spaces, can begin with a letter, a number or a special character, and the length cannot exceed 520 characters, including spaces.

- **Matrix Sheet Names**
  - **Rows mapped to linearly spaced Y values**
  - **Columns mapped to linearly spaced X values**
  - **Matrix Book Name** Short Name - Long Name: active object/total objects
  - **Matrix Window Menu**

- **Matrix Sheet**
  - **Z Values - View of Image in "Data Mode"**

- **Origin User Guide**
### Matrix Sheets

- The sheet Short Name (a Layer object) must be unique within the matrix book and is limited to 32 characters.
- Can contain spaces, numbers and special characters.
- Can begin with a letter, number or special character.
- These special characters are not allowed: `!"#$%&'()*+,-./:;<=>?@[^_`{|}~`

### Matrix Objects

- Origin assigns a Short Name -- the matrix object index number -- to each matrix object, as it is created. This name/index number cannot be changed.
- You can add an optional Long Name to the object by clicking on the yellow object icon -  for a data matrix or  for an image matrix - in the upper right corner of the matrix sheet and choosing **Rename** from the menu.

#### 10.1.2 Different Views of the Matrix

In the worksheet, a dataset is contained in a single column and the dataset may consist of \textbf{X,Y,Z, Error,} or \textbf{Label} data. In the Origin matrix, a dataset is arranged in a specified dimension of rows and columns. The matrix contains a single dataset of \textbf{Z} values.

- Matrix columns are mapped to linearly-spaced \textbf{X} values.
- Matrix rows are mapped to linearly-spaced \textbf{Y} values.

Note that the matrix window has two column and row heading view modes:

- By default, matrix row and column headings display as row and column index numbers (**View: Show Column/Row** from the menu or press \textbf{Ctrl}+\textbf{Shift}+\textbf{C}).
- You can opt to view matrix row and column as \textbf{X} and \textbf{Y} values by choosing **View: Show X/Y** from the Origin menu (or press \textbf{Ctrl}+\textbf{Shift}+\textbf{X}). The displayed \textbf{X} and \textbf{Y} values are the \textbf{X} and \textbf{Y} coordinate values, calculated by linear interpolation of the axes \textbf{From} and \textbf{To} values by the number of columns and rows.

In addition to the two row and column heading view modes, there are two matrix display modes:

- In Data Mode (**View:Data Mode** from the menu or press \textbf{Ctrl}+\textbf{Shift}+\textbf{D}), the matrix object displays as raw numbers.
- In Image Mode (**View:Image Mode** from the menu or press \textbf{Ctrl}+\textbf{Shift}+\textbf{I}), the matrix object displays as either a gray scale image or a color image, depending upon the type of data in the matrix. A matrix of real numbers or complex numbers displays as a gray-scale image while RGB values will display as a color image.
An image in a matrix can be cropped within the existing window or it can be cropped and copied to create a new matrix window:

1. Make sure that there is a check mark beside Region of Interest Tools on the Tools menu. If this menu item is not checked, select it.
2. Click the Rectangle Tool button on the Tools toolbar.
3. Drag out a rectangular area on the image.
4. Right-click on the rectangle and select Crop from the shortcut menu.
Note: If the matrix object is an image, the object icon will display as ![image icon] regardless of view mode. Likewise, when the matrix object contains numbers, the object icon will display as ![number icon] regardless of view mode.

10.1.3 Matrix Books

Like the workbook window, the matrix book window is created from a customizable template (.otmu file). The matrix template stores such things as number of sheets in the book, the names of the matrix sheets, matrix dimensions, data type, math functions, data import handling instructions as well as various style and format options.

When you create a new matrix book, the book is named MBook\(N\), with \(N\) reflecting the order of window creation. Appended to the book name, you will see something like ":1/3" where the first integer denotes the active matrix object and the second denotes the number of matrix objects in the active matrix sheet. Following the above example, if you click the yellow object icon to the right side of the matrix, the menu shows three matrix objects with the first being the active one - the one with a check mark placed beside it (note that in our illustration, the objects are empty).
Previously, you could right-click on a worksheet tab and add a graph or notes window as a sheet in the workbook. Now, in Origin 2018b, you can add **Add Matrix as Sheet**, allowing you to insert a matrix book into a workbook. This gives you more flexibility when building your Analysis Templates.

### 10.1.4 Matrix Sheets

Prior to Origin 2018, an Origin matrix book could a maximum of 255 sheets. That number is now increased to 1024. When you have more than 255 sheets in a book, you will need to save the file using one of the new Unicode-compliant formats (opju, ogmu, etc).

A matrix book can have up to 1024 matrix sheets. The default matrix book template - ORIGIN.otmu - has a single matrix sheet containing 32 rows and 32 columns. Each matrix sheet can differ in dimensions (number of rows and columns and X & Y range).

To specify the dimensions of the matrix sheet:

1. Click on a tab to activate the sheet and choose **Matrix: Set Dimensions/Labels**. This opens the **Matrix Dimensions and Labels** dialog box.
2. Specify a number of columns (X dimension) and rows (Y dimension).
3. Specify a **From** and **To** value for X (columns) and Y (rows).
Note: The X and Y coordinates of the matrix are evenly spaced. The first X is mapped to the first matrix column and the last X is mapped to the last matrix column. The X coordinates of other columns are interpolated. Matrix rows are similarly mapped using the From Y and To Y values. When plotting or analyzing matrix data, the position of a point in 3D space is determined by the column X and row Y coordinate values (not column or row index) and the Z value contained in the cell intersected by the row and column.

10.1.5 Matrix Objects

A matrix sheet can contain up to 65,504 matrix objects (64-bit, 32-bit max = 43,339), though the actual limit is likely to be far less (determined by system resources). Objects in a sheet share the same X/Y dimensions and column (X) and row (Y) headers, but every object can have its own Z header. Other matrix object properties include internal data type and numeric display options.

Matrix object properties are set in the user interface via the Matrix Properties dialog box. To open the dialog box:

1. Make sure that the matrix object is active (check mark shows beside it in the object menu).
2. Choose Matrix:Set Properties... from the main menu.

You can set properties for multiple matrix objects without closing the Matrix Properties dialog boxes by clicking the Previous or Next buttons at the top of the dialog box.

10.2 Virtual Matrix

Data arranged in a block of worksheet cells can be treated as a "virtual matrix". As is the case with regular matrix data, virtual matrix data can be used to create 3D plots, such as color mapped surfaces or contour plots. The data can include a column or label row with the X or Y values. Unlike a regular matrix which only supports a linear spacing in the X and Y dimensions, a virtual matrix supports irregular spacing of X and Y coordinate values (provided those values are in ascending or descending order).
**Note:** You can create 3D plots from XYZ columns of worksheet data in which data are irregularly spaced in the X and Y dimensions. This is not considered a "virtual matrix."

### 10.3 Matrix Templates

Matrix windows are created from a matrix template file (*.otmu). The template file saves such things as the number of sheets in the matrix book, the number of rows and columns in each sheet, internal memory allocated for each sheet, mathematical formula used to fill the matrix with numbers and certain ASCII import and export options.

**Note:** Data are NOT saved with the matrix template file.

To save the active matrix window as a template:

1. With the matrix window active, choose **File: Save Template As** from the main menu. This opens the `template_saveas` X-Function dialog box.
2. Select a category from the **Category** drop-down list or enter a new category.
3. Select or type a file name in the **Template Name** box (the .otmu extension is automatically added).
4. Enter a description into the **Template Description** text box (optional).
5. Type the file path for the template or click the browse button to locate your folder. Typically, you would save your template to your **User Files** folder.

The following table lists some of the kinds of things that are saved with the matrix template file. It also tells you where to find these controls.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>What is Saved?</th>
<th>Menu Access</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>--</strong></td>
<td>• The Organizer&lt;br&gt;• The Script Panel&lt;br&gt;• The Matrix Image Thumbnails</td>
<td>Right-click on window title bar and choose:&lt;br&gt;• Show Organizer&lt;br&gt;• Show Script Panel&lt;br&gt;• Show Image Thumbnails</td>
</tr>
<tr>
<td><strong>Matrix Properties</strong></td>
<td>• Matrix Long Name, Units, Comments.&lt;br&gt;• Column width settings.&lt;br&gt;• Column number Display (decimal, scientific, engineering).&lt;br&gt;• Column Digits and data storage</td>
<td>Matrix:Set Properties</td>
</tr>
</tbody>
</table>
### Matrix: Dimensions and Labels

- Numbers of rows and columns in the matrix, xy coordinates, XYZ axis labels.

**Menu Access:**
- Matrix: Set Dimensions/Labels...

### Set Values

- Formula used to create or transform matrix values.

**Menu Access:**
- Matrix: Set Values ...

### ASCII Import Options

- ASCII import options pertinent to the matrix window are saved with the template.

**Menu Access:**
- File: Import: Single ASCII
- File: Import Multiple ASCII

## 10.4 Simple Manipulation of Matrix Data

<table>
<thead>
<tr>
<th>Utility</th>
<th>Menu Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip or Rotate</td>
<td>Matrix: Rotate90</td>
</tr>
<tr>
<td></td>
<td>Matrix: Flip: Vertical</td>
</tr>
<tr>
<td></td>
<td>Matrix: Flip: Horizontal</td>
</tr>
<tr>
<td>Expand (by interpolation)</td>
<td>Matrix: Expand</td>
</tr>
<tr>
<td>Shrink (by averaging)</td>
<td>Matrix: Shrink</td>
</tr>
<tr>
<td>Transpose</td>
<td>Matrix: Transpose</td>
</tr>
<tr>
<td>Convert to Worksheet</td>
<td>Matrix: Convert to Worksheet</td>
</tr>
</tbody>
</table>

## 10.5 Setting Matrix Values

The **Set Values** dialog box is used to generate or transform data in a matrix object.

To open the **Set Values** dialog box, make sure that the matrix object is active, then:
1. From the menu, choose **Matrix: Set Values**.

or

1. Select the matrix by clicking in the upper-left corner (in the empty header cell just below the matrix icon/name), then right-click on the matrix and choose **Set Matrix Values** from the shortcut menu.

---

**Menu Commands**

- **Formula**: Load a saved formula into the matrix formula box. Formulas are saved using **Formula: Save** or **Formula: Save As**.
- **Mat(1)**: Use the menu to include matrix objects in either your matrix formula or your Before Formula Scripts (matrix object reference is inserted at the cursor). A Matrix Browser is available to help in selecting the correct objects. Objects are listed by object index.
- **Mat(A)**: Similar to Mat(1) menu functionality but matrix objects are listed by object Long Name, if one exists.
- **Function**: Add LabTalk functions to your expressions (function name is inserted at the cursor).
- **Variables**: Add a variable or a constant to **Matrix Formula** or **Before Formula Scripts**; Add range variables (including by selection) or file metadata, to Before Formula Scripts.
### Matrix Formula
- Add a single line expression for generating data. Functions, conditional operators and variables can be used.

### Before Formula Scripts
- Enter one or more lines of LabTalk script to be executed before the expression in the Matrix formula box is executed.

Use the **Before Formula Scripts** panel at the bottom of the **Set Values** dialog box to define variables or LabTalk functions that you wish to use in your matrix formula.

Click the **Search and Insert Functions** button to search for built-in LabTalk functions.

## 10.6 Converting Worksheets to Matrixes

There are four methods for converting worksheet data to matrix data.

<table>
<thead>
<tr>
<th>Method</th>
<th>Conversion Type</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Direct  | • X across columns  
• Y across columns  
• No X and Y | Ideal for spreadsheet data that conforms to the following:  
- X data values in the 1st column, Y data values in the 1st row and Z values in columns 2 to N and rows 2 to M.  
- Y data values in the 1st column, X data values in the 1st row and Z values in columns 2 to N and rows 2 to M. |
<table>
<thead>
<tr>
<th>Method</th>
<th>Conversion Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand</td>
<td>• Row</td>
<td>Some ASCII files have an upper limit for characters allowed on a single line. Use this method when your file breaks a single line of data across multiple lines.</td>
</tr>
<tr>
<td></td>
<td>• Column</td>
<td>• Expand by <strong>Row</strong>: specifies the number of ASCII file rows comprising one matrix row.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Expand by <strong>Column</strong>: specifies the number of ASCII file columns comprising one matrix column.</td>
</tr>
<tr>
<td>XYZ Gridding</td>
<td>• Regular</td>
<td>Conversion Type depends upon XY spacing:</td>
</tr>
<tr>
<td></td>
<td>• Sparse</td>
<td>• Choose <strong>Regular</strong> applied for data that are regularly spaced in XY.</td>
</tr>
<tr>
<td></td>
<td>• Random (Renka Cline)</td>
<td>• Choose <strong>Sparse</strong> when you have missing values.</td>
</tr>
<tr>
<td></td>
<td>• Random (Shepard)</td>
<td>• Choose <strong>Renka-Cline</strong>, <strong>Shepard</strong>, <strong>TPS</strong>, <strong>Kriging</strong> or <strong>Weighted Average</strong> methods for data that are irregularly spaced in XY.</td>
</tr>
<tr>
<td></td>
<td>• Random (Thin Plate Spline)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Random (Kriging Correlation)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Random (Weighted Average)</td>
<td></td>
</tr>
<tr>
<td>XYZ Log Gridding</td>
<td>Methods same as <strong>XYZ Gridding</strong></td>
<td>Calculates logarithmic values for X and Y, then performs <strong>XYZ Gridding</strong>.</td>
</tr>
</tbody>
</table>
10.7 Converting Matrixes to Worksheets

There are two methods for converting matrix data to worksheet data:

- **Direct**: This copies the Z values in the matrix to a worksheet with no reordering. If the matrix consists of \( M \) rows by \( N \) columns of Z values, this method produces a worksheet which has \( M \) rows and \( N \) columns. By default, the X and Y coordinates of the matrix Z values are not copied to the worksheet. You can opt to copy X coordinates to the 1st worksheet row or a parameter row and the Y coordinates to the 1st worksheet column.

- **XYZ Columns**: This method produces a worksheet with three columns: an X, a Y and a Z column. The X and Y columns contain the X and Y coordinate values of the matrix Z values. The matrix Z values are contained in the worksheet Z column.
Data in a matrix can be viewed in profile -- either in the X, Y or arbitrary cross-section.

1. Activate the matrix object and choose **Plot > 2D: Profile: Image Profiles** from the main menu.

This creates an image plot and opens the **Image/Contour Profile** dialog box. Use the dialog box to specify X and/or Y profile plots and the location and appearance of the cross-sectional lines. Note that this dialog box is interactive. You can make adjustments to your image profile -- move the cross-sectional lines or change the configuration or the appearance of the plots -- without closing the dialog box. After closed the dialog box, a button **Profiles...** will appear at the right-top corner of graph window, which can be used to reopen the **Image/Contour Profiles** dialog.
10.9 Topics for Further Reading

- Matrix Books, Matrix Sheets and Matrix Objects
- Matrix Book and Matrix Sheet Operations
- What is Saved with the Matrix Template?
- Matrix Dimensions and XY Coordinates
- Matrix Object Data Properties
- Setting Matrix Values
- Matrix Conversion and Gridding
- Creating 3D and Contour Graphs from a Virtual Matrix
- Viewing and Profiling Matrix Data
11 Graphing

11.1 Creating a Graph

Graphs can be created from both hard data and from mathematical functions. With Origin, you can create over 100 graph types using Origin's built-in graph templates. Each of these graphs has been specifically chosen for its applications in various technical fields.

All graph types are accessible from the Plot menu. Note that while most graph types also have a corresponding 2D Graphs or 3D and Contour Graphs toolbar button, some do not. Until you've had time to familiarize yourself with available toolbar buttons, the Plot menu should be your "go to" place for creating graphs.

Creating most graphs involves just two steps.

1. Select your data.
2. Select the plot type.

Some Origin graph types have very specific data requirements. Other graphs can be created from multiple data arrangements. See the Origin Graph Types section for specific requirements.

11.1.1 Creating Graphs from Worksheet Data

Origin's most generic graph types -- line, column/bar, pie -- plus a lot of the more specialized types, are created from worksheet data. The following quick tutorial demonstrates importing an ASCII data file and creating a simple graph.

**Tutorial: One click to create graph with selected data**

1. Open a new workbook and select File: Import: Single ASCII... from the main menu.
2. Choose the file Samples/Curve Fitting/Multiple Gaussians.dat and click Open.
3. Now highlight columns B(Y), C(Y), D(Y) and E(Y) by clicking and dragging across the four column headings.
4. Click Plot > 2D: Line & Symbol: Line & Symbol. A graph window is created with four line and symbol plots. Note that the plots differ by line color and by symbol type.
5. Return to the worksheet, and again select columns B(Y), C(Y), D(Y) and E(Y).
6. This time, select the Plot > 2D: Multi-Panel: 4 Panel menu item. Note that a very different plot is created using the same datasets.

We were able to quickly create two different graphs using the same data. The chapter Customizing Graphs discusses customizing graphs and saving templates in more depth.

We are also able to create 3D plot types from worksheet data. The following tutorial demonstrates creating a 3D surface plot, then overlaying it with a 3D scatter plot.
Tutorial: 3D Surface Plot from XYZ Data

1. Create a new, empty workbook window and import the file \Samples\Matrix Conversion and Gridding\XYZ Random Gaussian.dat.
2. Highlight column C and right click. Select Set As: Z from the fly-out menu.
3. Select Plot > 3D: Surface: 3D Colormap Surface to create a 3D Colormap Surface plot.
4. Select the Graph: Layer Contents... menu item or right click the layer icon on the left-top of the graph to open the Layer Contents dialog. In this dialog, click on drop-down next to the button and select 3D Scatter/Trajectory/Vector from the fly-out menu.
5. Select column C from the left panel and click on the Add Plot button to add the 3D scatter plot to the graph. Click OK to close the dialog.
6. Double-click on the plot to open the Plot Details dialog. In the left panel, expand the Layer1 node and then expand the 2nd node which represents the scatter plot. Click and select the branch named Original. Be sure to leave the node-level check box selected, otherwise this plot will be hidden.
7. In the Symbol tab on the right side, set Shape to Ball, Size to 12 and Color to Color Mapping: Col(C).
8. In the Drop Lines tab, clear the Parallel to Z Axis check box.
9. Select Layer1 from the left panel of the Plot Details dialog. In the Lighting tab, under Mode, select Directional. Click OK to close the dialog.
10. Click on the scatter plot in the graph to select this plot, then in the Style toolbar, click on the button and select the Rainbow palette.

Your graph should look like this:
You can hold down the R key on your keyboard and use the mouse to freely rotate the 3D surface. With the pointer tool active, click on the layer for additional controls to move, stretch and rotate the surface.

11.1.1.1 Worksheet Column Plot Designations

The labels (X), (Y), (Z), etc. in column headings are referred to as the Column Plot Designation. Columns can also be designated as Label, Disregard, Y Error or X Error. Each plot type has certain data requirements (e.g. a simple line plot requires one X and one Y dataset) and column plot designations work in concert with settings saved in the graph template, to allow you to quickly create a graph.

To set the Column Plot Designation, select a column or multiple columns, then from the menu choose Column: Set as:<option>; or right-click and choose an option from the Set As: context menu.

In the 1st tutorial above, we plotted 2D graphs, which require Y data from one or more worksheet columns. The Y data were automatically plotted against the X column data to their left. In 2nd tutorial, we plotted a 3D graph using Z data. The Z data were plotted against X and Y data columns to the left of the Z data column.

Note: For more information on Column Plot Designations and how they affect plotting behavior, see Plot Designation, in documentation for the Column Properties Dialog Box.

11.1.1.2 Selecting Worksheet Data

Various ways to select data for plotting:

- **Single column**: Click on the column heading, e.g. B(Y)
- **Multiple columns**: To select a small number of contiguous columns, click on the first column heading and drag the pointer to the last column heading. To select a large number of contiguous columns, click on the first column heading, use the scroll bar at the bottom of the worksheet to locate the last column, then press the SHIFT key and click on the last column heading. To select non-contiguous columns, press the CTRL key while clicking on the desired column heading.
- **A range in a column**: Click on the first cell of the range and drag to the last cell of the range.
- **Multiple ranges within a column**: Select one range. Press the CTRL key while selecting each range. When plotting, each range will be treated as a separate data plot in a plot group.
- **Ranges across multiple columns**: If cells are contiguous, click on the first cell and drag to the last cell. If cells are not contiguous, press the CTRL key while selecting each range. Each range selection will be treated as a separate data plot in a plot group.
- **Range(s) across all columns**: Click on the first row heading and drag to the last row heading, to select multiple rows. This will select data in all columns in the worksheet. Press the CTRL key while selecting row headings for non-contiguous rows. Each range selection will be treated as a separate data plot in a plot group.
- **Entire worksheet**: Press CTRL+A to select the entire worksheet; or mouse over the bottom-right corner of the blank cell in the upper-left corner of the worksheet. When the pointer becomes a downward-pointing arrow, click to select the entire worksheet.
- **Specific columns**: To select columns by data in column label rows (header rows); or to select columns using a pattern, choose Edit: Select.
11.1.2 Creating a Graph from Matrix Data

As discussed in the Matrix Book, Matrix Sheets and Matrix Objects chapter, a matrix is a dataset of Z values arranged as an array of columns and rows which are linearly mapped to X (column) and Y (row) values. Matrix data is used to create 3D, contour and heatmap graphs -- all of which require require "3D" data. In earlier versions of Origin you had to have your data in a matrix to create such plot types but this is no longer the case (see discussion of the Virtual Matrix below). A few graph types such as a color-filled surface with error bars still require matrix data.

There are still many situations in which you will be creating 3D plots from matrix data. If data are stored in a worksheet and for one reason or another, you need to convert it into a matrix form, see Converting Worksheets to Matrixes.

Once your data are in a matrix form, plotting matrix data is simple: activate the matrix window then select your plot type using a Plot menu command or corresponding 3D and Contour Graphs toolbar button. Since you cannot plot only a portion of the matrix, data selection isn't necessary. You can, however, choose a subset of the data plot to display once the graph is created. See Editing Plot Range in the Manipulating Data Plots section of this chapter.

11.1.2.1 The Virtual Matrix

The Virtual Matrix concept was covered in the Matrix Book, Matrix Sheet and Matrix Object chapter of this Guide. To recap, a virtual matrix is a block of worksheet cells which contain Z values, with X and Y coordinates in the first row or column label row, and first column. X and Y coordinates don't have to be evenly spaced and can even contain text or date/time data.

When selecting and plotting virtual matrix data to 3D, Contour and Heatmap graph types, the worksheet’s Column Plot Designations are ignored. Instead, a dialog box is opened where you designate your X and Y coordinates. The intersecting data points are then treated as Z values.

Tutorial: Contour Plot from Virtual Matrix

1. With a new workbook active, use the File: Import: Import Wizard... menu to open the Import Wizard dialog.
2. Press the browse button in the dialog and select the file Waterfall.dat from the Samples\Graphing subfolder.
3. This file has an import filter already associated with it. Press the Finish button to import the file.
4. With the workbook active, press CTRL+A to select the entire sheet.
5. Now select the Plot > 2D: Contour: Contour - Color Fill menu item. The plotvm dialog will open.
6. In the dialog, set the Y Values in drop-down to Column Label, and then set the Column Label drop-down to Excitation Wavelength(nm).
7. Set the X Values in drop-down to 1st column in selection, then press OK to close this dialog.
8. The contour plot will be created.
9. Use the Graph: Speed Mode... menu item, then in the dialog that opens, set the Speed Mode drop-down to Off and press OK. This will turn off speed mode so that all data points are plotted (see the discussion of Speed Mode, below).
10. Click on the contour plot to select this data plot, then from the Style toolbar, click the Palette button and then select the Pumpkin Patch palette. Your graph
11.1.3 2D and 3D Function Plots

To create function plots and parametric function plots, select **File: New: Function Plot** menu. There are four options to choose from:

<table>
<thead>
<tr>
<th>Type</th>
<th>Function Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Function Plot</td>
<td>( y = f(x) )</td>
</tr>
<tr>
<td>2D Parametric Function Plot</td>
<td>( x = f_1(t) )</td>
</tr>
<tr>
<td></td>
<td>( y = f_2(t) )</td>
</tr>
<tr>
<td>3D Function Plot</td>
<td>( z = f(x, y) )</td>
</tr>
<tr>
<td>3D Parametric Function Plot</td>
<td>( x = f_1(u, v) )</td>
</tr>
<tr>
<td></td>
<td>( y = f_2(u, v) )</td>
</tr>
<tr>
<td></td>
<td>( z = f_3(u, v) )</td>
</tr>
</tbody>
</table>

Once you customize your contour levels and colors, you can save your settings as a Theme, or simply copy-paste your customizations from one graph to another. To save a Theme, right-click on the graph and choose **Save Format as Theme**; or use the **Colormap Theme controls** on the **Colormap/Contours** tab of the **Plot Details** dialog box.
These plot types are also accessible from the function plot buttons on the **Standard** toolbar.

![Function Plot Buttons](image)

**Tutorial: 3D Function and 3D Parametric Function in Same Layer**

1. From the menu, choose **File: New: Function Plot: 3D Parametric Function Plot**...
2. In the dialog that opens, click on the arrow button at the top right side of the dialog, and from the fly-out menu select the built-in example **Partial Torus (System)** and press **OK** to close the dialog. The function plot will be created.
3. With the function plot window active, invoke the menu **File: New: Function Plot: 3D Function Plot**....
4. In the dialog that opens, enter -5 and 5 for the **From** and **To** edit boxes for x and y scale.
5. In the **Z(x,y)** edit box, enter **0**.
6. Set the drop-down at the bottom left corner of the dialog to **Add to Active Graph** and press **OK** to close dialog.
7. The **Z=0** plane will be added to the graph, and the plane will properly intersect the parametric surface plot. You can hold down the **R** key and use the mouse to freely rotate the plot.
• Some function plot dialogs provide sample formulas. Click the arrow button beside Theme at the top of the dialog box to access them. You can download more examples at http://originlab.com/3dfunctions.

• For 2D parametric, 3D, and 3D parametric function plots, data is generated when the function plot is created. To create data for 2D function plots, right-click the plot and choose Make dataset copy of Function or if on the Function tab in Plot Details, click the Workbook button.

• Besides function plots, you can also create graphs with all built-in and user-defined nonlinear curve-fitting or surface-fitting functions. From the menu, choose Analysis: Fitting: Simulate Curve... or Simulate Surface.... You can even add noise to the plot. Corresponding data is created as well.

11.2 Plotting without Using Column Plot Designations

While Column Plot Designations remain an important concept, they are no longer required by many Origin graphing and analysis operations. For instance, the Plot Setup dialog box allows you to freely specify which column is used as X, Y, etc. when plotting, thereby overriding the Column Plot Designations.

In order to make full use of the Plot Setup dialog box, you need to have some familiarity with the hierarchy of objects contained in the Origin graph window.

11.2.1 Pages, Layers, Plots and the Active Plot

Each Origin graph window is comprised of a single, editable graph page. The graph page is defined by the white area inside the graph window. Anything that lies outside the page is not printed or exported. By default, the dimensions of the graph page are defined by the printable area of your default printer driver; without adjusting settings, a printed graph should fill the printed page.
• The graph page must contain at least one, and may contain as many as 1024, graph layers.
• Each graph layer generally contains one or more data plots (graphical depictions of datasets). Note that the graph in the image above contains three graph layers, represented by the three non-printing layer icons in the upper-left corner of the graph page. Note that there is one layer icon which is highlighted, indicating the active layer.
• Just as there is only one active layer, there is only one active plot in a graph. Usually, the active plot is the first plot in the active layer. To verify which plot is active, click on the **Data** menu while the graph is active. The active plot will have a check mark beside it.

The hierarchical structure of the graph page can be seen in these places:

• The **Plot Details** Dialog Box (**Format: Page Properties ...**)
• The **Object Manager** (**View: Object Manager**)
11.2.2 The Plot Setup Dialog Box

The Plot Setup dialog box is a flexible all-in-one plotting tool for creating graphs and manipulating the data plots in an existing graph.

- Creating graphs without regard to Column Plot Designations
- Creating graphs from a combination of data sources: multiple worksheets, workbooks, matrix books, loose datasets, etc.
- Creating graphs combining multiple plot types.
- Adding, removing, replacing data plots.
- Grouping or ungrouping data plots.
- Reordering data plots in a layer or moving data plots to another layer.
To create a graph with the **Plot Setup** dialog, make sure no data is selected in the active worksheet and choose the plot type that you want to create (from the **Plot** menu or by clicking on a toolbar button).

To open the **Plot Setup** dialog for an existing graph window, right-click on any layer icon in the upper left corner of the graph window and select **Plot Setup...**, or choose menu **Graph: Plot Setup...**.

---

**Tutorial: Creating a Simple Line Plot with the Plot Setup Dialog Box**

1. Click the **New Workbook** button on the **Standard** toolbar.
2. Click **File: Import: Single ASCII**, browse to the Origin installation folder and import the file \Samples\Curve Fitting\Step01.dat. Starting from column B, columns are actually paired - X data and Y data -- but by default all columns are assigned a "Y" Column Plot Designation on import.
3. Without selecting any data, click **Plot > 2D: Line: Line**. This opens the Plot Setup dialog box.
4. Click the two "double-arrow" buttons to show all three dialog box panels.
5. In the middle panel, select the "X" box for Column B (Sensor Ax) and the "Y" box for Column C (Sensor Ay), then click the **Add** button to add the plot to Layer 1 in the bottom panel.
6. Select the "X" box for column D (Sensor Bx) and the "Y" box for Column E (Sensor By), then click **Add**.
7. Select the "X" box for column F (Sensor Cx) and the "Y" box for Column G (Sensor Cy), then click **Add**. Three plots are added to Layer 1.
8. Press CTRL and click on each plot in the bottom panel to select all three, then right-click and choose **Group**.
9. Click **OK** to create a grouped line plot.

---

**Tutorial: Creating a Graph with Data from Multiple Worksheets**

1. Click the **New Workbook** button on the **Standard** toolbar.
2. Click **File: Import: Multiple ASCII**, browse to the Origin installation folder and select Sensor01.dat, Sensor02.dat and Sensor03.dat under \Samples\Curve Fitting\ to import. After Import, 3 workbooks are created.

3. Without selecting any data, click **Plot > 2D: Line+Symbol: Line+Symbol**. This opens the Plot Setup dialog box.

4. Expand the top panel if it is hidden. From the **Available Data** list, choose **Worksheets in Folder**.

5. Select Sensor01, Sensor02 and Sensor03 sheets in the top panel.

6. In the middle panel, select the "X" box for Column A (Displacement) and the "Y" box for Column B (Sensor Output), then click the **Add** button.

7. Click **OK** to create a grouped Line+Symbol plot using Sensor Output columns from 3 worksheets.

- The Plot Setup middle panel only allows choosing one X column at a time.
- If your worksheet is set up with the correct Column Plot Designations (e.g. XXYX) but you only want columns with same Long Name, click the toggle in the upper-right corner of middle panel so that only plottable columns show (e.g. for 2D plot types, X columns are not shown). Then you can sort the columns.
and select all columns with same Long Name and plot them together. The Y columns will be plotted against corresponding X columns.

- To change a data plot's type, choose the corresponding plot in bottom panel. Corresponding X and Y columns will show in middle panel. Choose a new plot type in middle panel and click the Replace button.
- All data plots in a group share the same plot type. If you want to change the plot type of a single plot in a group, right-click the Group node in bottom panel and Ungroup first.
- Drag and drop data plots in the bottom panel to move them to different layers.
- If the bottom panel is hidden and you have selected columns in the middle panel, you can directly click the OK button to create your graph.

### 11.3 Manipulating Data Plots

The following sections discuss higher level modifications to existing graphs such as changing plot type, adding or removing plots from the layer and controlling the density of plotted points (Speed Mode). For more detailed plot customizations, including those involving such things as changing plot symbols, colors, and legend customizations, see the Customizing Graphs chapter.

The following methods of manipulating data plots in the graph window are fairly easy to use. Thus, you may want to choose File: Open Template and pick your template to create a blank graph window. Then, using the methods below you can add and group data plots in the graph.

#### 11.3.1 Changing Plot Type

Some Origin plot types (e.g. scatter, line, line+symbol) allow you to interchange the plot type of an existing plot with a few other select plot types. Some examples:

- Scatter, line, line+symbol, column/bar are interchangeable.
- 3D scatter/trajectory/vector, 3D bars, 3D surface are interchangeable.

To change the plot type of an existing plot:

- Right-click on the data plot and choose Change Plot to: Graph Type from the shortcut menu.
- Click on the data plot and choose Format: Plot Properties and in Plot Details choose from the Plot Type drop-down list.
- Click on the data plot, then click one of the supported graph toolbar buttons.

Note that if you switch plot types and the selected plot is part of a plot group, all plots in the group are switched.

#### 11.3.2 Exchanging Data Plots

You can quickly change the data source (X, Y, or worksheet) of a plot using these context menu commands. Right-click on a data plot, then select one of these options:
Graphing

- **Change X.** This menu item allows you to change the assignment of X data to another data column in the same worksheet.
- **Change Y.** This menu item allows you to change the assignment of Y data to another data column in the same worksheet.
- **Change Worksheet.** This menu item allows you to replace both X and Y with data from another worksheet. The selected worksheet should have the same Short Names, the same Column Plot Designations and the same row index range as the current worksheet.

If you have a grouped data plot, then clicking once on any of the plots in the group will select the entire group. Click a second time to select a particular member of the group. The context menu options to change worksheet, X, or Y are available only when a single data plot is selected.

**Tutorial: Changing X and Y assignment of a data plot**

1. Start with a new workbook and import the file *automobile.dat* from the Samples\Statistics sub-folder of the Origin installation folder.
2. Select the Gas Mileage column and select the Plot: Symbol: Scatter menu item. The Gas Mileage column is plotted against the default X column Year.
3. Right-click on the data plot and select Change X: Engine Displacement. The Gas Mileage column is now plotted against Engine Displacement.

**Note:** If new data is significantly outside of the current range for X or Y axes, you will be asked if the graph should be rescaled. If data are not significantly different, you may want to manually rescale the graph (Hot key: CTRL+R).

If you perform analysis on the data plot (e.g. linear regression with Recalculate set to Auto), the fit results will automatically update when you change X/Y or the worksheet.

### 11.3.3 Adding, Removing and Hiding Data Plots

Use the following methods to add or remove data plots from a graph.

#### 11.3.3.1 Adding Data with the Add Plot to Layer Menu Command

This is a simple method for adding a range of data to an existing Line, Scatter, Line + Symbol, Column or Area graph:

1. Highlight your worksheet data.
2. Go to the graph window where you want to add data. If there are multiple layers in the graph, press the layer icon to activate the desired layer.
3. From the menu, choose Graph: Add Plot to Layer: Graph Type.
You can use the **Graph: Add Error Bars...** menu item to add error bars, calculated from statistics such as standard deviation.

- Error data will be output beside the data column in the worksheet. This only works for the active plot. You can set the active plot from the **Data** menu. The active plot has a check mark beside it.

### 11.3.3.2 Adding Data by Drag and Drop

You can add data to a graph by drag and drop. When using this method, Origin relies on worksheet **Column Plot Designations** to create the plot.

1. Select the worksheet data (one or more columns or a range of one or more columns).
2. Move the mouse over the left or right edge of the selected range.
3. When the pointer looks like this `↵`, hold down the left mouse button and drag the data to the graph window. Release the mouse.
4. If there are multiple layers in the graph, drag the data to the desired layer, then release the mouse.

Usually the current plot type is used when plotting by drag-and-drop. To change the global plot type to use when drag and drop, choose **Tools: Options...** from the main menu. Go to the **Graph** tab and change the global **Drag and Drop** plot type.

### 11.3.3.3 Adding and Removing Data with the Layer Contents Dialog Box

Open the **Layer Contents** dialog box by double-clicking or right-clicking on the layer icon(s) in the top left corner of the graph page. Controls in the left panel can be used to filter and list available datasets. The right panel lists datasets that are plotted in the active layer.
Controls in the center of the dialog box allow you to add or remove plots from the active graph layer. When adding data to the graph, click the list button (downward-pointing arrow) to pre-select the plot type before adding data to the layer. Use controls in the right panel to group or ungroup plots, or re-order plots in the layer.

11.3.3.4 Adding, Removing, Replacing or Hiding Data Plots with the Plot Setup Dialog Box

Among other things, the Plot Setup dialog box can be used to add or remove data plots from the graph.

1. To add plots to the graph, use the top panel of Plot Setup to identify your source data.
2. Use the controls in the middle panel to specify the plot type and how the data selection should be treated (as X, Y, yError or Label).
3. In the bottom panel, choose the Layer to which you want to add plots, then click the Add button.
4. To remove a plot from the layer, select the plot in the bottom panel, then right-click and choose Remove.
5. To hide a plot, uncheck the Show check box for the plot.
6. To replace a plot, select the plot in bottom panel, then change the X and Y selection and plot type in middle panel and click the Replace button.
11.3.3.5 Adding Data by Direct ASCII Import

You can import ASCII files directly into the active graph window using the Import ASCII toolbar button. Note that this method works only with files having a simple structure and it supports only the simplest of graph types - Line, Scatter, Line + Symbol, Column and Bar charts.

1. Click the Import ASCII button. This opens the Import ASCII dialog box.
2. Choose a file.
3. Click Open.

The file is imported and plotted in the active graph window.

11.3.3.6 Adding Data by Copying and Pasting a Plot

You can copy a plot from an existing graph window and paste it into the same or another window.

1. Click on the plot to select it and press CTRL+C.
2. Click on the target graph and press CTRL+V.

Simultaneously, a ClipbN worksheet is created. You can open this worksheet by double-clicking on the plot, then clicking the Workbook button at the bottom of Plot Details; or right-click on the plot in the graph window or in the Object Manager and choose Create worksheet ClipbN.

You can also "paste" a copied plot to a worksheet cell. Select a cell and press CTRL+V to fill the column(s) with plot data.

11.3.3.7 Removing or Hiding Plots with the Object Manager

The Object Manager is a dockable panel that allows for easy manipulation of graph layers and data plots. See the section on The Object Manager in this Guide.

To hide or remove plots, right-click on a plot and choose from the shortcut menu:
• To show or hide plots of the same Long Name.
• Show all plots.
• Remove a plot from the graph window (not the same as hiding).

  • When you right-click on a plot, there is a Remove shortcut menu item. If the plot is part of a group, the entire group will be removed.
  • When you right-click on a plot, you can use the Hide Data Plot and Hide Others shortcut menu items to quickly hide selected plots (restore plots by enabling their display in the Object Manager or in Plot Details).

11.3.3.8 Removing or Hiding Data with Plot Details

In the left panel of the Plot Details dialog box (Format: Plot Properties), right-click on a plot and choose Remove or Hide from the context menu. Remove will delete the data plot from the graph so if you just want to temporarily hide a plot, choose Hide. Neither of them will delete data from worksheet or matrix.
11.3.3.9 Deleting Plots using the Delete Key

Click on a data plot (either in the graph window or Object Manager) and press the Delete key. If the selected plot is part of a group, the entire group is deleted. This action does not delete worksheet or matrix data. To restore the deleted plots, choose Edit: Undo Remove Plot from the main menu.

11.3.3.10 Editing Plot Range

Once a graph is made, you can edit the plot display range, specifying only a portion of the plotted data:

- Right-click on the plot and choose the Edit Range... shortcut menu command. Edit the From and To values.
- In the right panel of the Layer Contents dialog box (Graph: Layer Contents), turn on the Range column by right-clicking on the column headings and choosing Range. Click on a plot's range values, then click the ... button that appears to the right side of that column.
- In the bottom panel of Plot Setup (Graph: Plot Setup), click on the plot range in the Range column and click the ... button that appears to the right side of that column.

Choose Graph: Rescale to Show All to rescale the graph after editing the plot range.

11.3.4 Grouping Data Plots

When you make multiple range or column selections, then create a graph, Origin groups the resulting data plots in the graph layer. This applies to most 1D (statistical) and 2D graphs, plus 3D XYY (XYY 3D bar, 3D ribbon, 3D wall, and 3D waterfall plots) and 3D XYZ (3D scatter, 3D bar) graphs.

Grouping provides for quick creation of presentation-ready graphs because each plot in the group is assigned a differentiating set of plot attributes (line color = black, red, green...; symbol shape = square, circle, triangle...; etc.). Assignments are made by cycling through a pre-determined (user-modifiable) increment list of styles. For instance, the first plot of a grouped line plots might be denoted by a black line; the second plot might be denoted by a red line (the second color in the color list), the third plot by a green line (the third color in the color list), and so on.

Tutorial: Creating a simple grouped data plot

1. Open a fresh worksheet and click the Import Single ASCII button on the Standard toolbar.
2. Browse to the Samples\Graphing subfolder in the Origin software folder and Open GROUP.DAT.
3. Select B(Y), C(Y), and D(Y) columns
4. Click the Line & Symbol button on the 2D Graphs toolbar. Note that line and symbol color and symbol type are automatically differentiated for each plot.
Tutorial: Grouping (or ungrouping) plots manually

• **Via the Layer Contents dialog box**

1. To open the **Layer Contents dialog box**, double-click on the *layer n* icon in the upper-left corner of the graph window.
2. To create a group, select the desired data sets from the **Layer Contents** list (use CTRL + select, SHIFT + select, or simply drag the mouse to select multiple data sets).
3. Click **Group**. Note that each plot in Layer Contents is now preceded by a *gn* (for "group1", "group2", etc.).
4. To ungroup, click on one of the grouped data plots in the **Layer Contents** list and click **Ungroup**.

• **Via the Plot Setup dialog box**

1. To open the **Plot Setup** dialog box, ALT + double-click on the *layer n* icon in the upper-left corner of the graph window.
2. To create a group, select the desired plots from the **Plot List** (use the CTRL or SHIFT keys to select multiple data sets).
3. Right-click and select **Group**. Note that a **Group** icon now precedes the selected plots in the Plot List.
4. To ungroup, right-click on the **Group** icon and choose **Ungroup** from the shortcut menu.

**11.3.5 Speed Mode**

With **Speed Mode**, you can control the number of data points displayed in a graph layer. This option is most useful when working with large data sets. Speed Mode can be turned on for any 2D or 3D graph. When Speed Mode is enabled, the layer icon displays in red and a **Speed Mode is On** watermark appears in the layer. The watermark is *not included when printing, copying, or exporting the graph.*
To adjust Speed Mode settings:

1. With your graph active, select **Format: Layer Properties** from the Origin menu.
2. Select the **Size/Speed** tab.
3. For plots created from worksheet data, Select the **Worksheet Data, Maximum Points Per Curve** check box to enable Speed Mode for all the data plots in the layer that are created from worksheet data. Type the desired value (n) in the associated text box. If the number of data points in a data plot exceeds n, Origin displays a subset of the data plot containing n points, drawn by extracting values at regular intervals from the data set.
4. For 3D data plots created from a matrix or for contour data in the layer, Select the **Matrix Data, Maximum Points Per Dimension** check box to enable Speed Mode. Type the desired value (n, m) in the X and Y text boxes. If the number of data points in a data plot exceeds n or m, Origin displays a subset of the data plot composed of -- at maximum -- n by m points. This subset is drawn by extracting values at regular intervals from the matrix columns (X) and rows (Y).

For broad control, you can select **Speed Mode** from the **Graph** menu. This opens the **speedmode X-Function** dialog. The dialog lets you specify a number of options for where your changes should apply (Target) as well as a range of Speed Mode settings from **Off** to **On - High**.

Click the **Enable/Disable Speed Mode** button on the Graph toolbar, to toggle Speed Mode on/off for all layers in the graph window.

To turn off the **Speed Mode is On** watermark:

1. Select **Tools: Options** to open the Options dialog box.
2. Select the **Graph** tab and clear the **Speed Mode Show Watermark** check box and refresh the graph, if needed.

**Notes on Speed Mode:**

- The Speed Mode controls on the **Size/Speed** tab of the layer’s Plot Details only apply to what you see on screen. They do not apply to graphs that are printed or exported, by default. If you wish to skip points in printouts, use controls in the **Print** dialog. See the discussion of the Skip Points feature as it applies to some graph windows in the Origin Help file. If you wish to apply Speed Mode settings to graphic export, please see this discussion of **Performance Group** controls on the **Miscellaneous** tab of the Plot Details dialog box or use controls under the **Export Settings** node in the **Graph Export** dialog.
- All Speed Mode settings are saved with the graph template. If you make changes to Speed Mode settings for a particular graph type, you will have to resave the graph template to make those changes permanent.
- Always exercise caution when using Speed Mode. Since Speed Mode systematically weeds out a portion of your data points, it should be kept in mind that any graph in which Speed Mode is turned on, may -- or may not -- accurately represent your data, to your satisfaction. Always familiarize yourself with your data and adjust and compare Speed Mode settings to ensure that trends in your data are accurately depicted.

### 11.4 Publishing Your Graph: Copy/Paste, Image Export, Slide Shows and Printing

There are a number of ways to present your finished graph.

- Copy a graph page and paste it in other applications such as Word, Powerpoint, etc.
- Export graph page as an image file (raster or vector).
- Send Graphs to Powerpoint.
- Printout.
- Slideshow within Origin.
- Create Movies.

Please read details in the Publishing and Export chapter of this User Guide and the "Topics for Further Reading" there.

### 11.5 Origin Graph Types

Origin supports over 100 plot types. Origin’s 2D graphs are plotted from **Worksheet** data. Origin’s 3D graphs are plotted from **Worksheet** data (XYY, XYZ), a worksheet arrangement we refer to as a **Virtual Matrix** or from **Matrix** data.
Origin Graph Samples of most 2D and 3D graph types are included with your Origin software. To view graphs, supporting data and guidelines for making the graphs, choose Help: Origin Central; or click on the Origin workspace to activate Origin and press F11 on your keyboard.

The tables below list all Origin 2D and 3D graph types, grouped as they appear in the Plot menu:

- The Plot menu icon for each graph type precedes the graph name.
- The Notes column provides basic information on data requirements. For more specific data requirements, click on the graph name beside the Plot menu icon.

### 11.5.1 2D Graphs

Beginning with Origin 2018b, you can modify the size of the Plot menu icons using the LabTalk system variable @PPS. To find out how to change the value of a system variable, see Customizing Origin Using System Variables.

<table>
<thead>
<tr>
<th>Plot Menu Group</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Line            | ![Graph Types](image) | • Start with a Worksheet.  
• Select one or more Y columns or at least a portion of one Y column.  
• Multiple Y columns are grouped in layer.  
• If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.  
• For specific data requirements, follow links in the Graph Types column. |
<table>
<thead>
<tr>
<th>Plot Menu Group</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scatter</td>
<td>Scatter</td>
<td>Start with a <strong>Worksheet</strong>.</td>
</tr>
<tr>
<td></td>
<td>Scatter Central</td>
<td>If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.</td>
</tr>
<tr>
<td></td>
<td>Column Scatter</td>
<td>For specific data requirements, follow links in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td></td>
<td>Y Error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>XY Error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertical Drop Line</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bubble</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Color Mapped</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bubble + Color Mapped</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Error Band</td>
<td></td>
</tr>
<tr>
<td>Line + Symbol</td>
<td>Line + Symbol</td>
<td>Start with a <strong>Worksheet</strong>.</td>
</tr>
<tr>
<td></td>
<td>Line Series</td>
<td>Select one or more Y columns or at least a portion of one Y column.</td>
</tr>
<tr>
<td></td>
<td>2 Point Segment</td>
<td>Multiple Y columns are grouped in the graph layer (except Line Series).</td>
</tr>
<tr>
<td></td>
<td>3 Point Segment</td>
<td>For Line Series graph, select 2 or 3 Y columns.</td>
</tr>
<tr>
<td></td>
<td>Spline Connected</td>
<td>If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For specific data requirements, follow links in the <strong>Graph Types</strong> column.</td>
</tr>
</tbody>
</table>
## Plot Menu Group

### Function

<table>
<thead>
<tr>
<th>New 2D Plot</th>
<th>New 2D Parametric Plot</th>
</tr>
</thead>
</table>

- Function plots are not created from physical data.
- Once a function plot is created, you can obtain the derived dataset.
- For more information on function plots, follow links in the **Graph Types** column.

### Bar

<table>
<thead>
<tr>
<th>Column</th>
<th>Column + Label</th>
<th>Bar</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Stacked Column</td>
<td>Stacked Bar</td>
</tr>
<tr>
<td></td>
<td>100% Stacked Column</td>
<td>100% Stacked Bar</td>
</tr>
<tr>
<td></td>
<td>Floating Column</td>
<td>Floating Bar</td>
</tr>
</tbody>
</table>

- Start with a **Worksheet**.
- For Bar, Column or Column + Label, select one or more Y columns (multiple Y columns are grouped in layer).
- For Floating Bar/Column, select two Y columns.
- For Stack graphs, select two or more Y columns.
- If there is an associated X column, X column supplies X values; otherwise, Y **sampling interval** or row number is used.
- For specific data requirements, follow links in the **Graph Types** column.

### Pie

| 3D Color Pie Chart | 2D B&W Pie Chart |

- Start with a **Worksheet**.
- Select exactly one Y column or a range from one Y column.
- If there is an associated X column, the X data are used in the graph legend; otherwise row number is used.
- For specific data requirements, follow links in the **Graph Types** column.
<table>
<thead>
<tr>
<th>Plot Menu Group</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td></td>
<td>- Start with a <strong>Worksheet</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- If there is an associated X column, X column supplies X values; otherwise, Y <strong>sampling interval</strong> or row number is used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- For specific data requirements, follow links in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td></td>
<td><strong>Area</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Stacked Area</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>100% Stacked Area</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Fill Area</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Fill 2 Colors</strong></td>
<td></td>
</tr>
<tr>
<td>Multi-Y</td>
<td><strong>Double-Y</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>2Ys, Column-Line&amp;Symbol</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Double-Y Column Graph</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>3Ys Y-Y-Y</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>3Ys Y-YY</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>4Ys Y-YYY</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>4Ys YY-YY</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Multiple Y Axes...</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Stacked Lines by Y Offsets</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Colormapped Line Series</strong></td>
<td></td>
</tr>
</tbody>
</table>
### Plot Menu Group

<table>
<thead>
<tr>
<th>Plot Menu Group</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **Multi-Panel** | ![Vertical 2 Panel](image) | - Start with a **Worksheet**.  
- Select one Y column (or range) per panel.  
- If there is an associated X column, X column supplies X values; otherwise, Y **sampling interval** or row number is used.  
- For specific data requirements, follow links in the **Graph Types** column. |
|                | ![Horizontal 2 Panel](image)   |       |
|                | ![4 Panel](image)              |       |
|                | ![9 Panel](image)              |       |
|                | ![Stack...](image)            |       |
|                | ![Multiple Panels by Label...](image) |       |
| **Zoom**       | ![Zoom](image)                 | - Start with a **Worksheet**.  
- Select at least one Y column or a range from at least one Y column.  
- If there is an associated X column, X column supplies X values; otherwise, Y **sampling interval** or row number is used.  
- For specific data requirements, follow the link in the **Graph Types** column. |
<table>
<thead>
<tr>
<th>Plot Menu Group</th>
<th>Graph Types</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Box</strong></td>
<td><strong>Box Chart</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Interval Plot</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Marginal Box Charts</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Bar Chart</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Box Overlap</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Box Normal</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Bar Overlap</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Bar Normal</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Scatter Interval</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Double Y Box</strong></td>
</tr>
<tr>
<td><strong>Histogram</strong></td>
<td><strong>Histogram</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Histogram + Probabilities</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Stacked Histograms</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Marginal Histograms</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Distribution</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Histogram with Labels</strong></td>
</tr>
</tbody>
</table>

- Start with a **Worksheet**.
- Select at least one Y column or a range from at least one Y column.
- For specific data requirements, follow the link in the **Graph Types** column.
<table>
<thead>
<tr>
<th>Plot Menu Group</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Kernel Density</td>
<td>2D Kernel Density</td>
<td>• Start with a Worksheet.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select at least one Y column or a range from at least one Y column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For specific data requirements, follow the link in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td>Scatter Matrix</td>
<td>Scatter Matrix</td>
<td>• Start with a Worksheet.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select two Y columns or a range from two Y columns.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For specific data requirements, follow the link in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td>Probability</td>
<td>Probability Plot, Q-Q Plot</td>
<td>• Start with a Worksheet.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select one Y column or a range from one Y column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For specific data requirements, follow the link in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td>Pareto</td>
<td>Pareto Chart - Binned Data, Pareto Chart - Raw Data</td>
<td>• Start with a Worksheet.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select one Y columns or a range from one Y column (Raw), or a Y column of Binned results.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For specific data requirements, follow the link in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td>Plot Menu Group</td>
<td>Graph Types</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| **QC (X-bar R) Chart** | ![QC (X-bar R) Chart](image) | - Start with a **Worksheet**.  
- Select at least one Y column or a range from at least one Y column.  
- For specific data requirements, follow the link in the **Graph Types** column. |
| **Contour** | ![Contour - Color Fill](image) ![Contour B/W Lines + Labels](image) ![Gray Scale Map](image) ![Heat Map](image) | - Contour Color Fill, B/W Lines + Labels, Gray Scale Map, Contour Profiles: **XYZ, Virtual Matrix, Matrix**.  
- Heat Map: **Virtual Matrix, Matrix**.  
- For specific data requirements, follow links in the **Graph Types** column. |
<table>
<thead>
<tr>
<th>Plot Menu Group</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polar</td>
<td><img src="image" alt="Polar theta(X) r(Y)" /></td>
<td>• Start with a Worksheet (Polar, Polar Contour) or Matrix (Polar Contour only).</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Polar r(X) theta(Y)" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Bar theta, r" /></td>
<td>• For data requirements and other information on all polar graphs except polar contour graphs, see Polar Graph.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Bar r, theta" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Line + Symbol theta, r" /></td>
<td>• For data requirements and other information on polar contour graphs from XYZ data, see Polar Contour from XYZ Data.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Line + Symbol r, theta" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Symbol theta, r" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Symbol r, theta" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Polar Contour theta(X), r(Y)" /></td>
<td>• For data requirements and other information on polar contour graphs from matrix data, see Polar Contour from Matrix Data.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Polar Contour theta(X), theta(Y)" /></td>
<td></td>
</tr>
<tr>
<td>Vector</td>
<td><img src="image" alt="Vector XYAM" /></td>
<td>• Start with a Worksheet.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Vector XYXY" /></td>
<td>• For XYAM Vector, select three Y columns (or a range of the three Y columns).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For XYXY Vector, select two X columns and 2 Y columns (or a range of two X and two Y columns).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For specific data requirements, follow links in the Graph Types column.</td>
</tr>
<tr>
<td>Plot Menu Group</td>
<td>Graph Types</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| **Ternary**     | ![Ternary](image1), ![Ternary, Line+Symbol](image2), ![Ternary, Line](image3), ![Ternary Contour](image4), ![Piper](image5) | - Start with a **Worksheet**.  
- For specific data requirements, follow links in the **Graph Types** column. |
| **Stock**       | ![High-Low-Close](image6), ![Japanese Candlestick](image7), ![OHLC Bar Chart](image8), ![OHLC-Volume](image9), ![Line](image10) | - Start with a **Worksheet**.  
- For specific data requirements, follow links in the **Graph Types** column. |
| **Bridge Chart**| ![Bridge Chart](image11), ![Stacked Bridge Chart](image12), ![Stacked Total Bridge Chart](image13), ![Horiz-Bridge Chart](image14) | - Start with a **Worksheet**.  
- Select one or more Y columns (or a range of one or more Y columns). If there is an X column to the left of the Y column(s), this X column is treated as **categorical data**; otherwise, the worksheet’s row indices will be used.  
- Origin Bridge Charts are variants of one basic chart type. For more information, see **Bridge Charts**. |
<table>
<thead>
<tr>
<th>Plot Menu Group</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile</td>
<td><img src="image1" alt="Contour Profiles" /> <img src="image2" alt="Image Profiles" /></td>
<td>• Start with a <strong>Worksheet</strong>, <strong>Virtual Matrix</strong> or <strong>Matrix</strong> (Image Profiles, Matrix only).&lt;br&gt;• For specific data requirements, follow links in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td>Smith Chart</td>
<td><img src="image3" alt="Smith Chart" /></td>
<td>• Start with a <strong>Worksheet</strong>.&lt;br&gt;• Select at least one Y column of values (or a range from at least one column). If there is an associated X column, X column supplies X values; otherwise, Y <strong>sampling interval</strong> or row number is used.&lt;br&gt;• For more information, follow the link in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td>Wind Rose</td>
<td><img src="image4" alt="Wind Rose - Binned Data" /> <img src="image5" alt="Wind Rose - Raw Data" /></td>
<td>• Start with a <strong>Worksheet</strong>.&lt;br&gt;• Select one or more Y columns or a range from one or more Y columns. If there is an associated X column, X column supplies X values; otherwise, Y <strong>sampling interval</strong> or row number is used.&lt;br&gt;• For specific data requirements, follow links in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td>Plot Menu Group</td>
<td>Graph Types</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
<td>-------</td>
</tr>
</tbody>
</table>
- Select at least one Y column (or a range from at least one Y column). The X column displays as the title of the radial axis around the chart. If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.  
- Radar Charts and Spider Charts are created from the same basic Origin plot type.  
- For more information, see Spider Charts. |
| Group Plot     | Grouped Columns - Indexed Data, Grouped Box Charts - Indexed Data, Grouped Box Charts - Raw Data | - Start with a Worksheet.  
- Select at least one Y column (or a range from at least one Y column), plus a second column with grouping information. If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.  
- For more information, follow the link in the Graph Types column. |
## 11.5.2 3D Graphs

Beginning with Origin 2018b, you can modify the size of the Plot menu icons using the LabTalk system variable `@PPS`. To find out how to change the value of a system variable, see [Customizing Origin Using System Variables](#).

<table>
<thead>
<tr>
<th>Plot Menu Group</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Line + Symbol</strong></td>
<td><img src="image1" alt="3D Scatter" /> 3D Scatter  <img src="image2" alt="3D Scatter + Error Bar" /> 3D Scatter + Error Bar  <img src="image3" alt="3D Line" /> 3D Line  <img src="image4" alt="3D Trajectory" /> 3D Trajectory</td>
<td>• Data requirements vary by plot type. See links in the Graph Types column.</td>
</tr>
</tbody>
</table>

<p>| <strong>Function</strong> | <img src="image5" alt="New 3D Plot" /> New 3D Plot  <img src="image6" alt="New 3D Parametric Plot" /> New 3D Parametric Plot | • Function plots are not created from physical data.  • When a 3D Function is plotted, a matrix of Z values is simultaneously generated.  • For more information on function plots, follow links in the Graph Types column. |</p>
<table>
<thead>
<tr>
<th>Plot Menu Group</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vector</td>
<td><img src="#" alt="3D Vector XYX XYZ" /></td>
<td>• Start with a <strong>Worksheet</strong>.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="3D Vector XYX dXdYdZ" /></td>
<td>• Select 6 worksheet columns, designated as XYZ XYZ.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For more information, see links in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td>Bar</td>
<td><img src="#" alt="3D Bar Graph" /></td>
<td>• Start with a <strong>Worksheet</strong> (XYZ) or a <strong>Virtual Matrix</strong> or <strong>Matrix</strong> of Z values.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="3D Stacked Bars Graph" /></td>
<td>• For specific data requirements, follow links in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="3D 100% Stacked Bar" /></td>
<td></td>
</tr>
<tr>
<td>Surface</td>
<td><img src="#" alt="Color Fill Surface" /></td>
<td>• Start with a <strong>Worksheet</strong> or <strong>Matrix</strong>.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="X Constant with Base Surface" /></td>
<td>• For specific data requirements, follow links in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Y Constant with Base Surface" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Color Map Surface" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Color Map Surface with Projection" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Wire Frame" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Wire Surface" /></td>
<td></td>
</tr>
<tr>
<td>Plot Menu Group</td>
<td>Graph Types</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| Ternary        | ![3D Ternary Colormap](image) | • Start with a **Worksheet**.  
• Select two Z columns (XYZZ) or a range of data from two Z columns (Z columns may be multiples of 2).  
• For more information, follow links in the **Graph Types** column. |
|                | ![3D Ternary Symbol](image)     |       |
| Waterfall      | ![Waterfall](image)            | • Start with a **Worksheet**.  
• Select at least one Y column (or a range from at least one Y column). Ideally, select at least two Y columns (or a range of at least two Y columns). If there is an associated X column, X column supplies X values; otherwise, Y **sampling interval** or row number is used.  
• For more information, see the links in the **Graph Types** column. |
|                | ![Waterfall: Y Color Mapping](image) |       |
|                | ![Waterfall: Z Color Mapping](image) |       |
|                | ![3D Waterfall](image) |       |
|                | ![3D Waterfall: Y Color Mapping](image) |       |
|                | ![3D Waterfall: Z Color Mapping](image) |       |
| Multi-Y        | ![XYY 3D Bars](image)          | • Start with a **Worksheet**.  
• Select at least one Y column (or a range from at least one Y column). Ideally, select at least two Y columns (or a range of at least two Y columns). If there is an associated X column, X column supplies X values; otherwise, Y **sampling interval** or row number is used.  
• For more information, see the links in the **Graph Types** column. |
<p>|                | <img src="image" alt="XYY 3D Stacked Bars" />  |       |
|                | <img src="image" alt="XYY 3D 100% Stacked Bars" /> |       |</p>
<table>
<thead>
<tr>
<th>Plot Menu Group</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **3D Ribbons** | ![3D Ribbons](image) | - Start with a **Worksheet**.  
- Select at least one Y column (or a range from at least one Y column). Ideally, select at least two Y columns (or a range of at least two Y columns). If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.  
- For more information, see the link in the **Graph Types** column. |
| **Walls** | ![3D Wall Graph](image), ![3D Stacked Wall Graph](image), ![3D 100% Stacked Wall Graph](image) | - Start with a **Worksheet**.  
- Select at least one Y column (or a range from at least one Y column). Ideally, select at least two Y columns (or a range of at least two Y columns). If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.  
- For more information, see the link in the **Graph Types** column. |

*For an overview of Origin’s 3D graph types and their source data requirements, see these topics:*

- Creating 3D Graphs
- 3D and Contour Graphing
- Creating Contour Graphs
- Creating 3D and Contour Graphs from Virtual Matrix
11.6 Topics for Further Reading

- The Page-Layer-Plot Hierarchy
- Page Viewing Modes
- Graph Axes
- Creating Graphs from Graph Templates
- Creating Multi Layered Graphs
- Adding Data Plots to the Graph Layer
- The Layer Contents Dialog Box
- The Object Manager
- Graph Layers
- Linking Layers
- 3D and Contour Graphing
- Plotting Mathematical Functions
- Appendix 2 - Complete Listing of Origin Graph Types
12 Customizing Graphs

12.1 Introduction

This chapter introduces you to various aspects of graph customization. All Origin graphs start from a graph template. If the graph you are making is fairly standard for its type, the options that were stored in the graph template may be entirely adequate to produce a polished-looking graph. The business of basic graph creation was covered in the last chapter, Graphing.
Sooner or later, however, you are going to want to add annotations, modify axis scales, or change plot colors. Hence, the purpose of this chapter is to introduce you to some key Origin graph customization tools and techniques, as well as to point you toward resources that will help you manage more complex graph customization tasks.

We begin with a discussion of the graph customization-related toolbars, as these toolbars have tools that are commonly used for quick modifications of graph elements.

### 12.2 Toolbars

Toolbar buttons useful for graph-customization tasks:

<table>
<thead>
<tr>
<th>Description</th>
<th>Toolbar (default configuration)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format toolbar buttons:</strong></td>
<td><img src="image" alt="Format Toolbar" /></td>
</tr>
<tr>
<td>• Creating and customizing text objects.</td>
<td></td>
</tr>
<tr>
<td><strong>Style toolbar buttons:</strong></td>
<td><img src="image" alt="Style Toolbar" /></td>
</tr>
<tr>
<td>• Editing colors, line thickness, fill patterns.</td>
<td></td>
</tr>
<tr>
<td><strong>Tools toolbar buttons:</strong></td>
<td><img src="image" alt="Tools Toolbar" /></td>
</tr>
<tr>
<td>• Add text objects, lines, arrows, rectangles/circles/polygons.</td>
<td></td>
</tr>
</tbody>
</table>
## Customizing Graphs

<table>
<thead>
<tr>
<th>Description</th>
<th>Toolbar (default configuration)</th>
</tr>
</thead>
</table>
| **Graph toolbar buttons:** | ![Graph Toolbar](image)
| • Add graph layers incl. inset graphs, merging or extracting graphs; exchanging axes; anti-aliasing and Speed Mode. | |
| **Add Object to Graph toolbar buttons:** | ![Add Object to Graph Toolbar](image)
| • Add legends/color scales/bubble scales; date & time and project path stamps; XY scale; table objects. | |
| **Object Edit toolbar buttons:** | ![Object Edit Toolbar](image)
| • Arranging and aligning objects and layers on the page. |
## 12.3 Menus and Dialog Boxes

Many graph customizations are initiated via commands on the the **Graph** menu. Options for customization are explained in the sections below.

The following table lists key dialog boxes used for customizing graphs:

<table>
<thead>
<tr>
<th>Task</th>
<th>Dialog Name</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customize the graph Page, Layer, or Data Plot</td>
<td>• <strong>Plot Details</strong> dialog</td>
<td>• Double-click on Page, Layer or Data Plot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Format: Page Properties...</strong> menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Format: Layer Properties...</strong> menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Format: Plot Properties...</strong> menu</td>
</tr>
<tr>
<td>Customize Axes</td>
<td>• <strong>Axis Dialog</strong></td>
<td>• Double-click on axes or tick labels</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Format: Axes...</strong> menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Format: Axis Tick Labels...</strong> menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Format: Axis Titles...</strong> menu</td>
</tr>
<tr>
<td>Add or Customize Legend</td>
<td>• (Text Object -) <strong>Legend</strong> dialog</td>
<td>• Double-click on the legend object text</td>
</tr>
<tr>
<td></td>
<td>• Update Legend dialog</td>
<td>• Right-click legend and choose <strong>Legend: Update Legend</strong> or choose <strong>Graph: Legend: Update Legend</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Legends/Titles</strong> tab at Page level of Plot Details dialog</td>
<td>• Double-click on the legend plot symbol</td>
</tr>
<tr>
<td>Merge multiple graph windows into one graph window</td>
<td>• <strong>Merge Graphs</strong> dialog</td>
<td>• <strong>Graph: Merge Graph Windows...</strong> menu</td>
</tr>
<tr>
<td>Layer level customizations: resize, move, swap, align, or add layers</td>
<td>• <strong>Layer Management</strong> dialog</td>
<td>• <strong>Graph: Layer Management...</strong> menu</td>
</tr>
</tbody>
</table>
### Customizing Graphs

<table>
<thead>
<tr>
<th>Task</th>
<th>Dialog Name</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save settings as graph template</td>
<td><strong>Save Template As</strong> dialog</td>
<td>• File: <strong>Save Template As</strong>... menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Right-click graph window title and choose <strong>Save Template As</strong>...</td>
</tr>
<tr>
<td>Manage graph templates, add plots to a template</td>
<td><strong>Template Library</strong> (custom graph templates)</td>
<td>• Plot &gt; Templates: <strong>Template Library</strong> menu</td>
</tr>
<tr>
<td></td>
<td><strong>System Templates</strong> (built-in graph templates)</td>
<td>• Plot &gt; Templates: <strong>System Template Library</strong> menu</td>
</tr>
<tr>
<td>Save settings as graph Theme</td>
<td><strong>Save Format as Theme</strong> dialog</td>
<td>• Right-click and choose <strong>Save Format as Theme</strong>... context menu</td>
</tr>
<tr>
<td>Manage Graph Themes: edit, combine, apply Theme, set as System Theme</td>
<td><strong>Theme Organizer</strong> dialog</td>
<td>• Tools: <strong>Theme Organizer</strong>.. &gt; Graph tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• F7 hotkey.</td>
</tr>
</tbody>
</table>

### 12.4 Customizing Page, Layer and Data Plots

A graph window is a collection of objects, organized in a hierarchical structure. As we shall see, there are editable properties at the page, layer and data plot levels.

Quick formatting of some graph properties can be done using toolbar buttons, as mentioned above. However, the vast majority of properties are customized via Origin’s **Plot Details** dialog box. To open Plot Details, (1) double-click on your plot or (2) click the **Format** menu, then choose **Page Properties**, **Layer Properties** or **Plot Properties**.

The figure below shows an example of the **Plot Details** dialog box:

- The left panel depicts the **Page** > **Layer** > **Plot** hierarchy as an expandable/collapsible tree.
- The right panel contains controls, organized by tabs, that pertain to the object that is currently selected in the left panel.
- To customize an object, select it in the left panel and modify the corresponding properties that appear on the various tabs in the right panel.
<table>
<thead>
<tr>
<th><strong>Selected Left Panel Object</strong></th>
<th><strong>Right Panel, Controls for...</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>Print/Dimensions, layer drawing orders, page display color, legends/titles.</td>
</tr>
<tr>
<td>Layer</td>
<td>Layer background colors, layer size and speed mode settings, layer display settings, stack settings for applicable plot types. Some plot types will include extra tabs/controls specific to the plot type.</td>
</tr>
<tr>
<td>Data Plot</td>
<td>Plot specific properties. The tabs and controls are pertinent to the plot type.</td>
</tr>
<tr>
<td>Data Point</td>
<td>Point specific properties. Available for some plot types. The tabs and controls are generally similar to those available at the Data Plot level.</td>
</tr>
</tbody>
</table>
You can UNDO customizations made in the Plot Details dialog box. Click OK to close Plot Details and choose Edit: Undo Modify Page or press CTRL + Z.

Prevent text and label objects from scaling when resizing layer, by going to the Display tab of Plot Details (at the Layer level) and setting Fixed Factor to 1.
Origin 2018b adds a **Layer** tab at the **Page** Level in Plot Details. Use controls on this tab to customize a graph layer and contained plots, then apply those customizations to other layers and plots in the page. This is particularly useful for modifying the appearance of stack or panel graphs. Previously, for instance, if you wanted to customize a 9-panel graph you had to customize each panel individually. Now, you can apply multiple customizations to all plots, simultaneously. For more information, see [The (Plot Details) Layer Tab](#).

### 12.4.1 Customizing Grouped Plots

When you select and plot multiple data ranges to a single graph layer, the plots are **grouped** in the layer. By default, plots within a group are automatically differentiated by cycling through customizable increment lists, one for each plot property (symbol shape, symbol color, line style, etc.). These increment lists are saved with the graph template (.oggu) or Theme file (.oth) so that you can easily recreate graphs with the same look.

The above image shows the Plot Details **Group** tab settings for a line + symbol plot in the upper-left. The first column lists **Line Color**, **Symbol Type**, **Line Style**, **Symbol Edge Color**, and **Symbol Interior**. **Line Color**, **Symbol Type**, and **Symbol Edge Color** are set to increment **By One Between Subgroups** (grouping occurs using the column **Long Name**), while **Line Style** and **Symbol Interior** are set to increment by **None** (they do not vary).
This arrangement is completely customizable and you can save customizations with the graph template:

- To find out more about customizing of grouped and subgrouped plots, see The Plot Details Group Tab Controls.
- To find out more about saving graphs as templates, see Graph Template Basics.

Starting with Origin 2018b, you can use the Object Manager to group or ungroup data plots in the layer. If plots are grouped, ungroup by right-clicking on the group icon ("gN") and choosing Ungroup. To group plots in the layer, right-click on a plot and choose Set as Group Begin.

12.4.2 Customizing Individual Data Points

For some plot types such as scatter and column, you can modify the display properties of a single data point. This is another plot customization that happens via the Plot Details dialog box.

To edit a single point:

1. Press the CTRL key and double-click on the data point in the graph. This opens the Plot Details dialog box with the focus set to edit this data point. The data point will be identified in the left-panel of Plot Details by its row index number. Use the controls on the tabs in the right panel to modify the appearance of the data point. Changes you make to the appearance of this point will not affect the appearance of other points in the same plot.
Alternately, when the Custom Construction box is checked, you can use these controls to customize the symbol.

To remove customizations made to a single data point:

- Right-click the single point in the left panel of the Plot Details dialog and choose Delete.
- In the graph window, click on the single point to select it, then press DELETE on the keyboard.

The point properties revert to those of the containing dataset.

### 12.5 Customizing Graph Axes

Most graph axis customizations are made via the Axis Dialog box. Double-click on the graph axis or tick labels to open the Axis Dialog - Layer N dialog box.

This image shows the tab-based axis dialog used by most 2D and 3D graphs.
In earlier versions of Origin, you had to customize each layer’s axes from separate Axis dialogs. Starting with Origin 2017, you can switch layers inside the **Axis** dialog using the **Layer** drop-down at the bottom of the dialog box.

In the left panel, you can select one or more icons (hold the **CTRL** key to select multiple icons) to specify the axis or axes to be customized, then select the desired tab and choose your options.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Controls for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale</td>
<td>Scale range of values, scale type, rescale mode and margin, reverse scale, major and minor ticks.</td>
</tr>
<tr>
<td>Tick Labels</td>
<td>Display and format options for major and minor tick labels, including custom labeling by formula.</td>
</tr>
<tr>
<td>Title</td>
<td>Axis title (often set using variable notation) and font options. Note that you can directly edit by double-clicking the text object in the graph.</td>
</tr>
<tr>
<td>Grids</td>
<td>Control display and properties of grid lines at major and minor ticks.</td>
</tr>
<tr>
<td>Line and Ticks</td>
<td>Global axis line and tick display options for all axes.</td>
</tr>
<tr>
<td>Tab</td>
<td>Controls for</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Special Ticks</td>
<td>Placement of special tick labels.</td>
</tr>
<tr>
<td>Reference Lines</td>
<td>Placement of reference lines and “recession bars” (shaded areas with transparency, that can be added on top of the data plot).</td>
</tr>
<tr>
<td>Breaks</td>
<td>Enable line breaks and configure each break.</td>
</tr>
</tbody>
</table>

Click the **Apply To...** button to apply the axis format settings of the currently selected axis to another axis.

**Note:** For more information on axis customization and for axis controls for specialized graph types (e.g. polar, ternary, radar chart etc), refer to: **Help: Origin: Origin Help > Graphing > Graph Axes**

### 12.6 Graph Legends

#### 12.6.1 How the Default Legend is Created

A graph legend is automatically created when you plot data. For 2D and some 3D graph templates, Origin creates a default legend that combines (A) **plot style information** stored with the graph template, with (B) **dataset information stored in the worksheet column label rows**, and places the resulting legend object on the graph page.

![Graph Legend Example](image)

The default legend object is created using LabTalk script. The reason for this is:

- The legend object is able to incorporate identifying information such as data that has been entered into the worksheet column headings (entered manually or automatically added on file import).
• The legend object is dynamically linked to the plotted data so that the legend can be updated when data are added or removed from the graph. The substitution notation becomes visible when you double-click inside of the legend object (as if to edit it).

The notation used for legend texts is controlled by the Translation mode of %1, %2 list in the Legends/Titles tab of the Plot Details dialog box (Format: Page Properties...). Custom formatting of the notation(s) is supported.

12.6.2 Graph Editing Tips

• If you do not want a legend automatically added to your graph each time you create the graph, delete the legend object and save the graph template.
• Right-click the legend object for some useful controls such as Reverse Order, Show Legend for Visible Plots Only, and Hide Legend for Fitted Curves.
• Select the legend object; then press CTRL while dragging a selection handle to change the layout of the legend (e.g. drag horizontally to create a legend that is all on one line).
• Ctrl + double-click on the legend text to enter in-place edit mode (for overwriting legend text).
• Double-click the legend text to open the Legend dialog box.
• Double-click a legend symbol to open the Plot Details dialog box with corresponding plot selected.

12.7 Customizing Legends

There are a number of reasons for modifying the default graph legend. We suggest that you look at this topic to see what sort of customizations are supported.

For the standard data plot legend used with most 2D plots (line, line+symbol, bar/column, pie, etc.), customizations are done using the (Text Object) Legend dialog box. To open the Legend dialog box, double-click on the legend text. This dialog gives the best access for line-by-line customization of the data plot legend. Note that there is a separate dialog box for customization of color scales.

• Double-click on the legend text or right-click and choose Properties..... The Legend dialog includes controls for customizing legend text and symbols, legend object frame and background, and associating LabTalk scripts with the legend object.
• Double-click on the legend symbol or right-click on the graph legend and choose Plot Details. Modify the size, color, line width and data plot symbols associated with each plot.
• Click on the legend border (if shown) to view border line controls for adjusting padding between the legend entry (symbol + text) and the legend border.
## 12.7.1 Adding and Updating the Default Legend

The table below lists tasks associated with adding, updating and reconstructing the default legend, and where to find controls for each. Before proceeding, you should know the difference between updating a legend and reconstructing a legend:

- **Updating** will preserve any previous customizations, including size and position adjustments and legend symbol and text customizations.
- **Reconstructing** will overwrite previous customizations, defaulting to legend settings stored in the graph template.
- The graph template stores a Legend Update Mode setting that determines how the legend is refreshed when adding or removing data plots from the graph. For more information, see Legend Update Mode.

<table>
<thead>
<tr>
<th>Task</th>
<th>Method (graph is active)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or reconstruct legend</td>
<td>• <strong>Graph: Legend: Reconstruct Legend</strong> menu.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reconstruct Legend</strong> button (Add Object to Graph toolbar).</td>
</tr>
<tr>
<td></td>
<td>• CTRL+L.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Customizations made to an existing legend will be lost when you use these commands.</td>
</tr>
<tr>
<td>Update legend</td>
<td>Open the <em>legendupdate</em> dialog box:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Graph: Legend: Update Legend</strong> menu.</td>
</tr>
<tr>
<td></td>
<td>• Right-click on legend and select <strong>Legend: Update Legend</strong>.</td>
</tr>
<tr>
<td>Advanced legend customizations</td>
<td>Right-clicking the legend object provides several advanced options to customize the graph legend. Applies primarily to:</td>
</tr>
<tr>
<td></td>
<td>• Categorical data plots.</td>
</tr>
<tr>
<td></td>
<td>• Box charts.</td>
</tr>
<tr>
<td></td>
<td>• Legends constructed point-by-point.</td>
</tr>
<tr>
<td>Task</td>
<td>Method (graph is active)</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add color scale</td>
<td>Only available for color-mapped plots (e.g., Contour Plots).</td>
</tr>
<tr>
<td></td>
<td>- Click the <strong>Add Color Scale</strong> button (Add Object to Graph toolbar).</td>
</tr>
<tr>
<td></td>
<td>- Right-click in the layer and select <strong>New Color Scale</strong>.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Graph: New Color Scale</strong> menu.</td>
</tr>
<tr>
<td></td>
<td>- For multiple color-mapped plots with different color scale in one graph, click on each plot to select it and add corresponding color scale.</td>
</tr>
<tr>
<td>Control color scale</td>
<td>Available when a color scale object is added to a graph. To open the <strong>Color Scale Control</strong> dialog:</td>
</tr>
<tr>
<td></td>
<td>- Double click on the color scale object.</td>
</tr>
<tr>
<td></td>
<td>- Right-click on the color scale object and choose <strong>Properties</strong>.</td>
</tr>
<tr>
<td>Add bubble scale</td>
<td>Available for bubble plot, or when symbol size is controlled by a dataset.</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>Graph: New Bubble Scale</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Right-click in the layer and select <strong>New Bubble Scale</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Click the <strong>Add Bubble Scale</strong> button in the Add Object to Graph toolbar.</td>
</tr>
<tr>
<td></td>
<td>- Right-click the legend to select <strong>Add Bubble Scale</strong> from the context menu.</td>
</tr>
<tr>
<td>Control bubble scale</td>
<td>Available when bubble scale object is added to a graph. To open the <strong>Bubble Scale Control</strong> dialog:</td>
</tr>
<tr>
<td></td>
<td>- Double click on the bubble scale object.</td>
</tr>
<tr>
<td></td>
<td>- Right-click on the bubble scale object and choose <strong>Properties</strong>.</td>
</tr>
</tbody>
</table>
Origin 2018 added an interface tool to manually Add Legend Symbols to the graph legend. Right-click on the legend object and choose Properties. Click the Add Legend Symbol button in the lower-right corner of the dialog box.

Note: For more information on creating and customizing graph legends, see:
Help: Origin: Origin Help > Graphing > Graph Legends and Color Scales

### 12.7.2 Controlling Legend Update

When a data plot is added or removed from a graph layer, the default behavior is to update the legend. The Legend/Titles tab at the graph page level in the Plot Details provides a Legend Update Mode drop-down to control this behavior.

The default setting **Update when Adding** only affects the legend display of data plots that are added or removed. Previous legend customizations to existing plots, such as literal text entered manually, will be maintained.

#### Tutorial: Customize legend and add data plots

1. Start with a new project in Origin.
2. Open Windows Explorer and navigate to the subfolder `<Origin EXE folder>\Samples\Import and Export`.
3. Shift-select the files `S15-125-03.dat`, `S21-235-07.dat`, `S32-014-04.dat` and then drag-and-drop the files onto an empty Origin workbook. The three files will be imported into three separate workbooks.
4. Click on one of the workbooks, select the column B, and create a line plot.
5. Right-click on the legend and select **Legend: Update Legend...** to open the legendupdate dialog.
6. Change the Auto Legend Translation Mode drop-down to **Custom**, and in the edit box that appears below, enter the string: `@WS, @LD3`
   and then press OK to close the dialog box. The legend updates, displaying the sheet name and the third user parameter.
7. Click on the second workbook, select column B, move the mouse over the right-edge of the column until it changes to , and then drag-and-drop this data onto the graph to create a 2nd data plot.
8. Repeat the procedure with column B from the third workbook. The graph will now
display three data plots, and the legend will automatically update to display the identifier for all three plots.

9. Click on each individual curve and use the **Style** toolbar to set a different line color for each. The legend will automatically update and display the new line color.

![Graph Example](image)

### 12.7.3 Special Legend Types

Origin also has several special legends used with certain graph types. These legends can be customized and updated similarly to the default legend object.

<table>
<thead>
<tr>
<th>Legend Type</th>
<th>Menu Access</th>
<th>Used When..</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend for Categorical Values</td>
<td>Graph:Legend:Categorical Values</td>
<td>At least one plot attribute (e.g. color, symbol shape, etc) is controlled by data indexing. See the <a href="#">Legend for Categorical Values</a> help page.</td>
</tr>
<tr>
<td>Point by Point Legend</td>
<td>Graph:Legend:Point by Point</td>
<td>The symbol style is controlled by data indexing, or increment list, or color mapping. See the <a href="#">Point by Point Legend</a> help page.</td>
</tr>
<tr>
<td>Legend for Box Chart Components</td>
<td>Graph:Legend:Box Chart Components</td>
<td>The graph is a box chart, or a grouped box chart. See the <a href="#">Legend for Box Chart Components</a> help page.</td>
</tr>
</tbody>
</table>
12.8 Annotating Your Graph

Origin 2018 added Unicode (UTF-8) support.

Annotating a graph can be as simple as adding a static text object and formatting it with Format toolbar tools. Or you might add a more complex object that is linked to some LabTalk script that is executed whenever some user-specified event occurs (e.g. object is moved, window is activated, graph axes are rescaled, etc.).

<table>
<thead>
<tr>
<th>Task</th>
<th>Method</th>
</tr>
</thead>
</table>
| Label Data Points     | • Choose **Format: Plot Properties**, then click the **Label** tab and select **Enable** (not available for all plot types).  
                        | • To annotate individual points, see "Annotate a Data Point", below.                                                                    |
| Add Text Objects      | • Click the **Text Tool** button, then click on graph to place object.                                                                    
                        | • Right click on the graph and choose **Add Text** from the shortcut menu.                                                                
<pre><code>                    | • Double click on text to do rich text editing.                                                                                         |
</code></pre>
<p>| Add Layer Title       | • Right-click on graph and choose <strong>Add/Modify Layer Title</strong> from the shortcut menu to add/modify layer title in active layer.           |
| Add Vertical/Horizontal Line | • With 2D graph active, use the <strong>Graph: Add Straight Line...</strong> menu item.                                                               |
| Annotate a Data Point | • Click the <strong>Annotation</strong> tool on the <strong>Tools</strong> toolbar. See <strong>The Annotation Tool</strong>.                                                  |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Drawing Objects</td>
<td>Use the corresponding toolbar buttons on <strong>Tools</strong> toolbar. Origin supports:</td>
</tr>
<tr>
<td></td>
<td>• Arrow, Curved Arrow.</td>
</tr>
<tr>
<td></td>
<td>• Line, Polyline, Freehand Draw.</td>
</tr>
<tr>
<td></td>
<td>• Rectangle, Circle, Polygon, Region.</td>
</tr>
<tr>
<td>Insert Equation, Word Object, Excel Object, Other OLE Object</td>
<td>• Insert Equation group on the <strong>Tools</strong> toolbar.</td>
</tr>
<tr>
<td>Insert Image</td>
<td>• Right click on the graph and choose <strong>Insert Images From Files</strong>.</td>
</tr>
<tr>
<td>Add Table</td>
<td>• Click the <strong>New Link Table</strong> button on the <strong>Add Object to Graph</strong> toolbar and then click on the graph.</td>
</tr>
<tr>
<td></td>
<td>• Right click on the graph and choose <strong>New Table</strong> from the context menu.</td>
</tr>
<tr>
<td></td>
<td>• Double click the table object to edit and customize the table.</td>
</tr>
<tr>
<td>Insert Date &amp; Time Stamp</td>
<td>• <strong>Date &amp; Time</strong> button on the <strong>Add Object to Graph</strong> toolbar.</td>
</tr>
<tr>
<td>Insert Project Path</td>
<td>• <strong>Project Path</strong> button on the <strong>Add Object to Graph</strong> toolbar.</td>
</tr>
<tr>
<td>Add Bracket with Asterisk</td>
<td>• To indicate statistical groupings, click the <strong>Add Asterisk Bracket</strong> button on the <strong>Add Object to Graph</strong> toolbar.</td>
</tr>
<tr>
<td></td>
<td>Manually adjust the size and placement of brackets by dragging handles on the object.</td>
</tr>
</tbody>
</table>
### Task Method

**Add XY Scale**

This is useful when using a nonlinear xy scale.

- **New XY Scale** button and click on a graph layer.
- Right click on a graph layer and choose **New XY Scale** from the shortcut menu.

### 12.8.1 Tips for Editing Your Graph Annotations

- Pressing CTRL when drawing with the **Rectangle** or **Circle** tools, will draw a square or circle (as opposed to a rectangle or ellipse).
- Right-click an object and choose **Properties...** to edit the properties of the text or drawing object and set the default.
- Use the **Format** and **Style** toolbar buttons to quickly modify some plot elements including plot colors and axis title font face or size.
- For text objects, including the axis titles, you can edit text objects directly in "In-place Edit" mode. Double-click on a text object to edit. Use the **Format** toolbar buttons to add superscript, subscript, and Greek characters.
- Do NOT set font size while in "In-place Edit Mode" unless you need to mix font sizes. The correct way to change font size is to click the text object once so that the green selection handles appear, then select font size from the **Format** toolbar. If you set while in In-place Edit mode, Origin will not indicate the proper font size when you hover on the text object.
- When you are in In-place Edit mode, you can right-click and choose **Symbol Map** to insert special characters into your text object.
- You can insert the contents of a worksheet cell into a text object by copying and pasting the cell contents. While in In-place Edit mode in the text object, right-click and choose **Paste** or **Paste Link** from the shortcut menu. Pasted data is static; Paste Linked data is dynamic and will change if the linked cell data changes.
- Also, when in In-place Edit mode, you can right click and choose **Insert Info. Variable...** to insert information related to plotted data, into the text object. Since the pasted information is linked to a LabTalk variable value, the inserted data updates if the variable value changes.
- You can insert variable values into a text object using the LabTalk `%`, and `$` substitution notation by setting the **Link to (%)$, Substitution Level** to 1 in the text object’s **Properties** dialog box, **Programming** tab. Right-click on the text object and choose **Properties** from the shortcut menu.
- You can use controls on the Programming tab to associate LabTalk script with a text or drawing object (for instance, see [Linking Text Labels to Data and Variables]). Enter your script in the text box and specify a **Script, Run After** condition for running the script. Use the **Apply to** drop-down to set the scope for the script.
• You can copy a range (of cells) from a workbook and paste it into a graph as a **table object**. The table object is editable.

### 12.8.2 Object Attachment and Scaling

When you add a text or drawing object to an Origin graph window, the object becomes part of the active graph layer. This is important because if you resize or delete that graph layer, you could resize or delete the object.

To view or change a text or drawing object’s attachment method:

1. Right-click on a text or drawing object and choose **Properties**....

2. Click on the Programming tab and note the object's **Attach to** setting.

Though objects remain a part of the layer that was active at the time of their creation, you can manage some object behaviors by changing the object attachment method. An object is attached in one of three ways:

- **Page**. When attached to the page, objects are not affected by moving or resizing the graph layer, nor are they affected by a change in axis scales. These objects are still associated with a particular graph layer and they will be hidden or deleted if the layer is hidden or deleted.

- **Layer Frame**. Objects that are attached to the layer frame, resize and move with the layer frame, but are not tied to axis scales and, thus, are unaffected by changes in the layer's axis scale values. Objects are hidden or deleted if the associated layer is hidden or deleted.

- **Layer and Scales**. Objects are linked to a particular range of axis scale values. If you resize the layer, the object is resized accordingly. If you rescale the axes, the object moves in relation to the visible scale and will disappear from view if the linked axis scale range is not displayed. These objects are hidden or deleted if the associated layer is hidden or deleted.

**Note:** Each object has a default object attachment method that determines how an object behaves when graph layers are resized. For more information on object attachment methods, see [Default Object Attachment Methods](#).
### 12.8.3 Grouping, Aligning and Arranging with the Object Edit Toolbar

You can group text labels and drawn objects so that they move or resize as a unit:

1. To select objects, press SHIFT + click; or drag out a box around objects using the Pointer tool.
2. To group the selected objects, click the Group button on the Object Edit toolbar.
3. To ungroup objects, click the Ungroup button on the Object Edit toolbar.

You can align text labels and drawn objects using the tools on the Object Edit toolbar:

1. Select objects to be aligned by holding the SHIFT key while selecting (or drag out a selection box using the Pointer tool), then click one of the align objects buttons on the toolbar. Note that objects will be aligned with respect to the first-selected object.

You can bring overlapping objects to the front or send them to the back:

1. Select the objects that you want to move to the front or the back.
2. Click the Front button or the Back button on the Object Edit toolbar.

---

**Note:** For more information on graph annotations, see your Origin User Guide:

Help: Origin: Origin Help > Graphing > Adding Text and Drawing Objects

You can also use **Object Edit Toolbar** manipulate graph layers. Selected graph layers respond just like text or drawing objects. Use it to align and set a uniform size for multiple graph layers or to swap layer order.
## 12.9 Arranging Graphs and Layers

<table>
<thead>
<tr>
<th>Task</th>
<th>Method</th>
</tr>
</thead>
</table>
| Merge multiple graph windows into a single graph window. | • **Graph: Merge Graph Windows...** menu command  

or  

• **Merge Graph Windows** button on the **Graph** toolbar. |

Origin 2018b has a new **Fitting Layers to Page** dialog box that complements the Fit Page to Layers dialog. **These dialogs** are handy for arranging multi-panel graphs and trimming white space. |

| Extract data plots in one layer to multiple layers. | • **Extract to Layers** button on the **Graph** toolbar. **Hint:** to preserve your original graph, click the **Duplicate** button before extracting to layers. |

| Extract multiple layers in a single graph to multiple graph windows | • **Graph: Extract to Graphs**  

or  

• Click the **Extract to Graphs** button on the **Graph** toolbar.  

All layers are extracted to individual graph windows, even if a layer is linked to another layer.  

By default, **Extracted Layers** is set to **1:0**, which specifies that all layers be extracted. To act only on certain layers, clear **Auto** and use the **layextract** X-Function's comma/colon notation to point to specific layers. The notation **1:0** means starting with layer 1, extract all layers to graphs (**0** denotes all). Specifying **1,3:4**, for example, tells Origin to extract only the first, third and the fourth layer. |

| Add, arrange, resize, position, swap, align, or link layers | **Graph: Layer Management...** menu.  

**Hint:** to physically swap inplane positions for layers (don’t reassign layer number), use the Layer Management tool’s **Swap** control (**Graph: Layer Management, Size/Position** tab). |
<table>
<thead>
<tr>
<th>Task</th>
<th>Method</th>
</tr>
</thead>
</table>
| Link graph layers | • **Linked Axes Scales** tab, layer level of **Plot Details** dialog box.  
|               | • **Link** tab of the **Layer Management** dialog box.                  |

When linking layers, the child layer must have a higher layer number than the parent layer.

Linked layers can be moved and resized together.

You can link layers’ axis scale values to be **Straight (1:1)** or you can specify a **Custom** mathematical relationship.
<table>
<thead>
<tr>
<th>Task</th>
<th>Method</th>
</tr>
</thead>
</table>
| Reorder layers      | There are several ways to reorder graph layers (reassign Layer number for each Layer). Learn more about reassigning layer numbers in the *mini tutorial* below this table.  
  
  - **Method 1**: Open the **Layer Management** dialog and click the row header (shown in image below) and drag it up or down to change the Layer order.  
  
  ![Layer Management](image)  
  
  For more information, see the [Layer Management tool](#).  
  
  - **Method 2**: Enter the following LabTalk script in the **Command Window** (*Window:Command Window*), then press **Enter** to execute.  
  
  ```labtalk
  page.reorder(n,m)
  ```  
  
  The command changes the *n*th Layer to the *m*th Layer.  
  
  - **Method 3**: Use the **Front** and **Back** buttons on the **Object Edit** toolbar (these buttons work on the *active* layer as indicated by the graph layer icon ![Layer Icon](image)). Alternately, you can right-click on the graph layer icon and change layer order using shortcut menu commands.  
  
  **Note**: Reordering layers may break layer linking relationships.  
  
| Exchange X-Y Axes   |  
|---------------------|------------------------------------------------------------------------|
|                     |  
|                     | **Graph: Exchange X-Y Axes** menu command  
|                     | **Exchange Axes** button on the **Graph** toolbar.  

### Task

Move a plot(s) to another layer

<table>
<thead>
<tr>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Method 1</strong>: Open <strong>Plot Setup</strong> dialog(by selecting <strong>Graph:Plot Setup</strong>), expand the bottom panel, select a plot and drag it from a layer to another layer.</td>
</tr>
<tr>
<td><strong>Method 2</strong>: Run <code>laymplot -d;</code> (e.g. open the Script Window, type the command and press &lt;Enter&gt;) to open the <strong>Move Plot</strong> dialog to specify plot(s) to move and a target layer.</td>
</tr>
</tbody>
</table>

You can move a plot by Copying (CTRL+C or Copy Range context menu) and Pasting (CTRL+V or Paste context menu) operations, between different layers or different graphs. Please note, the pasted plot won't be associated with the source data of copied plot, but exists as a loose dataset.

In a multi-layer graph, layer order determines drawing order. The 1st layer is plotted and then 2nd layer is plotted on top of it, and so on. The layer with higher number is drawn on top of the layer with lower number. This is important when plots in one layer overlay plots in another layer. When necessary, you can change layer order to change plot drawing order.

This mini tutorial shows you how layer reassignment works. Use the preview window to see how layer number reassignment affects your graph.

1. Click **Help: Origin Central** or press F11.
2. Click on the **Graph Sample** tab, set the **Samples in** drop-down list to **Area Plots** and double-click on this graph:

![Graph Sample](image)

3. Activate the graph **Area Plot With Horizontal Color Gradient**, then click the **Extract to Layers** button on the **Graph** toolbar. Set both number of rows and columns to 1, click OK, then, click OK again for the page spacing. The green layer is on the top of the yellow layer in the figure. The purpose of this last step...
Customizing Graphs

was simply to create a two layer graph in which the data in one layer partially hides the data in the other layer. What we will do now is to reorder the layers and set the yellow layer on the top, giving you a better view of the two plots.

4. Choose **Graph: Layer Management...** menu, then drag the row header "1" of the Layer1 in the **Layer Selection** downward under the Layer2 (indicated by a blue line), and click **OK**.

5. You can see the yellow layer is on the top now.
**Alternate Method:** Beginning with Origin 2017, you can use the **Front** or **Back** toolbar buttons (located in the **Object Edit** toolbar, or at the top of **Layer Selection** box in the **Layer Management** dialog) to bring a layer forward or push it backwards. Just as with the previous method by dragging row header in **Layer Management**, this method swaps layer numbers.

You can easily add an inset layer with data by clicking the **Add Inset Graph With Data** button on the **Graph** toolbar or **Graph: New Layer(Axes): Inset With Data (Linked Dimension)**.

You can copy a layer from one graph window to another graph window. Click to select the layer first (a frame shows around the layer). Then press **Ctrl+C** or right-click and choose **Copy**. Click on the target graph window, then right-click to **Paste**.

**Note:** For more information on merging graphs, see your Origin User Guide:

Help: Origin: Tutorials > Graphing > Layers > Adding and Arranging Layers

Help: Origin : Origin Help > Graphing > Reference > The Merge Graph Dialog Box
12.10 Templates and Themes

Origin’s flexible Page > Layer > Plot hierarchy, plus an extensive list of editable object properties makes it easy to customize and save your graph settings for repeat use. You can preserve your custom settings in a couple of ways -- either with templates or with Themes. These concepts are introduced below.

**Note:** For detailed information please refer to Origin Help file, see:

Help: Origin: Origin Help > Graphing > Creating Graphs from Graph Templates
Help: Origin: Origin Help > Customizing Your Graph > Graph Formats and Themes

12.10.1 Templates

Customizations to your graph can be saved to template files for repeat use. For example, you can customize a graph page to add multiple layers, set relationships between layers, modify data plot properties, and then save all of these attributes as a graph template (.otpu) file. You can further specify that the graph template be "cloneable" allowing you to link these graph customizations to dataset Long Name, Short Name or worksheet column index number and quickly re-create your graph with new data.

A few things to note:

- By default, new, blank 2D graphs are created from the ORIGIN.otpu template. Other graph windows use different templates, saved with a set of customizations pertinent to a specific template.
- Origin ships with over 100 built-in graph templates. These "system" templates are installed to the Origin software folder. These templates are customizable but you cannot overwrite the template files in your software folder (see next).
- You can customize and save a system template to the same file name, in your User Files Folder. If the system template was the default template associated with a menu command or toolbar button (e.g. ORIGIN.otpu and the New Graph toolbar button), the customized template becomes the new default template associated with the command or button.
- To view system or custom graph templates, click Plot (workbook or matrix should be active) and under Templates, choose User or System Templates.
- You can save a graph template anywhere and with any name that you like -- it does not need to be saved with the name of a system template. However, by saving your templates to your User Files Folder, they will be collected in one, easily-remembered place and from there, they can easily be transferred to your new User Files Folder when you upgrade your Origin software.
• For an overview of graph templates, see [Graph Template Basics].
• For information on the Template Library, see [The Graph Template Library].
• For information on “cloneable” templates, see [Cloneable Templates].

### 12.10.2 Themes and Copy/Paste Format

An Origin Theme is a file containing a set of object properties. There are four kinds of Theme files in Origin: **graph** Themes, **worksheet** Themes, **dialog** Themes and **function plot** Themes. Graph Themes are a collection of properties of different elements in a graph window (e.g. a Theme could be as simple as axis major and minor tick direction settings, a colormap for a plot, or a combination of page dimensions, layer background, axis scales, color palettes used in a plot, etc.).

Themes allow you to quickly change one or more object properties in an existing graph; or to apply a consistent set of properties for all graph windows. For example, you might apply a black-and-white Theme to one of your color graphs in order to prepare it for journal publication; or you could change the font in all of your graph windows to Times New Roman.

The properties that can be saved as a Theme differ depending upon the selected object. At a basic level, it works like this:

1. Right-click on an object in a graph window, e.g. a plot and choose **Copy Format**. Depending on what you click on, there may be sub-menu items under the **Copy Format** shortcut menu, which give you the option as to what exact format to copy.
   - To apply the copied formats to a single graph, right-click on your target graph and choose **Paste Format To**. Again, this shortcut menu might have some sub-items that limit what to paste. In this way, the formatting option(s) from your source graph should be applied to your target graph.
Customizing Graphs

- To apply the copied formats to multiple windows in the project, keep the source graph window active and select **Edit:Paste Format(Advanced)...** from the Origin menu. This opens the **Apply Formats** dialog box. Here you have the option of editing or selectively applying formats to one or more graph windows in the Origin Project.

2. You can do the above on-the-fly copy and paste format or you can choose the **Save Format As a Theme...** shortcut menu item instead of **Copy Format**, then use **Tools: Theme Organizer** to apply the Theme in the future.

12.10.2.1 **Theme Organizer**

Use the **Theme Organizer** (**Tools: Theme Organizer**) to organize and apply Themes to graphs. With this dialog box you can apply a graph Theme simultaneously to multiple graphs in the Origin project file.

To combine multiple Themes in the Theme Organizer dialog box:

1. Press the **CTRL** key while selecting multiple Themes, then right-click and choose **Combine** from the shortcut menu. The shortcut menu in the tool provides an option for editing a Theme, allowing the user to add/delete properties from an existing Theme.
• If you right-click on a graph Theme and save it as your System Theme in the Theme Organizer, then each time you plot a new graph, the System Theme will be applied regardless of the settings that were saved with the graph template.

• If you don’t want a System Theme to be applied automatically to the graph, choose File: Save Template As and make sure the Apply System Theme to Override check box is cleared.

• You can load a graph Theme in the Export Graph dialog and the Theme will be applied to the exported image file.

### 12.11 Topics for Further Reading

- [Customizing Graph Page Elements](#)
- [Customizing Graph Layer Elements](#)
- [Customizing Plot Elements](#)
- [The Tools: Options: Axis tab Settings](#)
- [The Tools: Options: Graph tab Settings](#)
- [Graph Axes](#)
- [Controlling the Graph Axis Display Range](#)
- [Adding Text and Drawing Objects](#)
- [Hiding Labels, Data and Layers](#)
- [Creating Graphs from Graph Templates](#)
- [System Themes](#)
13 Graphical Exploration of Data

Start with a data plot ...

Choose a Tools Toolbar tool

For quick interactive analyses and recalculation of results choose Gadgets

Click here for Gadget controls

Gadgets for:
- Peak Finding
- Integration
- Differentiation
- FFT
- Curve Fitting
- Statistics
- Curve Intersection and more ...

Origin includes a number of tools for graphically exploring your data, including tools for magnifying and zooming, reading XY coordinate values, and drawing and deleting data points.
With Origin 2016, OriginLab began releasing add-on tools called **Apps**. Many exploratory and analysis-related tools have been added to OriginLab’s **File Exchange** since that time. If you find you need some exploratory or analysis tool that is not a standard part of Origin, you might check to see if the tool exists as an App. If it does not, request it!

### 13.1 Zooming, Panning and Rescaling

This section discusses the use of toolbar tools, and keyboard and menu commands that change the view of your 2D graph. We have split these tools and commands into two groups:

- Page-level zoom and pan operations that do **not** change axis scales.
- Axis rescale operations which zoom and pan the graph by changing **axis From and To values**.

Page level zoom and panning treat the graph page as a whole. You can read the current zoom level in the **Zoom** dropdown list of the **Standard** toolbar. Page level zoom and pan will not affect the printout or export of the graph, while axis rescaling tools (such as and ) change axis scales and will affect the printout and export of the graph.

### 13.1.1 Page-level Zoom and Pan

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Menu</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom-Panning: Zoom and pan the graph page.</td>
<td><img src="image" alt="Thumb Down" /></td>
<td>A +/- keys (zoom) or arrow keys (pan)</td>
<td></td>
<td>Click the toolbar button; or with the <strong>Pointer</strong> tool active, place the cursor on the graph page and press &quot;A&quot;, then ...</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Use +/- keys or mouse wheel to zoom in or out.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Use the arrow keys to pan horizontally or vertically.</td>
</tr>
<tr>
<td>Action</td>
<td>Button</td>
<td>Shortcut Key</td>
<td>Menu</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------</td>
<td>--------------</td>
<td>-------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Stepped Zoom-Pan†:** | | CTRL + I    | View:Zoom In and View:Zoom Out | • Stepped zoom.  
• CTRL + I activates zoom in; click on the graph to establish the focal point.  
• CTRL + M zooms out; clicking on graph not needed. |
| Zoom All: All objects in the window are shown. | -- | -- | View: Zoom All | • Can be used to locate "lost" objects lying outside the graph page. |
| Whole Page: Show the whole graph page. | | CTRL + W | View: Whole Page | • Reset the view of the page after using the Zoom-Panning tools, above. |

†Notes: These are older tools and methods that have been deprecated. Toolbar buttons are not shown by default. To add them to the workspace, use the Customize Toolbars dialog box (View: Toolbars > Graph button group).

### 13.1.2 Axis Rescaling

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Menu</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **Rescale**: Rescale and pan the graph in both X and Y dimensions. | | -- | -- | • Scroll mouse wheel to rescale X.  
• SHIFT + scroll to rescale Y.  
• Drag with the left mouse button to pan (will rescale both X and Y).  
• Select the Pointer tool to exit Rescale mode. |
<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Menu</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rescale the graph in the X dimension.</td>
<td>--</td>
<td>Z + scroll wheel or Z + +/- keys</td>
<td>--</td>
<td>• Rescale the graph in the X dimension without limits.</td>
</tr>
<tr>
<td>Pan the graph in the X dimension.</td>
<td>--</td>
<td>X + scroll wheel or X + +/- keys</td>
<td>--</td>
<td>• Rescales X.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Does not rescale Y.</td>
</tr>
<tr>
<td><strong>Rescale X:</strong> Rescale the graph in the X</td>
<td>![Arrow]</td>
<td>--</td>
<td>--</td>
<td>• Rescales (Resets) X to full X range + some padding factor.</td>
</tr>
<tr>
<td>dimension.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rescale the graph in the Y dimension.</td>
<td>--</td>
<td>SHIFT + Z + scroll wheel or SHIFT + Z + +/- keys</td>
<td>--</td>
<td>• Rescale the graph in the Y dimension without limits.</td>
</tr>
<tr>
<td>Pan the graph in the Y dimension.</td>
<td>--</td>
<td>SHIFT + X + scroll wheel or SHIFT + X + +/- keys</td>
<td>--</td>
<td>• Rescales Y.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Does not rescale X.</td>
</tr>
<tr>
<td><strong>Rescale Y:</strong> Rescale the graph in the Y</td>
<td>![Arrow]</td>
<td>--</td>
<td>--</td>
<td>• Rescales (Resets) Y to full Y range + some padding factor.</td>
</tr>
<tr>
<td>dimension.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Button</td>
<td>Shortcut Key</td>
<td>Menu</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------</td>
<td>--------------</td>
<td>------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rescale XY: Rescale the graph in both X and Y dimensions.</td>
<td><img src="image" alt="Arrow" /></td>
<td>--</td>
<td>--</td>
<td>• Rescales (Resets) X and Y to full range + some padding factor.</td>
</tr>
<tr>
<td>Rescale Z: Rescale the graph in the Z dimension.</td>
<td><img src="image" alt="Arrow" /></td>
<td>--</td>
<td>--</td>
<td>• Rescales (Resets) Z to full range + some padding factor.</td>
</tr>
</tbody>
</table>
| Scale In/Scale Out: Rescale the graph in X and Y dimensions. | ![Magnifying Glass and Arrow](image) | --           | --          | • Select Scale In button, then drag out rectangle(s) to define axis scale range desired.  
• Reset by clicking on the Scale Out button (no need to drag) several times.  
• Rescales both X and Y.  
• Press ESC (or select another tool) to quit magnifying mode. |
| Rescale: Rescale the graph in the all dimensions. | ![Arrow](image) | CTRL + R     | Graph: Rescale to Show All | • Rescales (Resets) all axes to display all data in the layer (+ some padding factor). |

You can use the Scale In button ![Magnifying Glass and Arrow](image) to copy an enlarged portion of your 2D graph to a new window. With a graph active, press Ctrl then click the Scale In button ![Magnifying Glass and Arrow](image) (Tools toolbar) and drag out a rectangle on your 2D graph. Note that this Enlarged graph is dynamic. Move or resize the rectangle on your original graph and the Enlarged graph is updated.

If you do not see a toolbar button, it may be turned off. To add or remove buttons from a toolbar, see The Customize Toolbar Dialog Box.
Origin 9.1 SR0 introduced the `@nrm` system variable to modify rescale behavior when using the Rescale tool or associated shortcut keys:

@nrm = 0: From/To values on the Scale tab of the Axis dialog box will change when Rescale is set to Manual. This is established behavior.

@nrm = 1: From/To values will not change when Rescale is set to Manual. This is new behavior.

Modify the current behavior by opening the Script Window (Window: Script Window), typing `@nrm = <value>`, then pressing ENTER.

Note:

- Since Origin 2017, we have renamed Manual rescaling to Fixed rescaling. And several advanced selections, one-side fixed rescaling, have been available under this Rescale down list.
- When using the older Scale In tool you are prompted to override Manual rescaling. When @nrm=1 you cannot override the Axis dialog box Rescale setting.

### 13.2 Rotation of 3D openGL Graphs

You can interactively rotate your 3D graphs for purposes of data exploration. When you click on an empty portion of a 3D graph, a floating toolbar displays. You can use the floating buttons to rotate the graph; or you can use your keyboard and mouse.

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Menu/Action</th>
<th>Context</th>
</tr>
</thead>
<tbody>
<tr>
<td>X + Arrow key</td>
<td>Rotate the 3D graph around the X axis.</td>
<td>With graph layer active and with Rotate button selected in the 3D floating button group.</td>
</tr>
<tr>
<td>Y + Arrow key</td>
<td>Rotate the 3D graph around the Y axis.</td>
<td></td>
</tr>
<tr>
<td>Z + Arrow key</td>
<td>Rotate the 3D graph around the Z axis.</td>
<td></td>
</tr>
<tr>
<td>Q + Arrow key</td>
<td>Rotate the 3D graph in screen.</td>
<td></td>
</tr>
<tr>
<td>W + Arrow key</td>
<td>Rotate the 3D graph around any axes.</td>
<td></td>
</tr>
</tbody>
</table>
### Hot Key

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Menu/Action</th>
<th>Context</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rotate 3D graphs using R key</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>R + Mouse</td>
<td>Drag to rotate the 3D graph in an arbitrary direction.</td>
<td>Press &quot;R&quot; before pressing other keys.</td>
</tr>
<tr>
<td>R + Ctrl + Mouse/Arrow key</td>
<td>Rotate the 3D graph around the X axis.</td>
<td>Hovering on a 3D graph while pressing &quot;R&quot; changes the Pointer tool to a arrow. Press Ctrl and/or Shift as needed, and rotate by (a) dragging with your mouse or (b) pressing the arrow keys on your keyboard.</td>
</tr>
<tr>
<td>R + Shift + Mouse/Arrow key</td>
<td>Rotate the 3D graph around the Y axis.</td>
<td></td>
</tr>
<tr>
<td>R + Ctrl + Shift + Mouse/Arrow key</td>
<td>Rotate the 3D graph around the Z axis.</td>
<td></td>
</tr>
</tbody>
</table>

### 13.3 Reading Coordinate Values and Distances

Origin provides several tools to aid in labeling and graphical exploration of your data plots. Most of these tools are available from the **Tools** toolbar (View: Toolbars). There is a related tool -- **Vertical Cursor** -- available from the **Gadgets** menu.

#### 13.3.1 Data Point Tooltips

Origin 2017 added a floating tooltip that, when you hover on a data plot, identifies the source dataset. Origin 2018 expanded on this, adding a shortcut menu that is opened by right-clicking directly on the tooltip.

- **Go to worksheet** pops up the worksheet that contains the source data for the plot.
• **Pick Data Points** puts the cursor into data reading mode and opens a Pick Points dialog. Double-click on points in the graph and when finished, click **Done**. This generates summary data (source, X-Y coordinates, etc.) for your picked points.

If you find the tooltip distracting, you can turn it off by changing the value of LabTalk system variable @PT.

```labtalk
@PT=0; //Disable dataset tooltips
@PT=1; //Enable dataset tooltips for 2D graph (default)
@PT=2; //Enable dataset tooltips for 3D OpenGL graph
@PT=3; //Enable dataset tooltips for both 2D graph and 3D OpenGL graph
```

13.3.2 The Annotation Tool

Use the **Annotation** tool to label a data point. The tool works with Symbol/Line+Symbol and Column/Bar plots. Choose from several standard data point labels or create your own custom label using LabTalk script.

To annotate a data point:

1. Click the **Annotation** button on the **Tools** toolbar and move the cursor to the desired data point. The **cursor** and the **Status Bar** will display the current label form.

   ![Cursor and Status Bar](image)

   `[double click=add an annotation, TAB=toggle annotation label current label :Custom (this point s x location is $X)]`

2. Use the TAB to toggle between the following standard annotation forms: `(X coordinate value, Y coordinate value); (X coordinate value, Y coordinate value)[index number]; X coordinate value; Y coordinate value; index number (row number); or Custom (see Tutorial, next).

3. When you've selected your label form, double-click to add a label to the data point.

   **Tutorial: Customizing the Annotation String**

   The annotation string can be customized by combining literal characters with the X and Y coordinate values:
1. Start with a graph of your data

2. Open the **Script Window** (Window:Script Window) and type the following command, then press Enter:

   ```
   system.annotation.customlabel$="X value: $(x,.2), Y value: $(y, *5)
   ```

3. Click the **Annotation** button, hover on your graph, then press the **Tab** key several times to cycle through the annotation choices until the custom string format specified above is displayed in the Status Bar. The cursor will display the word "Custom".

4. Start double-clicking on data points to add the custom annotation string. The X values will be displayed with two decimal places and the Y values will be displayed with 5 significant digits, as specified by your script.

**Note:** Please view more information on string formatting in the Programming help file:

   - HELP: Programming: LabTalk > Language Reference > Object Reference > Alphabetical Listing of Objects > **String**

   - To move a label to another data point, click the **Pointer** tool, press the ALT key and drag the label.

   - To copy a label to another data point, press CTRL + SHIFT and drag to a new data point.

   In both cases, the label is automatically updated to display info on the new data point.

   Use the **Pointer** and drag to re-position overlapping labels. A leader line is automatically added.

**13.3.3 The Screen Reader tool**

The **Screen Reader** uses the **Data Display** window to report the XY(Z) coordinates of the cursor on the graph page. Note that the Data Reader is not reading data point coordinates; rather it is reading page coordinates in relation to the graph axes.
The Data Display window opens automatically when you select the Screen Reader tool from the **Tools** toolbar (by default, the Data Display window is docked at the bottom of your Origin workspace).

You can alter basic properties of the Data Display window by right-clicking on the window title bar or by right-clicking inside the window.

To use the **Screen Reader**:

1. Click the **Screen Reader** button on the **Tools** toolbar. This opens the **Data Display** tool.
2. Click on a location in the graph page to read its X,Y, and Z coordinates (ternary and contour only). Coordinate values show in the Data Display window.
3. To increase cross-hair size, press the space bar.
4. Click the **Pointer** button on the **Tools** toolbar to exit screen reading mode.

### 13.3.4 The Data Reader Tool

The **Data Reader** is used to read information associated with a data point in your plot. This could be coordinate values or it could be more complex information including metadata or even images that relate to the data point. The Data Reader works in concert with the customizable **Data Info window**.

The **Data Reader** tool is grouped with one related tool -- the **Data Cursor** tool. Only one of them will display at a time. To select a hidden tool, click on the small arrow to the right of the button and select a tool from the pop-up menu.

To use the Data Reader tool:

1. Click the **Data Reader** button on the **Tools** toolbar. This opens the **Data Info** window.
2. Click on a data point to read its X,Y (and Z, if they exist) coordinates. Coordinate values display in the Data Info window (and Data Display window).
3. To move the cross-hair to the next data point along the data plot, use the LEFT and RIGHT arrow keys or click on the data point using your mouse. If you have multiple plots in a layer, use the UP and DOWN arrow keys to move to a data point on another plot or use your mouse to click on the point.
4. To change the vertical and horizontal cross-hair size, click on a point and press the spacebar.
5. Click the **Pointer** button on the **Tools** toolbar or **Esc** key to exit the Data Reader tool.

### 13.3.5 The Data Cursor Tool

The **Data Cursor** tool -- grouped on the Tools toolbar with the **Data Reader** tool -- allows you to place one or more cursors on a data plot and (using the **Data Info window**) read the cursor coordinates or measure the X and Y distance between two cursors, or the distance between a cursor and a point selected with the **Data Reader**.
Tutorial: Using the Cursor Tool to Measure Relative Distance

1. Import the file $\text{Samples}\backslash\text{Spectroscopy}\backslash\text{Sample Pulses.dat}$ and create a line plot.
2. Click and select the Data Cursor button from the Tools toolbar.

3. Double-click on one of the peaks or click once on a data point and press ENTER, to add a cursor object.

4. Repeat to place a second cursor object on another peak.
5. Double click in the Data Info. window to open the Data Info. Report Settings dialog. If this window is not visible, select the View: Show Data Info menu item to open the Data Info. window.
6. Switch to the Columns tab and then right-click in the gray area to the right of the columns and choose Add Column.
7. In the new column that is added, click on the source row of new column, and select Relative (Cursor2 - Cursor1) from the drop-down, and then press OK to close the dialog.
8. Now you can drag and move the cursor objects and the third column in the Data Info window will display the X and Y distances between the two cursors.
13.3.6 The Data Info Window

The Data Info window opens when you choose either the Data Reader, the Annotation or the Data Cursor tools. When you click on a plotted data point with one of these tools, the Data Info window displays information about this particular data point.

You have considerable control over the sort of information that is reported by the Data Info window. In addition to reporting XY coordinate data as the Data Display tool does, the Data Info window can display other classes of data -- metadata and images -- associated with a particular data point.
To customize the display of the Data Info window, right-click on the Data Info window and choose Preferences... from the shortcut menu; or simply double-click on the Data Info window. Use the controls in the Data Info Report Settings dialog box to customize the display of the Data Info window:

- **The Title tab** is used to specify how the report title is displayed in the upper left corner of the Data Info window.
- **The Rows tab** is used to specify which columns in the data worksheet are shown in the Data Info window.
- **The Columns tab** allows control over what displays in the Data Info window. In addition to the data groups that are chosen in the Rows tab, the user can choose to show additional information such as the Long Name, Short Name, Units, and data contained in individual cells.
- **The Display tab** contains options for customizing the display properties of the Data Info window.
- At the top of the dialog, there is a Dialog Theme control. The Data Info window customizations can be saved to the graph, layer and even plot level so that every time you use the Data Reader, Cursor, or Annotation tools on an applicable graph, layer or plot, your customized Data Info window will display; Or you can save customizations as a Theme file for later use.

For more information on customizing the Data Info window, see:

- The Data Info Window.
- Tutorial: The Data Reader Tool (discussion on customizing the Data Info window).

### 13.3.7 Gadgets

Origin provides several Gadgets for data exploration and analysis. These gadgets are accessible from the Gadgets menu when a graph window is active. Three gadgets in particular are suitable for data exploration:

- **Vertical Cursor**
- **Statistics**
- **Cluster** (OriginPro)
The **Vertical Cursor** gadget is especially useful for reading XY coordinate values for data points in stacked panel plots or multi-plot graphs, where plots share a common X scale.

To open the Vertical Cursor:

1. With a graph window active, choose **Gadgets: Vertical Cursor...** from the main menu. This opens the **Vertical Cursor** dialog box.

Using the controls in this Gadget's dialog box, you can add data labels to the graph, increase or decrease label font size, hide labels, etc.

The **Statistics** gadget returns basic statistics on data points falling inside a rectangular region-of-interest (ROI) on the graph.

- Display basic statistics for data inside the ROI.
- Display mean and \( n \)th Standard Deviation lines inside the ROI.
- Update results dynamically as ROI is moved or resized.
The **Cluster** gadget (available in OriginPro) provides the following features:

- Display basic statistics for data inside a region of interest (ROI).
- Switch between rectangular or elliptical ROI.
- View statistics for points inside and outside of the ROI.
- Edit, copy, mask, delete or group data points.
- Update results dynamically as ROI is moved/re-sized.
- Output results to a worksheet.

Beginning with Origin 2018, when you use the **Cluster** gadget to define a category (points within a ROI on a plot), you can apply a differentiating color to points within the ROI.
Note: To learn more about these gadgets, see:

Help: Origin: Origin Help > Gadgets
13.4 Topics for Further Reading

- Gadgets
- The Data Analysis chapter of this User Guide
- The Cluster Gadget (OriginPro)
- The Vertical Cursor Gadget
- The Digitizer
- The Statistics Gadget
- Masking Data
- Data Filtering
- Drawing or Deleting Data Points in the Graph
- List of Origin Built-in Toolbars and Buttons
14 Gadgets

Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. The concept is simple: While each Gadget has a specific purpose, each is built around applying a set of customizable analysis operations to a range of plotted data defined by a movable, resizable, region-of-interest (ROI) object.

You can drag to modify the ROI at any time, then change your analysis options and recalculate results by clicking the arrow button in the upper-right corner of the ROI and choosing one of the menu options. For general access to Gadget formatting and analysis options, choose Preferences at the bottom of the context menu. Use the Preferences Dialog Theme box to save a group of Gadget settings to a Theme file.

Multiple Gadgets are supported on a graph. You can distinguish ROIs by giving each a different color. Click on an ROI object to bring it forward. When an ROI is selected, you can use the TAB key to switch the ROI.

Origin 2016 introduced add-on tools called Apps. Since being introduced, many new exploratory and analysis-related tools have been added to OriginLab’s File Exchange and more tools are being released all the time. Please visit the File Exchange to review available tools.

14.1 Origin Gadgets

The Gadgets main menu is available when a graph window is active. There are 14 gadgets available in Origin:
<table>
<thead>
<tr>
<th>Gadget Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cluster Gadget†</strong></td>
<td>View statistics on points inside/outside a rectangular or elliptical ROI <em>(OriginPro Only)</em>.</td>
</tr>
<tr>
<td><strong>Differentiate Gadget</strong></td>
<td>Calculate and plot the $n$th-order derivative of selected data.</td>
</tr>
<tr>
<td><strong>FFT Gadget</strong></td>
<td>View FFT spectrum of selected data.</td>
</tr>
<tr>
<td><strong>Integration Gadget</strong></td>
<td>Calculate the area under a curve, or between two curves.</td>
</tr>
<tr>
<td><strong>2D Integration Gadget</strong></td>
<td>Calculate the 2D integration for a contour or image graph created from matrix or XYZ worksheet data <em>(OriginPro Only)</em>.</td>
</tr>
<tr>
<td><strong>Interpolate Gadget</strong></td>
<td>Perform linear, spline, b-spline or Akima spline interpolation of selected data.</td>
</tr>
<tr>
<td><strong>Intersect Gadget</strong></td>
<td>Calculate the intersection points of two or more data plots.</td>
</tr>
<tr>
<td><strong>Quick Fit Gadget</strong></td>
<td>Perform linear, polynomial, or nonlinear fitting of selected data.</td>
</tr>
<tr>
<td><strong>Quick Peaks Gadget</strong></td>
<td>Locate peaks, and compute area and other peak properties.</td>
</tr>
<tr>
<td><strong>Quick Sigmoidal Fit Gadget</strong></td>
<td>Perform Sigmoidal fit of selected data.</td>
</tr>
<tr>
<td><strong>Rise Time Gadget</strong></td>
<td>Analyzes rise/fall time for the step-like signal <em>(OriginPro Only)</em>.</td>
</tr>
<tr>
<td><strong>Statistics Gadget</strong></td>
<td>Compute and display simple descriptive statistics of selected data on the graph.</td>
</tr>
<tr>
<td><strong>Vertical Cursor Gadget</strong></td>
<td>Read and tag X, Y coordinate values for data plots across multiple graphs that share the same X axis.</td>
</tr>
<tr>
<td><strong>Image/Contour Profile</strong></td>
<td>Analyze the image or contour from matrix data and generate profiles.</td>
</tr>
<tr>
<td><strong>Curve Translate Gadget</strong></td>
<td>Drag a curve in the vertical or horizontal direction, adjusting source data in the process.</td>
</tr>
</tbody>
</table>
Note: To learn more about these gadgets, see:


† For 2018, when you use the Cluster gadget to graphically define a category (within an ROI), you can apply a differentiating color to points within the ROI.

Tutorial: Using the Integrate Gadget to Output Results to a Worksheet

1. With a new workbook active, import the file Peaks on Exponential Baseline.dat located in the Samples\Spectroscopy subfolder under the Origin installation folder.
2. Create a line plot of the data in column B.
3. With the graph active, go to the main menu and click Gadgets: Integrate....
4. In the dialog box that opens, click the Baseline tab and select Straight Line from the Mode drop-down list.
5. Click the Output tab, and under the Output Quantities to node, select Append to Worksheet and clear the other check boxes.
6. Expand the Quantities node, select None from the Dataset Identifier drop-down list and enable Beginning X and Ending X.
7. Press OK to close the dialog box. The Region-of-Interest (ROI) rectangle object is added to the graph.
8. Resize and move the ROI object to cover just the first peak in the data plot, then press the arrow button located at the top-right of the ROI and select New Output. This will write the parameters for the first peak to a worksheet.
9. Drag and move the ROI to cover the second peak, and repeat the steps above to generate output for the second peak.
10. Press the arrow button again and this time select Go to Report Worksheet. A worksheet with the integration results will open.
Click the arrow button in the top right corner of the ROI and you can opt to output results for all curves in the current layer (New Output for all Curves (N)) or for all layers of the graph page (New Output for All Layers (L)) or press the corresponding N or L hotkey. This allows for batch analysis of multiple curves in a graph.

14.2 Topics for Further Reading

- **Gadgets**
- **The Image/Contour Profile tool**
- **Tutorial: Using Multiple Gadgets**
- **Tutorials for Individual Gadgets**
- **Peak Analyzer**
- **Digitizer**
15 Data Analysis

15.1 Introduction

Origin contains powerful tools for all of your analytic needs, including peak analysis, curve fitting, statistics, and signal processing. The output of one operation can be used as input for another, allowing for a chain of operations and their associated results to be updated. You can easily update results when input data or analysis parameters are changed and avoid the trouble of repeating the procedure from the beginning.

The following sections cover (1) identifying the data that you wish to analyze and (2) the Origin and OriginPro tools available for analyzing that data. Please refer to the How to Handle Repetitive Tasks chapter of this User Guide for more information on Analysis Templates, Dialog Themes and other time-saving features.

Origin 2016 introduced add-on tools called Apps. Since being introduced, many new exploratory and analysis-related tools have been added to OriginLab’s File Exchange and more tools are being released all the time. Please visit the File Exchange to review available tools.

15.2 Selecting Data

Origin’s analyses tools may act on workbook data or plotted (graph window) data. By default, analyses will be done on highlighted data in worksheet or the active plot in graph. You may want to restrict your analysis to a subset of the data; say, a certain range of rows or columns in a worksheet, or a certain X range in a graph.

You can either do the data selection (with methods mentioned below) before opening an analysis dialog or after opening the dialog. Most of Origin’s X-Function based analysis tools have an Input Data branch with standard range selection control that you’ll want to become familiar with (we explain the control, below).

15.2.1 Selecting Data in the Worksheet

When you highlight a range of worksheet data, then open one of X-Function based dialog boxes -- that would include nearly all of those that open from the Analysis or Statistics menus -- you will see your range selection already entered into the dialog box Input Data branch. Most will find that selecting worksheet data prior to opening an Analysis or Statistics dialog box, is the easiest way to specify which data you wish to analyze.
If you open one of the X-Function dialog boxes without pre-selecting your data, the first thing you should do upon opening the dialog is to select data in Input Data branch:

1. Click the range selection control next to Input Data. The dialog box will roll up.

2. Go to worksheet and highlight your worksheet data, then click the button at the right end of the rolled up dialog box. The Input Data branch will now show the selected range.

Note that you do not have to select entire datasets (columns). You can select a portion of your worksheet data and analyses will be confined to that selected subset of your data. Also if the analysis supports multiple datasets, you could support multiple ranges such as multiple Y columns or Y ranges. If the analysis only supports one dataset, you may be able to select multiple ranges in the worksheet, but only the 1st range will be picked in the analysis.
Notes

- The Input Data branch has a hierarchical structure. If the analysis supports multiple datasets, you can add multiple ranges under Input Data and they will show as Range 1, Range 2, etc., each with its corresponding X, Y, Error and Row controls.

- Mousing over each level will show a tooltip indicating where the data on that level is from (i.e. book, sheet and column).

- A Rows control under each range node lets you set range by index or X value. If you want to apply the same row range to all ranges under Input Data, click the arrow button to the right of the range node and choose Apply Row Range to All.

- Depending on where you are in the Input Data hierarchy, the range selection button may have some limitations (e.g. if you click range selection control next to Y, though you could select multiple columns in a worksheet, only the 1st column is accepted).

- Clicking the arrow button to the right of the range selection control will show more selection options, including individual worksheet columns that can be quickly added to your data selection.

- Depending on which level you are in, the selection options when clicking the arrow button may vary. For instance, clicking the "arrow" button next to Input Data and clicking the Select Columns... menu item, will open the Column Browser allowing you to select multiple columns from different worksheets.
1. Use the List Datasets drop-down list to filter which sheets you want to pick from. The top panel list can be sorted by clicking any of the column headings, making it easy to select, for example, all columns that share the same LName or Comments.

2. Then click the Add button to add the column to your selection list in bottom panel.

3. To modify the data input range of any dataset, click the range button to the right of any dataset added to the bottom panel and edit the From and To values.

15.2.2 Selecting Data in the Graph

When a graph window is active and you select one of the Analysis menu tools, the default behavior is for the analysis dialog box to open showing the selected range of the active dataset as your Input Data (note that analysis dialogs include an Input Data node that allows adjustments -- adding more datasets with the interactive range selector button, changing a data range, etc.).

The active dataset is the one that shows in the data list (bottom of the Data menu) with a check mark next to it. Note that this analysis dialog box behavior applies even to plot groups. You can force an Analysis dialog box to register a particular data range by clicking on another of the data plots listed at the bottom of the Data menu.
Alternately, you can graphically set the range for your analysis by selecting one or more plots in the graph window:

- If your data plots are not part of a plot group, you can click once on the intended plot before opening an Analysis dialog box and this will set the Input Data range to the selected plot.

- If your data plots are part of a plot group, click once on any of the plots in the group to set Input Range to all plots in the group; or click a second time on any plot to restrict analysis to the selected plot (note that this does not switch the active dataset). Alternately, you can pre-select multiple plots using the Regional Data Selector (see below).

You can indicate the active dataset by placing a red rectangle around the plot's legend entry. To turn this feature on or off:

- Click on your graph window, select Format: Page Properties..., click on the Legends/Titles tab and enable or clear the Indicate Active Dataset box.

- Right-click on the graph and choose Legend, then select/deselect Indicate Active Dataset.

- Right-click on the graph and choose Legend: Update Legend and enable or clear the Indicate Active Dataset box.
15.2.3 Selecting a Subset of Your Data Graphically

You can graphically select a range of data using the **Regional Data Selector** tool:

1. With a graph window active, click and hold the **Regional Data Selector** button on the **Tools** toolbar, and then choose **Selection on Active Plot** or **Selection on All Plots**.
2. Drag out a rectangle or freehand object to select an area of the plot(s). Press **Space** to toggle between rectangle and freehand modes.

When you make your selection, data markers appear on the graph, delineating the selected range(s). You can work with graphically selected data using Origin’s analysis tools (e.g., Linear Fit), but note that some analysis dialog boxes do not work on multiple data ranges. The smoothing dialog box, for example, (**Analysis: Signal Processing: Smooth...**) will only smooth data in the active dataset or a single, selected plot.

**Tutorial: Linear Regression on Partial X Range**

1. Import the file \Samples\Curve Fitting\Exponential Decay.dat into a new workbook.
2. Select all Y columns and create a line plot.
3. Click and hold the **Regional Data Selector** button on the **Tools** toolbar, and then choose the **Selection on All Plots** button.
4. Drag out a rectangle to select the tail-end of the three curves between values of approximately 0.6 and 1.0 along the X axis.
5. Use the **Analysis:Fitting:Linear Fit** menu to open the **Linear Fit** dialog.
6. **Input Data** branch is filled with three ranges. Mouse over **Input Data** branch will show tooltip which shows 1X,1Y, ...3X and 3Y.
7. If you want to change the data selection, click the **arrow** button in **Input Data** and choose **Reselect All Data from Graph**. The dialog will roll up. Drag out a rectangle in graph again to make your selection and then click the **button at the right end of the rolled up dialog box. The new data selection will show in **Input Data** branch.
8. Accept default Linear Fit settings and press **OK** to close the dialog. Linear fitting will be performed on all three curves over the selected range.
In addition to the **data selection** and **data masking** methods discussed in this section, Origin includes **data filtering** and **data reduction** tools. Please visit the linked pages for details.

### 15.2.4 Editing a Data Marker

To edit a **Data Marker**:

- To modify a data range, right-click a data marker and choose **Edit**; or double-click on the data marker. The red marker changes to a dark color with arrows on both ends and the cursor changes into a cross-hair. Drag the beginning or ending marker to a new position or use one of the keyboard shortcuts listed below and modify the data range. To escape edit mode, double-click on the marker or press the Enter key.
- There are other options when right-clicking the data marker such as **Delete Marker**, **Delete Data**, etc..

![Edit Options]

[Image of Edit Options menu]

[Image of Data Curve]

- Decay 1
- Decay 2
- Decay 3
- Fit Curve of Decay 1
- Fit Curve of Decay 2
- Fit Curve of Decay 3

![Plot of Data Curves]

- Amplitude vs Time (sec)
- Graph showing decay curves and fit curves.
**Note:** If you have used the Regional Data Selector tool to place markers on multiple plots (Selection on All Plots), be aware that moving markers will affect the data range of the active plot only; the ranges of other selected plots will not follow that of the active plot. This is a limitation of the Regional Data Selector.

Alternately, you can use these keyboard shortcuts to select and edit data markers:

1. Select data markers using these keys ...

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>s</td>
<td>Select the first pair of data markers on the graph (those marked with &quot;1&quot;).</td>
</tr>
<tr>
<td>Tab</td>
<td>Select the next pair of data markers (not in edit mode) or the other data marker of the pair (in marker edit mode).</td>
</tr>
<tr>
<td>Home</td>
<td>Return to the first data marker.</td>
</tr>
<tr>
<td>End</td>
<td>Go to the last data marker.</td>
</tr>
</tbody>
</table>

2. ... then activate and edit the data marker using these key combinations:

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Activate the selected data marker for editing. (Press Enter again to exit data selection mode.)</td>
</tr>
<tr>
<td>Arrow</td>
<td>Move the active data marker exactly one data point.</td>
</tr>
<tr>
<td>Ctrl/Shift + Arrow</td>
<td>Move the active data marker multiple data points.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the active data marker.</td>
</tr>
</tbody>
</table>

**15.2.5 Difference between Data Markers and Analysis Markers**

- **Data Markers** define a sub-range that you select using the Data Selector tool. If you want to remove the data markers from a graph, you can select **Data: Clear Data Markers** from the main menu, or click the Clear Data Markers button on the Markers and Locks toolbar.
When the analysis routine is completed, Data Markers are replaced with **Analysis Markers**. By default, Analysis Markers will not show if the analysis is done on the entire dataset. If performed on a subrange, Analysis Markers will show at the beginning and end of that subrange. To modify the data range and rerun your analysis, you must right-click an analysis marker and choose **Change Parameters**. Change the Input Data range and rerun the analysis.
Note:

1. If you set Recalculate to None in the analysis dialog box, then no analysis markers are generated.
2. Data markers and analysis markers are not exported when you choose File: Export Graphs.
3. To select the exact same range again for another analysis, click the green lock and choose Plot Input Data with Data Markers to create a new graph and do analysis on it.
4. There is a Markers and Locks toolbar to control analysis markers and locks, such as Marker Hide Show to toggle analysis markers on or off, etc. There is also Data: Analysis Marker menu and context menus when right click on analysis marker, green lock, in graph layer to control analysis markers.

15.3 Data Masking

Masking is another tool that you can use when you want to analyze only a subset of your data, or when you have spurious data points that you do not want included in your analysis. Mask or unmask will trigger recalculation.

You can mask data points in either your worksheet or your graph. When data exist in both the worksheet and the graph, masking data in one will mask the corresponding data in the other.

Note that there are two toolbars with masking buttons: the Tools toolbar and the Mask toolbar. The masking tools on the Tools toolbar work only with graphs. The tools on the Mask toolbar work with worksheets or graphs.

15.3.1 Masking Data in Worksheets

Masking of worksheet data excludes masked data from analysis operations. When plotted, masked data points display in the mask color.

<table>
<thead>
<tr>
<th>Action</th>
<th>Toolbar Button</th>
<th>Shortcut Command</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mask data</td>
<td>![Mask symbol]</td>
<td>Mask: Range</td>
<td>Mask the selected data range. Masked data will display in the mask color.</td>
</tr>
<tr>
<td>Unmask data</td>
<td>![Unmask symbol]</td>
<td>Mask: Clear Range</td>
<td>Unmask the selected data range. Unmasked points are included in analysis operations and plot &quot;normally&quot;.</td>
</tr>
<tr>
<td>Change mask color</td>
<td>![Mask color]</td>
<td>Mask: Change Color</td>
<td>Change the mask color of the masked data range.</td>
</tr>
<tr>
<td>Disable masking</td>
<td>![Mask enable symbol]</td>
<td>Mask: Disable Masking</td>
<td>Toggle the mask on or off for all masked data in the worksheet.</td>
</tr>
</tbody>
</table>
### 15.3.2 Masking Data in Graphs

With your graph window active:

1. Choose **Data: Mask Data Points** from the main menu or click the **Mask Points on Active Plot** button or **Mask Points on All Plots** button on the **Tools** toolbar. This activates the **Regional Mask Tool**.
2. To mask a single point, double click on the point.
3. To mask a region of points, similar to **Regional Data Selector**, press the **space** bar to toggle among masking by row index, rectangular region or by freehand region. Then draw a rectangle or freehand region to mask data in that region.

Note that the cursor changes as you:

- Press **space** bar to toggle masking data points by row index number, rectangular region or freehand region.
- Choose the **Mask Points on the Active Plot** tool vs. the **Mask Points on All Plots of Active Layer** tool (**Tools** toolbar).

<table>
<thead>
<tr>
<th>Mask Points on Active Plot</th>
<th>Mask Points on All Plots of Active Layer</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Mask Points on Active Plot" /></td>
<td><img src="image" alt="Mask Points on All Plots of Active Layer" /></td>
<td>Mask data points by row index number. All data points between the lowest and highest selected index numbers are masked regardless of whether they lie inside your rectangle.</td>
</tr>
<tr>
<td><img src="image" alt="Mask Points on Active Plot" /></td>
<td><img src="image" alt="Mask Points on All Plots of Active Layer" /></td>
<td>Mask data points by rectangular region. Only the data points inside the rectangle that you drag out, will be masked.</td>
</tr>
<tr>
<td><img src="image" alt="Mask Points on Active Plot" /></td>
<td><img src="image" alt="Mask Points on All Plots of Active Layer" /></td>
<td>Mask data points by freehand region. Only the data points inside the region that you drag out, will be masked.</td>
</tr>
</tbody>
</table>

To remove the mask from data points in the graph window:

1. Choose either the **Unmask Points on the Active Plot** tool or the **Unmask Points on All Plots of Active Layer** tool on the **Tools** toolbar.
2. Use the **space** bar, as needed, to choose points by index, rectangular region or by freehand region, then drag to unmask your data points.
Some useful buttons on the **Mask** toolbar:

- **Change mask color** to avoid using the same mask color as your data plot color.
- **Hide/Show masked points** to hide masked points on the screen, printout and exported graph.
- **Disable/Enable Masking** button to quickly toggle the mask on or off without removing the masked points.

### 15.4 Drawing or Moving, or Deleting Data Points in the Graph

This collection of tools and menu-driven operations is helpful in exploring certain "what if" scenarios, or to quickly generate some data for purposes such as testing a fitting function. These procedures work only with 2D scatter plots.

1. Activate the graph window.
2. Click on the **Draw Data Tool**.
3. Make sure that the correct graph layer is active and place the cursor on the graph.
4. Double-click to create data points. The **Data Display** tool opens (if not already open) and displays the $X$ and $Y$ values for each created data point.
5. When you have finished adding data points, click on another tool (on the **Tools** toolbar) to exit drawing mode.

When you use the **Draw Data** tool, you simultaneously create a hidden worksheet named **Drawn** (worksheets are automatically enumerated, with $n = 1, 2, 3, 4, \text{etc.}$).

#### 15.4.1 Opening the hidden Drawn Worksheet

Right-click on the data plot and select **Go to Drawn** from the shortcut menu or in Plot Details dialog, with data plot selected on left panel, click the **Workbook** button.

A **Drawn** workbook will appear with A($X$) and B($Y$) columns with coordinate values of your drawn data plot.

#### 15.4.2 Deleting a Data Point

You can delete individual data points from your graph:

1. Select **Data: Remove Bad Data Points**.
2. Double-click on the data point, or click to select the data point and press **ENTER** key.
3. Click Arrow button on **Tools** toolbar or press **ESC** key to exit the Remove Bad Data Points mode.

The data point is deleted from both the data plot and the worksheet cell. In the worksheet, only the data cell for the $Y$ value will be cleared and shown as missing value.
15.4.3 Moving a Data Point

You can move individual data points in the graph. Understand that when you do this, you are changing the plot and the underlying data:

1. Select Data: Move Data Points (you'll be warned that you are about to change your data).
2. Click on the point you want to move (change X and Y coordinates). Place crosshairs on the point and drag; or use the arrow keys.
3. Click the Pointer button on the Tools toolbar or press ESC to exit the Move Data Points mode.

The data point is moved in the plot and the X and Y coordinates are changed in the worksheet cell.

15.4.4 Picking Data Points

Since Origin 2018b, you can pick the data points in the graph using the Pick Data Points tool.

1. Select Data: Pick Data Points. The Pick Points dialog will pop up.
2. With the square cross-hair, you can read the coordinate of current data points in the Pick Points dialog (also the data source info). Double-click on the point you want to pick until the cross-hair cursor became round, the actual X&Y values will be recorded and the total number of picked points will be counted up.

![Pick Points dialog]

3. Once you finished the picking, click the Done button to generate the results in a new workbook.
15.5 Mathematics

Origin provides a number of mathematics tools to perform basic calculations, interpolation, and area or volume calculations.

15.5.1 Basic Math

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Description</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Simple Column Math/Simple Curve Math</td>
<td>• Perform basic calculations on worksheet columns or XY data plots</td>
<td>Analysis:Mathematics (workbook, graph)</td>
</tr>
<tr>
<td>• Normalize Columns/Curves</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Average Multiple Curves</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Differentiate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Subtract Reference Data</td>
<td>• Subtract one dataset from another</td>
<td>Analysis:Data Manipulation (workbook, graph)</td>
</tr>
<tr>
<td>• Subtract Straight Line</td>
<td>• Subtract a straight line defined graphically by clicking in the graph.</td>
<td>Analysis:Data Manipulation (graph)</td>
</tr>
<tr>
<td>• Vertical Translate</td>
<td>• Use a Gadget to graphically translate curve(s) in vertical or horizontal.</td>
<td>Analysis:Data Manipulation (graph)</td>
</tr>
<tr>
<td>• Horizontal Translate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Differentiate Gadget</td>
<td>• Perform differentiation over a region of interest in a graph</td>
<td>Gadgets:Differentiate... (graph)</td>
</tr>
<tr>
<td>• Intersect Gadget</td>
<td>• Calculate the intersection points of two or more data plots.</td>
<td>Gadgets:Intersect... (graph)</td>
</tr>
<tr>
<td>• Vertical Cursor</td>
<td>• Read and tag X, Y coordinate values for data plots across multiple graphs that share the same X axis.</td>
<td>Gadgets:Vertical Cursor... (graph)</td>
</tr>
</tbody>
</table>
### 15.5.2 Interpolation

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Description</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Interpolate Gadget</td>
<td>• Perform interpolation over a region of interest</td>
<td>Gadgets:Interpolate... (graph)</td>
</tr>
<tr>
<td>• Interpolate/Extrapolate</td>
<td>• Perform interpolation/extrapolation on a group of XY data.</td>
<td>Analysis:Mathematics (workbook, graph)</td>
</tr>
<tr>
<td>• XYZ Trace Interpolation(3D Graph)</td>
<td>• Perform periodic interpolation on XYZ worksheet data</td>
<td></td>
</tr>
<tr>
<td>• Trace Interpolation(2D Graph)</td>
<td>• Perform interpolation on cycle or periodic curves</td>
<td></td>
</tr>
<tr>
<td>Tool Name</td>
<td>Description</td>
<td>Menu Entry</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Interpolate/Extrapolate Y from X</td>
<td>Perform interpolation/extrapolation on a group of XY data to find Y at given X values.</td>
<td>Analysis:Mathematics (workbook)</td>
</tr>
<tr>
<td>3D Interpolation</td>
<td>Perform 2D interpolation on a group of XYZ data to find Z at given XY values w/ choice of 8 methods.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Perform interpolation with a 3D function on XYZ dataset.</td>
<td></td>
</tr>
<tr>
<td>2D Interpolate/Extrapolate</td>
<td>Perform 2D interpolation/extrapolation for a matrix</td>
<td>Analysis:Mathematics (matrix, graph from matrix)</td>
</tr>
</tbody>
</table>

15.5.3 Area/Volume Calculation

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Description</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integrate Gadget</td>
<td>Perform integration over a region of interest in a 2D Graph</td>
<td>Gadgets:Integrate... (graph)</td>
</tr>
<tr>
<td>2D Integrate Gadget (Pro Only)</td>
<td>Calculate max height, volume, FWHM (X,Y) for a contour or image graph created from matrix or XYZ worksheet data (OriginPro Only).</td>
<td>Gadgets:2D Integrate... (graph)</td>
</tr>
<tr>
<td>Integrate (2D Graph)</td>
<td>Perform integration on input data</td>
<td>Analysis:Mathematics (workbook, graph)</td>
</tr>
<tr>
<td>Polygon Area (2D Graph)</td>
<td>Calculate the area of enclosed plot regions</td>
<td></td>
</tr>
<tr>
<td>XYZ Surface Area (3D Graph) (Pro Only)</td>
<td>Calculate the area of the XYZ surface</td>
<td></td>
</tr>
</tbody>
</table>
### 15.6 Curve Fitting

#### 15.6.1 Linear and Polynomial Fit

Linear and polynomial fitting can be performed on worksheet data or data plots in a graph. The menu entries of these tools are listed in the table below. All are available for both workbook or plotted data.

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Linear Fit</td>
<td>Analysis:Fitting:Linear Fit or Gadgets:Quick Fit (graph)</td>
</tr>
<tr>
<td>• Fit Linear with X Error (Pro Only)</td>
<td>Analysis:Fitting:Fit Linear with X Error</td>
</tr>
<tr>
<td>• Multiple Linear Regression</td>
<td>Analysis:Fitting:Multiple Linear Regression</td>
</tr>
<tr>
<td>• Polynomial Regression</td>
<td>Analysis:Fitting:Polynomial Fit or Gadgets:Quick Fit (graph)</td>
</tr>
</tbody>
</table>

#### 15.6.2 Nonlinear Curve Fit

You can perform nonlinear curve fitting using one of many built-in fitting functions, or you can create a user-defined fitting function. OriginPro supports implicit function fitting, surface fitting, and fit comparison. Some tools are available only in OriginPro.
The table below summarizes available nonlinear curve fitting tools:

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Features</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Fit Gadget</td>
<td>• Fit a region of interest in a graph interactively</td>
<td>Gadgets:Quick Fit (graph)</td>
</tr>
<tr>
<td></td>
<td>• Fit with built-in or user-defined fitting functions</td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>• Fit one or multiple datasets</td>
<td>Gadgets:Quick Sigmoidal Fit (graph)</td>
</tr>
<tr>
<td></td>
<td>• Choose from a number of pre-defined analyses (incl. Linear, Cubic,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Peak and Sigmoidal).</td>
<td></td>
</tr>
<tr>
<td>Nonlinear Curve Fitting</td>
<td>• Fit with built-in or user-defined fitting functions</td>
<td>Analysis:Fitting:Nonlinear Curve Fit (workbook,</td>
</tr>
<tr>
<td></td>
<td>• Fit one or multiple datasets</td>
<td>graph)</td>
</tr>
<tr>
<td></td>
<td>• Compare fit, multiple parameter sets</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Global fit with parameter sharing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Global fit, parameter sharing with multiple functions (Pro Only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Fit with replicas</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Advanced options including bounds, constraints, fit control</td>
<td></td>
</tr>
<tr>
<td>Implicit Curve Fitting (Pro Only)</td>
<td>• Fit with implicit functions</td>
<td>Analysis:Fitting:Nonlinear Implicit Curve Fit</td>
</tr>
<tr>
<td></td>
<td>• Orthogonal Distance Regression (ODR) algorithm</td>
<td>(workbook, graph)</td>
</tr>
<tr>
<td>Surface Fit (Pro Only)</td>
<td>• Fit data from a matrix or worksheet XYZ columns</td>
<td>Analysis:Fitting:Nonlinear Surface Fit (workbook,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>graph)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis:Nonlinear Matrix Fit (matrix)</td>
</tr>
<tr>
<td>Fitting Function Builder</td>
<td>• Create or edit user-defined fitting functions</td>
<td>Tools:Fitting Function Builder</td>
</tr>
</tbody>
</table>
# Data Analysis

## 15.7 Peak Analysis

Origin provides several tools for peak analysis. With these tools, you can define and subtract baselines, find peaks, integrate peaks, and fit peaks. Some tools are available only in OriginPro.

The table below summarizes various tools available for peak analysis:

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Features</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Quick Peaks Gadget</td>
<td>• Perform peak analysis over a region of interest</td>
<td>Gadget:Quick Peaks (graph)</td>
</tr>
<tr>
<td></td>
<td>• Create baseline</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Subtract baseline</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Find peaks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Integrate peaks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Fit peaks</td>
<td></td>
</tr>
<tr>
<td>Tool Name</td>
<td>Features</td>
<td>Menu Entry</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| • Multiple Peak Fit           | • Pick multiple peaks  
• Fit peaks                                  | Analysis:Peaks and Baseline:Multiple Peak Fit (graph, workbook)             |
| • Peak Analyzer               | • Create baseline  
• Subtract baseline  
• Find peaks  
• Integrate peaks  
• Fit multi-peak datasets (Pro Only)  
• Fit baseline (Pro Only)  
• Find hidden peaks  
• Compute many peak characteristics (Pro Only) | Analysis:Peaks and Baseline:Peak Analyzer (graph, workbook)                     |
| • Batch Peak Analysis         | • Use a theme file created using Peak Analyzer tool  
• Perform batch peak analysis on multiple datasets                        | Analysis:Peaks and Baseline:Batch Peak Analysis Using Theme (graph, workbook) |

**15.8 Signal Processing**

Origin provides signal processing tools for many tasks, including producing signal transforms, smoothing/filtering, and correlation on 1D and 2D signals. Advanced tools are available in OriginPro.

You may refer to the tables below for the signal processing tools and their menu entry.

**15.8.1 Signal Transforms**

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• FFT Gadget</td>
<td>Gadgets:FFT... (graph)</td>
</tr>
<tr>
<td>• Fast Fourier Transform (FFT)</td>
<td>Analysis:Signal Processing:FFT (workbook, graph)</td>
</tr>
</tbody>
</table>
## Data Analysis

### 15.8.2 Filtering

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• FFT Filter</td>
<td>Analysis:Signal Processing:FFT Filters (workbook, graph)</td>
</tr>
<tr>
<td>• 2D FFT Filter (Pro Only)</td>
<td>Analysis:Signal Processing:2D FFT Filters (matrix)</td>
</tr>
<tr>
<td>• IIR Filter Design (Pro Only)</td>
<td>Analysis:Signal Processing:IIR Filter (workbook, graph)</td>
</tr>
</tbody>
</table>

### 15.8.3 Smoothing

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Smooth</td>
<td>Analysis:Signal Processing:Smooth (workbook, graph, matrix)</td>
</tr>
</tbody>
</table>
15.8.4 Correlation

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correlation</td>
<td>Analysis:Signal Processing:Correlation (workbook, graph)</td>
</tr>
<tr>
<td>2D Correlation (Pro Only)</td>
<td>Analysis:Signal Processing:2D Correlation (matrix)</td>
</tr>
</tbody>
</table>

15.8.5 Convolution

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convolution</td>
<td>Analysis:Signal Processing:Convolution (workbook, graph)</td>
</tr>
</tbody>
</table>

15.8.6 Wavelet Analysis (Pro Only)

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous Wavelet Transform</td>
<td>Analysis:Signal Processing:Wavelet Analysis (workbook, graph)</td>
</tr>
<tr>
<td>Discrete Wavelet Transform (Decomposition)</td>
<td></td>
</tr>
<tr>
<td>Inverse Discrete Wavelet Transform (Reconstruction)</td>
<td></td>
</tr>
<tr>
<td>Multi-Scale Wavelet Decomposition</td>
<td></td>
</tr>
<tr>
<td>Smoothing</td>
<td></td>
</tr>
<tr>
<td>Noise Removal</td>
<td></td>
</tr>
<tr>
<td>2D Wavelet Decomposition</td>
<td>Analysis:Signal Processing:Wavelet Analysis (matrix)</td>
</tr>
<tr>
<td>2D Wavelet Reconstruction</td>
<td></td>
</tr>
</tbody>
</table>
15.8.7 Other Advanced Tools (Pro Only)

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rise Time Gadget</td>
<td>Gadget:Rise Time (graph)</td>
</tr>
<tr>
<td>Decimation</td>
<td>Analysis:Signal Processing:Decimation (workbook, graph)</td>
</tr>
<tr>
<td>Coherence</td>
<td>Analysis:Signal Processing:Coherence (workbook, graph)</td>
</tr>
<tr>
<td>Envelope Curves</td>
<td>Analysis:Signal Processing:Envelope (workbook, graph)</td>
</tr>
</tbody>
</table>

15.9 Image Processing

Origin provides a collection of tools for basic image processing. These tools are accessible from the Image menu when a matrix book is active. The tools are organized in the following sub-menus:

- Image:Adjustments
- Image:Arithmetic Transforms
- Image:Conversion
- Image:Geometric Transforms
- Image: Spatial Filters

15.10 Topics for Further Reading

- Analysis Dialog Boxes: Specifying Your Input Data
- Outputting Analysis Results
- Recalculation of Analysis Results
- Generating Analysis Report Sheets
- Performing Math Operations on Datasets
- Linear/Polynomial Regression
- Nonlinear Curve Fitting
- Peak Analysis using Origin
- Signal Processing
- Image Processing and Analysis
16 Statistics

16.1 Basic Statistics

Origin provides several tools and methods to compute basic statistics on data from either the worksheet or from a graph.

Origin 2016 introduced add-on tools called Apps. Since being introduced, many new exploratory and analysis-related tools have been added to OriginLab’s File Exchange and more tools are being released all the time. To see what is available, point to the Add Apps button in the Apps Gallery to the right-side of your workspace and double-click. In the App Center dialog that opens, you will find New and Popular Apps. In this dialog, you can download new Apps or update existing Apps.

16.1.1 Basic Statistics on Worksheet

<table>
<thead>
<tr>
<th>Descriptive Statistics</th>
<th>Menu entry with worksheet active</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Statistics on Columns</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
<tr>
<td>• Statistics on Rows</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
<tr>
<td>• Cross Tabulation and Chi-Square (Pro Only)</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
<tr>
<td>Frequencies/Counts</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
<tr>
<td>• Frequency Counts</td>
<td></td>
</tr>
<tr>
<td>• 2D Frequency Counts/Binning</td>
<td></td>
</tr>
<tr>
<td>• Discrete Frequency</td>
<td></td>
</tr>
<tr>
<td>Distribution</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
<tr>
<td>• Normality Test</td>
<td></td>
</tr>
<tr>
<td>• Distribution Fit (Pro Only)</td>
<td></td>
</tr>
<tr>
<td>Relationship</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
<tr>
<td>• Correlation Coefficient (Pro Only)</td>
<td></td>
</tr>
<tr>
<td>• Partial Correlation Coefficient (Pro Only)</td>
<td></td>
</tr>
</tbody>
</table>
### Detecting Outliers

- Grubbs Test
- Dixon’s Q-test

#### 16.1.2 Descriptive Statistics on Graph

Origin provides a couple of gadgets to explore and summarize data plotted in graphs.

<table>
<thead>
<tr>
<th>Descriptive Statistics</th>
<th>Menu entry with graph active</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Cluster Gadget (Pro Only)</td>
<td>Gadgets:Cluster...</td>
</tr>
<tr>
<td>• Statistics Gadget</td>
<td>Gadgets:Statistics...</td>
</tr>
</tbody>
</table>

#### 16.1.3 Statistics on Selected Range

Origin provides some quick ways to obtain basic statistics on a selected range of worksheet cells, or data plot(s) in a graph.

**16.1.3.1 Status Bar**

Select a range of cells in a worksheet. Note that the selection can include cells from one or more columns, and you can use the CTRL key to select non-contiguous groups of cells.

Basic statistics (average, sum, count, min, max) for your selected data will be displayed in the status bar. Right click on the status bar to customize what quantities to display.
16.1.3.2 Command or Script Window

Statistics, Report to Script/Command Window

1. Select a range of cells in a worksheet, or click and select a group of data plots or an individual data plot in a graph.
2. Open the Command Window or the Script Window from the Windows menu, and type one of these commands, then press ENTER:

Stats

moments

quantiles

With the Command Window, the results are typed out below the command line. With the Script Window, you will need to issue an additional command to return your results:

stats;

stats.=;
Note: For more information, please refer to the:
Help: X-Function > X-Function Reference > Statistics

16.2 Statistical Graphs

Origin provides numerous statistical graph types. All graphs can be easily customized and saved as a template for repeat use. View the Graphing and Customizing Graphs chapters of this guide for more information.

<table>
<thead>
<tr>
<th>Graph Type</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Box Charts</strong>: Box, Interval Plot, Marginal Box Charts, Bar Charts, Box Overlap, Box Normal, Bar Overlap, Bar Normal, Scatter Interval, Double-Y Box.</td>
<td>Plot &gt; 2D: Box...</td>
</tr>
<tr>
<td></td>
<td>Double-Y Box now available.</td>
</tr>
<tr>
<td><strong>Box Charts, Grouped</strong>: Grouped Box Charts - Indexed Data, Grouped Box Charts - Raw Data.</td>
<td>Plot &gt; 2D: Group Plot...</td>
</tr>
<tr>
<td><strong>Histograms</strong>: Histogram, Histogram + Probabilities, Stacked Histograms, Marginal Histograms, Histogram + Distribution, Histogram + Label.</td>
<td>Plot &gt; 2D: Histogram...</td>
</tr>
<tr>
<td><strong>2D Kernel Density</strong></td>
<td>Plot &gt; 2D: 2D Kernel Density</td>
</tr>
<tr>
<td><strong>Probability</strong>: Probability Plot, Q-Q Plot.</td>
<td>Plot &gt; 2D: Probability...</td>
</tr>
<tr>
<td><strong>Pareto</strong>: Pareto Chart - Binned Data, Pareto Chart - Raw Data.</td>
<td>Plot &gt; 2D: Pareto...</td>
</tr>
<tr>
<td><strong>Scatter Matrix</strong></td>
<td>Plot &gt; 2D: Scatter Matrix</td>
</tr>
<tr>
<td><strong>QC (X-bar R) Chart</strong></td>
<td>Plot &gt; 2D: QC (X-bar R Chart)</td>
</tr>
<tr>
<td><strong>Trellis Plot</strong></td>
<td>Plot &gt; 2D: Trellis</td>
</tr>
</tbody>
</table>

The following statistical graphs are only available within the Plots branch of the statistical analysis dialogs.
<table>
<thead>
<tr>
<th>Graph Type</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Means Plot</td>
<td><strong>Statistics: ANOVA: One-Way ANOVA, Two-Way ANOVA</strong></td>
</tr>
<tr>
<td>• Means Comparison Plot</td>
<td><strong>Statistics: ANOVA: One-Way Repeated Measure ANOVA (Pro Only)</strong></td>
</tr>
<tr>
<td>• Survival Curve</td>
<td><strong>Statistics: Survival Analysis: Kaplan-Meier Estimator (Pro Only)</strong></td>
</tr>
<tr>
<td>• One Minus Survival Curve</td>
<td></td>
</tr>
<tr>
<td>• Hazard Curve</td>
<td></td>
</tr>
<tr>
<td>• Log Survival Curve</td>
<td></td>
</tr>
<tr>
<td>• Scree Plot</td>
<td><strong>Statistics: Multivariate Analysis: Principal Component Analysis (Pro Only)</strong></td>
</tr>
<tr>
<td>• Component Plot</td>
<td></td>
</tr>
<tr>
<td>• Dendrogram</td>
<td><strong>Statistics: Multivariate Analysis: Hierarchical Cluster Analysis (Pro Only)</strong></td>
</tr>
<tr>
<td>• Classification Summary Plot</td>
<td></td>
</tr>
<tr>
<td>• Classification Fit Plot</td>
<td><strong>Statistics: Multivariate Analysis: Discriminant Analysis (Pro Only)</strong></td>
</tr>
<tr>
<td>• Canonical Score Plot</td>
<td></td>
</tr>
<tr>
<td>• ROC Curve</td>
<td><strong>Statistics: ROC Curve (Pro Only)</strong></td>
</tr>
</tbody>
</table>
### 16.3 Comparing One, Two or More Groups

Origin provides parametric and non-parametric tests to compare one, two, three or more groups.

#### 16.3.1 Parametric Hypothesis Tests

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>- One-Sample t-Test</td>
<td>Statistics: Hypothesis Testing</td>
</tr>
<tr>
<td>- Two-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>- Pair-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>- One-Sample Test for Variance (Pro Only)</td>
<td></td>
</tr>
<tr>
<td>- Two-Sample Test for Variance (Pro Only)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>- One-Sample Proportion Test (Pro Only)</td>
<td>Statistics: Hypothesis Testing</td>
</tr>
<tr>
<td>- Two-Sample Proportion Test (Pro Only)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Two-Sample t-Test on Rows (Pro Only)</td>
<td>Statistics: Hypothesis Testing</td>
</tr>
<tr>
<td>- Pair-Sample t-Test on Rows (Pro Only)</td>
<td></td>
</tr>
</tbody>
</table>

#### 16.3.2 ANOVA

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>- One-Way ANOVA</td>
<td>Statistics: ANOVA</td>
</tr>
<tr>
<td>- Two-Way ANOVA</td>
<td></td>
</tr>
<tr>
<td>- Three-Way ANOVA</td>
<td></td>
</tr>
<tr>
<td>- One-Way Repeated-Measures ANOVA (Pro Only)</td>
<td></td>
</tr>
<tr>
<td>- Two-Way Repeated-Measures ANOVA (Pro Only)</td>
<td></td>
</tr>
</tbody>
</table>

(Supports both Balanced and Unbalanced data)
### 16.3.3 Non-parametric Tests *(Pro Only)*

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• One-Sample Wilcoxon Signed Rank Test</td>
<td>Statistics:Nonparametric Tests</td>
</tr>
<tr>
<td>• Paired-Sample Wilcoxon Signed Rank Test</td>
<td></td>
</tr>
<tr>
<td>• Paired-Sample Sign Test</td>
<td></td>
</tr>
<tr>
<td>• Mann-Whitney Test</td>
<td></td>
</tr>
<tr>
<td>• Two-Sample Kolmogorov-Smirnov Test</td>
<td></td>
</tr>
<tr>
<td>• Kruskal-Wallis ANOVA</td>
<td></td>
</tr>
<tr>
<td>• Moods Median Test</td>
<td></td>
</tr>
<tr>
<td>• Friedman ANOVA</td>
<td></td>
</tr>
</tbody>
</table>

**Notes:**

Multiple nonparametric tests can be run simultaneously. (Accessible from the Statistics:Nonparametric Tests menu) Available options are:

- **(NPH) K Independent Samples**: Kruskal-Wallis ANOVA and Mood's Median Test
- **(NPH) Paired Samples**: Paired-Sample Wilcoxon Signed Rank Test and Paired-Sample Sign Test
- **(NPH) Two Independent Samples**: Mann-Whitney Test and Two-Sample Kolmogorov-Smirnov Test
16.4 Advanced Statistics

Several additional tools are available in **OriginPro**.

### 16.4.1 Multivariate Analysis (Pro Only)

Origin offers several multivariate analysis methods to help you simplify, classify, or make predictions from your data.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Principal Component Analysis</td>
<td></td>
</tr>
<tr>
<td>• K-Means Cluster</td>
<td></td>
</tr>
<tr>
<td>• Hierarchical Cluster</td>
<td></td>
</tr>
<tr>
<td>• Discriminant Analysis</td>
<td></td>
</tr>
<tr>
<td>• Canonical Discriminant Analysis</td>
<td></td>
</tr>
<tr>
<td>• Partial Least Squares</td>
<td><strong>Statistics: Multivariate Analysis</strong></td>
</tr>
</tbody>
</table>

**Notes:** Canonical Discriminant Analysis is integrated with Discriminant Analysis. It is accessible from the **Statistics: Multivariate Analysis: Discriminant Analysis: Canonical Discriminant Analysis(System)** menu.

### 16.4.2 Survival Analysis (Pro Only)

**OriginPro** includes widely used survival tests to quantify survivorship in a population.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Kaplan-Meier Product-limit Estimator</td>
<td></td>
</tr>
<tr>
<td>• Comparing Survival Curves</td>
<td></td>
</tr>
<tr>
<td>• Cox Proportional Hazards Model</td>
<td></td>
</tr>
<tr>
<td>• Weibull Fit Model</td>
<td><strong>Statistics: Survival Analysis</strong></td>
</tr>
</tbody>
</table>

**Notes:** Comparing Survival Curves is accessible in the **Kaplan-Meier Product-limit Estimator** feature.
16.4.3 Power and Sample Size (Pro Only)

Statistics, Power and Sample Size Origin provides eight types of power and sample size analysis, useful in designing experiments. Origin can compute the power of the experiment for a given sample size and can also compute the required sample size for given power values.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>One-Proportion Test</td>
<td></td>
</tr>
<tr>
<td>Two-Proportion Test</td>
<td></td>
</tr>
<tr>
<td>One-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>Two-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>Paired-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>One-Variance Test</td>
<td></td>
</tr>
<tr>
<td>Two-Variance Test</td>
<td></td>
</tr>
<tr>
<td>One-Way ANOVA</td>
<td>Statistics: Power and Sample Size</td>
</tr>
</tbody>
</table>

16.4.4 ROC Curve (Pro Only)

ROC Curve analysis is useful in determining if an incident has occurred, or in comparing the accuracy of two methods that are used to discriminate between diseased and healthy cases.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROC Curve</td>
<td>Statistics: ROC Curve</td>
</tr>
</tbody>
</table>

16.5 Topics for Further Reading

- Statistics on Worksheet Columns
- Statistics on Worksheet Rows
- Descriptive Statistics
- Statistics Charts, General
- Appendix: Statistical Graph Types by Template
- Normality Testing
- Distribution Fit
- Parametric Hypothesis Testing
- ANOVA
- Nonparametric Tests
- Multivariate Analysis
- Survival Analysis
• ROC Curves
• Power and Sample Size Tests
• LabTalk Supported X-Functions: Statistics
17 How to Handle Repetitive Tasks

17.1 Recalculation

All Analysis and most data processing dialog boxes in Origin include a Recalculate control. This control allows you to tie the output of the operation to the source data such that any changes to the source data can trigger an update of the output. This allows you to analyze multiple datasets by, for instance, serial import of a new data file to replace existing data. This feature is also the basis for creating Analysis Templates. The Analysis Template concept is explained below.

Three options are available for the Recalculate control:

<table>
<thead>
<tr>
<th>None</th>
<th>Auto</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>• No lock is displayed in the output.</td>
<td>• An auto green lock is displayed in the output columns and graphs that contain plots of the output data.</td>
</tr>
<tr>
<td>• Changes to the input data will not result in an update of the output.</td>
<td>• The output will be automatically updated when input data is changed.</td>
</tr>
<tr>
<td></td>
<td>• You can also recall the dialog to make changes to the analysis settings.</td>
</tr>
</tbody>
</table>
A manual green lock is displayed in output columns and graphs that contain plots of the output data.

- The lock will turn yellow in color when input data is changed. You can manually trigger an update for each operation, or for all such pending operations in the project.
- You can also recall the dialog to make changes to the analysis settings.

A left-click on the lock displays a menu that provides multiple options including changing analysis parameters, opening source data sheet, switching to result sheets, and controlling the status of the operation such as switching from manual update to auto update.

### 17.2 Dialog Themes

Settings in analysis dialogs and most other data processing dialogs can be saved as a Dialog Theme file. Once saved, these Theme files containing your custom settings can be recalled as needed. Multiple theme files can be saved from a dialog, allowing for easy repeat analysis of datasets that may each require different settings.

Last used dialog box settings are automatically saved as a `<last used>` Theme. Origin also allows you to save your custom settings as the `<default>` Theme. The default Theme, last used Theme, and any named Theme that you have saved, can all be accessed from the theme fly-out menu that opens from the dialog box. The same Themes are also available from the main menu item associated with the analysis dialog box.

Dialog Themes are managed with the Theme Organizer tool, available from the Tools menu.
Tutorial: Saving and Re-using a Dialog Theme

1. Import the file Linear Fit.dat from the Samples\Curve Fitting\ subfolder.
2. Highlight column B and select Analysis: Fitting: Linear Fit...
3. In the Linear Fit dialog that opens, check the Fix Intercept checkbox (under Fit Options) and set the Fix Intercept at edit box to 0.
4. Click the button next to the Dialog Theme control and select Save as .... In the Theme Name box, enter Zero Intercept and press OK. Press OK again to close the Linear Fit dialog box and perform the analysis. FitLinear1 and FitLinearCurve1 result sheets are added to the workbook.
5. Return to the source data and highlight column C. Select Analysis: Fitting: Linear Fit from the menu. You will see a fly-out menu with multiple Theme options including the Zero Intercept Theme you saved in the previous step.
6. Select your saved Theme. The analysis is automatically performed on Column C using the settings saved in the Theme. Note that the dialog box does not open.

- Hold the SHIFT key while clicking on your Theme in the main menu and the associated dialog box will open with settings from the selected Theme loaded into the dialog box.
- The default Theme Origin shipped for an analysis is called System Default. Click the fly-out menu in the analysis dialog and choose System Default to load it.
- Click the fly-out menu in the analysis dialog and choose Delete to delete Themes you have created, including any customized <default> Theme.
- The customized <default> Themes for all analysis dialogs are saved in Defaults.xml in the User Files Folder. Deleting this file restores system default settings of all analysis dialogs.

17.3 Project and Workbook Templates

17.3.1 The Project as Template

The Origin project file can be used as a template for carrying out repetitive graphing and analysis tasks. Create the desired graphs and/or analysis results from data in your workbook(s) and save the project. You then simply replace the workbook data, to automatically update graphs and results. When saving the project, you have the following options:

1. Use the File: Save Project without Data menu item. This will clear all data before saving the project.
2. Use the File: Duplicate Project without Data menu item. This will create a copy of the existing project where all the data will be cleared before saving.
You can, of course, save the current project with data but the above two options may prove useful when working with very large datasets as they will reduce project file size.

17.3.2 The Workbook as Template

You can save a workbook as a template for repetitive graphing and/or analysis tasks. The workbook can contain worksheets with data, floating or embedded graphs and notes windows.

If the workbook contains analysis operations, the **File: Save Workbook as Analysis Template...** menu command can be used to save the workbook. All data columns that are used in the analysis operations in the workbook will be cleared before saving. Data that are not associated with analysis operations will not be cleared. Workbooks saved in this manner can be accessed quickly from **File: Recent Books** on the main menu.

**Tutorial: Creating an Analysis Template**

1. Start with a new workbook and import the file `Samples\Curve Fitting\Sensor01.dat`.
2. Select column B and use the **Analysis: Fitting: Linear Fit** and open the **Linear Fit** dialog.
3. Change the **Recalculate** drop-down to **Auto**.
4. Click the **Fit Control** tab, check the **Fix Intercept** check box and enter **0** in the **Fix Intercept at** edit box.
5. Click **OK** to close the dialog and perform the linear regression.
6. Answer "Yes" to the prompt and switch to the **Fit Linear1** report sheet to view results including plots of the best-fit line and residuals.
7. Now switch back to the original data sheet and import the file `Samples\Curve Fitting\Sensor02.dat`. The analysis results will be automatically updated with this new data. Note that you could continue to use this workbook for importing other data; or you could right-click the workbook window title and choose **Duplicate without Data** to create a new workbook with the linear fitting operation saved into it. This allows you to import new data into the new workbook and thus save a project with multiple such workbooks, if desired.
8. With the workbook active, select the menu **File: Save Workbook as Analysis Template...**, and in the dialog that opens, give a name such as **Linear Fit of Sensor Data** and click **Save**.
9. Choose **File: Recent Books** and select the template that was saved in the previous step. The workbook will open and the data sheet will be empty.
10. Import the file `Samples\Curve Fitting\Sensor3.dat` into the empty data sheet (1st sheet). The analysis results will be automatically generated upon data import.

The workbook template (Analysis Template) can even contain custom report sheets and a summary sheet. Thus, you can create an individual report for each file. The advantage of saving the workbook as an Analysis Template is that the **Batch Processing tool** can use the template to process multiple files or datasets and create a final summary report for all files that are processed as part of the batch analysis. View the **Batch Plotting** and **Batch Analysis** sections of this chapter for examples of using the workbook as a template when handling repetitive tasks.
17.4 Batch Plotting

Origin provides several methods for batch plotting of graphs from multiple datasets or files. The following two sections outline how to create multiple graphs from (1) data that is already in worksheets, or (2) multiple data files. In addition to these two procedures, batch plotting can also be performed programmatically using LabTalk script or Origin C.

17.4.1 Duplicating Graphs with Data from Other Books/Sheets/Columns

If you have several workbooks, worksheets or columns with similar data structure as you the data used to plot the graph, you can have Origin clone that graph via Window: Duplicate (Batch Plotting) menu with new data. There are two cases:

- If you have plotted a graph with a single dataset and customized it, and want to clone the graph with other data in the same worksheet: Choose Window: Duplicate (Batch Plotting): Duplicate with New Columns. Pick other data (columns) that you want to plot. Each column will be plotted as a new graph.
- If you have plotted a graph with data in one worksheet or workbook and customized the graph, and you want to clone the graph with other worksheets or workbooks with a similar data structure: Choose Window: Duplicate (Batch Plotting): Duplicate with New Sheets/Duplicate with New Books. Origin will list all worksheets or workbooks with a similar data structure. Pick the worksheet or workbook you want to plot from. Each worksheet or workbook will be plotted as a new graph.

Tutorial: Duplicating a graph with data from other books/sheets

1. Press the New Project button on the Standard toolbar.
2. Press the Import Wizard button on the same toolbar. This opens the Import Wizard dialog box.
3. Click the browse button to the right of the File box. Browse to the Import and Export folder and select the files S15-125-03.dat, S21-235-07.dat, and S32-014-04.dat. Click Add File(s), then press OK. In the Import Wizard dialog box, press Finish. The files are imported into three separate workbooks.
4. Drag and select all three Y columns in one of the workbooks, then select the menu item Plot>2D: Multi-Y: 3Ys Y-YY to create a graph with multiple Y axes and one shared X axis. Make any desired customizations to the graph.
5. Right-click on the title bar of the graph window then select Duplicate (Batch Plotting) shortcut menu.
6. In the dialog box that opens, press Ctrl and select the other two workbooks/worksheets then press OK. Two more graphs are created with data from the other two workbooks/worksheets.
17.4.2 The Workbook as a Template for Processing Multiple Files

If you want to plot graphs from many data files but don't want to import all files to workbooks before plotting, you can import one file, create the desired graph(s) based on that data, then add the graph(s) to your workbook and save the workbook as a template. Using this template you can process multiple files, creating a workbook for each file and its corresponding graph.

**Tutorial: Creating graphs from multiple data files**

1. With a new workbook active, choose File: Import Single ASCII and import the file Sensor01.dat from the Samples\Curve Fitting subfolder of the Origin installation folder.
2. Highlight column B and create a line+symbol graph of the data.
3. Double click on the X axis to open the Axis dialog. Make sure Scale tab is active. Select both Horizontal and Vertical on the left panel and set Rescale to be Auto and click OK. This will ensure that the graph scale will update automatically on data change.
4. In the workbook, right-click on the worksheet tab and select Add Graph as Sheet, then select the graph created above and click Done. This will add a new workbook sheet containing an embedded graph.
5. Switch to the data sheet, double-click on the tab rename the sheet as Data.
6. Select the Worksheet: Clear Worksheet menu item to clear the data in this sheet. Note that this step is optional. Clearing the data will reduce the size of the template saved in the next step.
7. Select the File: Save Window As... menu item, assign a name such as Sensor Data and Graph and press Save.
8. Now we can use this template to process multiple files. Select the File: Batch Processing... menu item.
9. In the dialog box that opens set the Batch Processing Mode to Load Analysis Template, then set the Analysis Template control to point to your saved template.
10. Set Data Source to Import from Files and select the three files Sensor01.dat, Sensor02.dat, and Sensor03.dat from the Samples\Curve Fitting subfolder.
11. Set the Data Sheet(s) to Data and set Result Sheet to <none>.
12. Press OK to close the dialog box. You should get three workbooks with the data imported into the first sheet and the graphs updated in the 2nd sheet. To further edit any of the graphs, double-click on the graph to pop up an editable page.

If processing of your data requires some custom import settings, you can save those settings to the data sheet from the Import dialog box (Save to <Sheet>, available from the Dialog Theme menu). Settings thus saved to the sheet will be used for import when batch processing of multiple files using the workbook as a template.
17.5 Batch Analysis

Origin provides several ways to perform batch analysis of multiple files, data columns, or data plots.

17.5.1 Analyzing Multiple Datasets in Dialogs

Some analysis dialog boxes, for instance Linear Fit and Nonlinear Fit, support analysis of multiple datasets. Report sheets created by these dialog boxes include a summary table listing the parameter values for each dataset and other pertinent results such as goodness-of-fit indicators. The summary table can be copied to an external sheet for further processing.

Tutorial: Fitting Multiple Datasets

1. Open a new workbook and import the file Samples\Curve Fitting\Multiple Gaussians.dat from the Origin installation folder.
2. Set the Long Names of the four Y columns as Peak 1, Peak 2, Peak 3 and Peak 4.
3. Select all four Y columns, and use the Analysis: Fitting: Nonlinear Curve Fit... menu item to open the NLFit dialog box.
4. Select Gauss from the Function drop-down list, then press the Fit button to perform fitting and close the dialog box.
5. Switch to the FitNL1 report sheet. You will see a table named Summary which lists the fit parameters and fit statistics for each dataset.

<table>
<thead>
<tr>
<th>Summary</th>
<th>( y_0 )</th>
<th>( x_c )</th>
<th>( w )</th>
<th>( A )</th>
<th>( \sigma )</th>
<th>FWHM</th>
<th>Height</th>
<th>Statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Value</td>
<td>Error</td>
<td>Value</td>
<td>Error</td>
<td>Value</td>
<td>Error</td>
<td>Value</td>
<td></td>
</tr>
<tr>
<td>Peak 1</td>
<td>1.913</td>
<td>0.145</td>
<td>24.808</td>
<td>0.347</td>
<td>13.734</td>
<td>0.643</td>
<td>115.121</td>
<td>6.853</td>
</tr>
<tr>
<td>Peak 2</td>
<td>4.954</td>
<td>0.078</td>
<td>20.046</td>
<td>0.144</td>
<td>6.021</td>
<td>0.325</td>
<td>49.182</td>
<td>1.928</td>
</tr>
<tr>
<td>Peak 3</td>
<td>0.117</td>
<td>0.016</td>
<td>24.973</td>
<td>0.242</td>
<td>12.393</td>
<td>0.620</td>
<td>11.116</td>
<td>0.643</td>
</tr>
<tr>
<td>Peak 4</td>
<td>-2.033</td>
<td>0.048</td>
<td>20.015</td>
<td>0.053</td>
<td>4.611</td>
<td>0.112</td>
<td>-51.452</td>
<td>1.188</td>
</tr>
</tbody>
</table>

In the NLFit report sheet, click on the downward-pointing arrow button next to the table named Summary and select Create Copy as New Sheet. This will create a copy of the table in which all cells are linked to the report. Any updates/changes to the fit will automatically update the values in this copied sheet. This sheet can then be used to plot or to perform secondary analysis on the fit parameters.

When enumerating something like a column Long Name, as you did in step 2 above, enter the string in the first cell (e.g. "Peak 1"), select the cell and hover over the lower-right corner. When the cursor becomes a "+", drag across the other cells and the contents of the first cell will be extended to those cells.
17.5.2 Using Gadgets for Analyzing Multiple Curves

Origin includes several gadgets for performing interactive analysis on plotted data. Gadgets allow selecting a data range of interest, switching from one dataset to another, and setting various preferences specific to the analysis being carried out.

Most gadgets offer an option to perform the analysis on all data plots in the current layer, or all data plots in the graph page. This allows for performing repetitive analysis on multiple datasets using the same settings, and generating a table of results across all datasets.

Tutorial: Using the Integrate Gadget to Integrate Multiple Curves

1. Open the project "Samples\Spectroscopy\Absorbance Spectra.opj".
2. With the graph window active, choose Gadgets: Integrate from the main menu.
3. In the dialog that opens, click the Baseline tab and set the Mode drop-down to Straight Line.
4. Click the Output tab, expand the Output Quantities to node, and check Append to Worksheet. Press OK to close the dialog box.
5. A region of interest (ROI) object is placed on the graph. If necessary, click on the ROI and resize this object to cover the entire data range plotted in the graph. The integrated area will be displayed as a shaded region.
6. Click the arrow button at the top right of the ROI object, then choose Change Data from the context menu and switch to another plot in the layer. Check that the current baseline setting works for other curves in the layer.
7. Click the arrow button, select New Output for All Curves (N) or simply press the "N" key. Integration is performed on all curves.
8. Click the arrow button again and select Go to Report Worksheet. Expand the report worksheet to view the integration results from all curves.
Batch Analysis Using an Analysis Template

The Batch Processing tool allows you to process multiple files or datasets using an Analysis Template. Simply perform the analysis on one of the files, include all desired results and report sheets in one workbook, and save that workbook as an Analysis Template. The Batch Processing tool then uses the Analysis Template to process multiple files/datasets. You have the option to retain one workbook for each file/dataset, and additionally, to create a summary table with select analysis parameters and other metadata that you have pre-configured in your analysis template.

Tutorial: Batch Analysis of Multiple Files using an Analysis Template

1. From the main menu, choose File: Batch Processing.... This opens the Batch Processing dialog box.
2. Set Batch Processing Mode to Load Analysis Template.
3. Press the browse button to the right of the Analysis Template box and select the file Sensor Analysis.OGW located in the Samples\Batch Processing subfolder under your Origin installation folder. This Analysis Template contains multiple sheets set up for linear regression analysis, reporting, and summary tables.
4. Set Data Source to Import From Files, then click the browse button to the right of the File List and from the Samples\Curve Fitting subfolder under your Origin installation folder, select files Sensor01.dat, Sensor02.dat and Sensor03.dat.

5. Set Dataset Identifier to File Name, Data Sheet to Data, and Result Sheet to Result, thus selecting the appropriate sheets in the Template.


7. Click OK to close the dialog box and process the three files (you can answer "No" to the prompt). You will obtain three books with the data, analysis results, and report for each file, and a fourth book containing the summary table of analysis results from all files.

Saving the initial workbook as an Analysis Template is optional. You can simply save the Origin project (.opj) and next time replace the data in your workbook to update all results and graphs. The Batch Processing tool also has an option to repeatedly import files into the active window, allowing you to simply re-use an existing book within a project (which contains all desired analysis and graphs) as an on-the-fly template for the batch analysis.
You can batch generate analysis reports using a custom MS Word template, with the option of outputting a PDF file for each report. For more information, see this tutorial.

17.6 Repeating Analysis on Other Datasets or Data Plots

For some analysis operations, you can perform the analysis on one dataset or data plot and then repeat the analysis for all other data. This feature is available via a special shortcut menu entry, when you click on the lock associated with the operation.

- In worksheet columns or reports, clicking the lock will show the menu command Repeat this for All Y columns. Selecting this will repeat the analysis on all other Y columns in the source data sheet.
- In a graph, clicking the lock will show the menu command Repeat this for All Plots. Selecting this will repeat the analysis for all other data plots in the graph page, even if the plots are in different layers.

This is particularly useful for such analysis dialog boxes as smoothing or interpolation that support input of only one dataset. As long as the data are contained in one worksheet or plotted in one graph, the analysis can be repeated on all other datasets.

Tutorial: Smoothing Multiple Columns in a Worksheet

1. Import the file Samples\Curve Fitting\Multiple Gaussians.dat into an empty workbook.
2. Select column B and click Analysis: Signal Processing: Smooth to open the smooth dialog box.
3. Accept the defaults and press OK to perform smoothing. A new column will be added with the smoothed data.
4. Click on the lock in the output column and select Repeat this for All Y columns. Three more columns of smoothed data with same settings will be generated from the data in columns C thru E.

17.7 Repeating Analysis Using Data Filters

Large multi-column datasets can be quickly reduced by applying filter conditions to one or more columns. This Data Filter feature can also be used in conjunction with the colcopy (column copy) X-Function to produce multiple graphs from the same source data using different filtering conditions. The filtered data can also be analyzed, allowing you to compare graphs and analysis results across multiple filter conditions.

Selected columns from the source data sheet can be copied to create child sheets where the filter condition stays synchronized with the parent sheet, or is locked to the child sheet. When the source data sheet is updated, all child sheets, associated graphs and analysis results will automatically update using their respective filter conditions. Additionally, the filter condition of a particular child sheet can be pushed back to the parent sheet at any time.

The image below displays the source workbook with data for several makes of automobiles. Two books were created with a subset of columns and a data filter to restrict the data to a particular make of automobile. Linear regression analysis of the filtered data was performed, allowing comparison of the results across the two filters.
Tutorial: Locking a Filter Condition on Copied Columns

1. Import the file Samples\Statistics\Automobile.dat

2. Click on the Make column, then right-click and select Filter: Add or Remove Filter context menu.

3. Click on the filter icon that was added to the column, and uncheck all makes but Honda (Choose Select All to clear all and then select Honda). Click OK.

4. Hold down the CTRL key and click and select the Make, Power and Engine Displacement columns. Next, right-click and select the Copy Columns to... context menu.

5. Accept defaults in the dialog that opens, and click Ok to copy the columns. A new worksheet will be added to the workbook.

6. Click and hold the tab of the new worksheet and drag it to an empty spot in the Origin workspace to create a separate workbook.

7. Click on any of the locks in the columns of this copied sheet, and select Worksheet Filters: Lock. The filter conditions will be locked to this sheet. If you change the filter condition in the original data sheet, this copied sheet will not be affected.
8. You can now return to the original automobile book and modify the filter condition to Toyota and use Copy Columns to to create another worksheet.
9. Highlight column B in your Honda workbook, then right-click and choose Set As: X. Do the same for the Toyota book.
10. Highlight column C in your Honda workbook and click the Scatter button on the 2D Graphs toolbar. Do the same for the Toyota book. This gives you two plots of Power vs Engine Displacement, one for Honda, one for Toyota.
11. Click on the Honda graph and choose Analysis: Fitting: Linear Fit. Accept the dialog defaults and click OK. Do the same for the Toyota graph.
12. Compare the fitting results for the two automobile makes.

17.8 Automating Tasks Using Programming

In addition to the above mentioned methods for automating tasks using the interface, graphing and analysis features can also be accessed programmatically from either the LabTalk scripting language or from Origin C. Access to Graph Themes and templates, and Analysis Templates can be programmed. You can set up some of the procedure manually by first creating the templates using the graphical user interface, and then write your code to call the templates as needed.

You can get a broad look at what programming options are available in Origin by browsing the Programming Chapter of this User Guide. More in-depth programming-related information is linked to from that chapter.

17.9 Topics for Further Reading

- Recalculation of Analysis Results on Data or Parameter Change
- Saving Analysis Dialog Settings as a Theme
- The Theme Organizer, Dialog Themes
- Analysis Templates
- Batch Processing and Analysis Templates
- Copy and Paste Operations
- Using Data Filters to Obtain Different Views of Your Data
- Analysis Report Sheets and Columns
- Tutorials: Batch Processing
- Video: Batch Processing
- Tutorial: Combine Quick Peaks Gadget with Peak Analyzer
18 Publishing and Export

18.1 The Master Page

The Master Page feature is used to add one or more common objects to exported or printed graphs. Use the master page to add a set of properties and objects -- a custom background, a company logo, text labels, images, etc. -- to selected graph windows in your project.
To make use of this feature, you must first create your Master Page. The Master Page should contain only the properties and objects that you want to display on your selected graph windows:

1. From the menu, choose File: New: Master Page. If you are not in the project root folder when selecting this menu item, you will be asked to switch to the project root folder.
2. Customize the Master Template. Note that the comments that show beneath the Save Master Template button are "hidden" and will not be applied to your graph windows.
3. Click the Save Master Template button. When you save, the Master Template will be saved to the User Files Folder as "name of active window“.otpu (e.g. "C:\Users\YourName\Documents\OriginLab\User Files\Master.otpu").

**Things to know about the Master Page:**

- Master items will only show in graphs pages of the same dimensions as the template. Apply Dimension to All Graphs applies Master Template page dimensions to all graphs of the same aspect ratio.
- If you create a graph and modify page size, then choose File: New: Master Page and load a Master Template into the workspace, the Master Template will be loaded with the page dimensions of your modified graph page.
- The Rotate button swaps the Master Template page dimensions (toggles orientation between landscape and portrait).
- When you click Apply Dimension to All Graphs you are prompted to apply dimensions only to graphs of the same aspect ratio, or to all graphs of the same orientation (portrait or landscape).
- Master Page items on a graph with portrait orientation will not show on a graph with landscape orientation and vice versa.
- Edit: Copy Page normally copies an Origin graph object to the Clipboard. When the object is pasted into an MS Word document and the user subsequently double-clicks on the graph object, the graph opens in
Publishing and Export

an OLE instance of Origin, where it can be edited. When Master Items are present on the graph, Edit: Copy Page places an image object (EMF) on the Clipboard, not the usual graph object.

- **Send Graphs to PowerPoint** does not support **Insert Graphs as Embedded Object** if the graph contains Master Items (see previous bullet). **Insert Graphs as Picture** does support Master Items.
- There is a mechanism for selectively excluding Master Items in your exported or printed page. **Any object** that you do not want to appear in the exported or printed page should begin with "NoExport" (e.g. open an arrow object’s Properties dialog and on the Programming tab, rename "Arrow" to "NoExport_Arrow").
- When you customize and save your Master Page to the User Files Folder, the next time you choose **File: New: Master Page**, you load your customized template.
- If you don't want to show Master Items in the workspace, click View: Show: Master Items and remove the check mark. The exported graph will still contain the Master Items (they just won't show in the workspace).
- If you want to remove Master Items from a graph in both the workspace and exported images, click **Format: Page Properties, Display** tab and clear the Use Master Items check box.

You could use the Text tool to add project and system information to your Master Template as static text objects, but since the idea is to build a template for re-use, consider "soft-coding" information in your text labels. To learn more, see these topics:

- [Substituting Variable Values in Text Labels](#)
- [LabTalk String Registers](#)

### 18.2 The Export Margin Offsets Dialog Box

By default, the margins of your copied or exported graph are determined by the Margin Control in Copy Page Settings group of Tools: Options (Copy actions) or the Export Settings branch of Export Graphs (Export actions). Beginning with Origin 2018, you can interactively modify the default margins using the Export Margin Offsets Dialog Box.
1. Click on the graph window (to activate) and choose Edit: Export Margin Offsets. This opens the Export Margin Offsets dialog.
2. Drag the green selection handles that appear at the page margins; or enter values into the dialog edit boxes and click Apply.

18.3 Copying and Pasting Graphs to Other Applications

There are two ways you can include Origin graphs in another application’s files (e.g. Microsoft Word): as a Picture, or as an Origin Graph Object.

1. Click on your Origin graph to activate it, then ...
   - To copy the graph as a picture, choose Edit: Copy Graph as Picture.
   - To copy the graph as an editable Origin graph object, choose Edit: Copy Page.
2. In your target application choose Paste or press CTRL+V.

When you paste as a picture, the graph is inserted as an image. In MS Word, for instance, double-clicking on the image launches Word’s picture-editing tools, but this method does not allow for further graph edits in your Origin software.

When you paste as a graph object, you can later double-click on the object in the target application to launch a new instance of Origin. The graph, and any associated data sheets, will be available for editing. After editing, use Origin’s File: Exit and Return to... menu item to update the embedded object, close Origin and return to the host application.

There are several settings in the Options dialog (Tools: Options, Page tab) that determine how the graph page is copied. These settings work with the newer Export Margin Offset dialog, to determine such things as graph copied size and page margins. Please review the Copy Page Settings and the Export Margin Offset dialog box.
18.4 Organizing Your Graphs for Presentation or Export

If your Origin project file contains a large number of graphs that you plan to export or use in an Origin slide show, you can make things easier by adding shortcuts to your graphs to a Project Explorer Favorites folder and arranging them there:

- Right-click on a window and choose Add Shortcuts to Favorites. This will add a shortcut to each graph window, to a new Favorites subfolder (visible in Project Explorer).
- When sending graphs to PowerPoint or creating an Origin slideshow, you can (1) set slide order in the corresponding dialog box or (2) set slide order following this procedure.

18.5 Exporting Graphs and Layout Pages to an Image File

To export a graph or a layout page as an image file, select the menu File: Export Graphs. This will open the expGraph dialog box. The expGraph dialog offers options for customizing the output size by scaling the height or width of the page, various settings that are specific to the chosen file format, options for naming the output file, and options to perform batch exporting of multiple pages.

Origin supports 14 export file formats:

<table>
<thead>
<tr>
<th>Raster Formats</th>
<th>BMP, GIF, JPG, PCX, PNG, TGA, PSD, TIF;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vector Formats</td>
<td>CGM, DXF, EPS, EMF, PDF, WMF</td>
</tr>
</tbody>
</table>

As is the case with most Origin dialog boxes, you can save your custom settings to a Theme file for repeat use. Once you have customized your settings:

- Click the arrow to the right of Dialog Theme and choose one of the Theme save options.
- Using any group of custom settings creates a temporary default Theme called <Last used>. This Theme then becomes available for loading your last used settings and you can access it from the expGraph dialog box or from the File: Recent Exports menu item.
Note: For more information, please refer to the:

Help: Origin: Origin Help > Exporting and Publishing Graphs > Exporting Your Graph or Layout Page to an Image File

Exporting to raster formats such as TIFF and specifying a high resolution (e.g. 600 DPI or above) can produce a very large output file size, depending on the page size. To reduce the file size, consider reducing the size of the page before export. Consult with your publisher to determine the actual width of a print column in your journal.

Starting with Origin 2018b, you can export multiple graphs, such as all graphs in a folder or all graphs in a project file, to a single, multi-page PDF file. Choose File: Export Graphs and open the Export Graphs dialog box. Set Image Type to Portable Document Format (*.pdf) and Select Graph(s) to one of the following options and you will see a checkbox for Export as multi-page PDF file.

18.6 Sending Graphs to PowerPoint

You can send a batch of Origin graphs to PowerPoint as either pictures or as embedded objects (unless graphs contain Master Items as explained above). These can be further edited in your Origin software. Double-click on the graph in PowerPoint to launch an instance of Origin.
Click the Send Graphs to PowerPoint button on the Standard toolbar or right click in Project Explorer and select Send Graphs to PowerPoint... from the shortcut menu. This opens a dialog with controls for specifying how your graphs are sent to PowerPoint.

- Select multiple graphs in Project Explorer before opening the dialog, and only the selected graphs will be sent to PowerPoint by default.
- Choose the Specified option in the Select Graph(s) drop-down list to remove graphs you don't want to send, and change graph order.
- Besides showing the window name or window path as a slide title, you can also specify a custom string that incorporates metadata properties in the slide title.
- When sending graphs to an existing PowerPoint file or template, set Slide Mode as Start New to create a new slide for extra graph page, using a specified "starting slide."

### 18.7 Slide Show of Graphs

Origin has a built-in slideshow utility for viewing or presenting your graphs. The slide show can be started in two ways:

- Right-click on any folder in Project Explorer and select Slide Show of Graphs...

or

- Click the Slide Show of Graphs button on the Standard toolbar.

A dialog box opens offering options to set slide order, slide cycle time, whether to include graphs in sub folders, etc. The dialog also lists shortcut keys for use during the slide show (e.g. G = go to the actual graph window of the currently displayed slide).

**Tutorial: Slide Show of Graphs**

1. Use the File: Open Sample Projects: 2D and Contour Graphs menu to open the sample project.
2. Click on the Slide Show of Graphs button in the Standard Toolbar.
3. Accept default settings in the dialog that opens, and press OK to start the slide show.
4. You can use the up/down arrow keys or the mouse wheel to flip thru the slides.

### 18.8 Creating Movies

Origin provides a Video Builder tool, accessible from the Open Video Builder button on the Standard Toolbar. This tool can be used to manually capture a series of graph windows, and write one frame at a time to a video (.AVI) file.

Videos can be created using LabTalk script or Origin C code, by programmatically computing or updating data and then writing out the graph as a frame in the video, at each step during the computation.
18.9 Exporting Worksheets and Matrices

18.9.1 Exporting Worksheets

With a worksheet active, the **File: Export** menu item provides the following options:

- **ASCII, NI TDM (TDM, TDMS), and Sound (WAV)**
  This option is available only for sheets containing data columns, and is not available when report sheets such as those created by the Nonlinear Fitting tool are active. The exported file will contain only data from the worksheet columns. Floating or embedded graphs placed in the worksheet will be ignored.

- **As Multipage PDF File**
  This option is available only on sheets with data columns, and not for report sheets. Use the **View: Page Break Preview Lines** menu item to view the vertical and horizontal page break lines that determine which columns and rows will be included in each page of the export. Floating or embedded graphs placed in the worksheet will be included in the exported image.

- **As Image File**
  This option is available on both data and report sheets. In the dialog that opens, you can select whether to export the entire sheet, visible area, or selection. Image file formats including PDF are supported. Floating or embedded graphs placed in the worksheet will be included in the exported image.

- **As PDF File†**
  This option is available for both data and report sheets. In the dialog that opens, you can opt for exporting the entire sheet, the visible area, or a selection. Floating or embedded graphs are included in the exported PDF.

† The PDF export option was previously included with the **As Image File** menu option but was not obvious to users so starting with version 2018, it is now a separate Export menu entry.
When creating a custom report from a worksheet that combines data, numeric results and graphs, the best option is to export the entire sheet as a PDF file, or export the sheet as a multi-page PDF file.

### 18.9.2 Exporting a Matrix

Origin matrix data can be exported in these two formats:

- **ASCII**
  
  This will create an ASCII file of the data contained in the active matrix object.

- **Image**
  
  This option will export the image view of the active matrix object, as a raster file.

**Note:** For more information, please refer to the:

*Help: Origin: Origin Help > Importing and Exporting Data > Exporting Worksheets and Matrices*

### 18.10 Topics for Further Reading

- [The Tools:Options Page Settings](#)
- [Pasting or Embedding Graphs in Other Applications](#)
- [Exporting Your Graph or Layout Page to an Image File](#)
- [Which Image Format Should I Choose?](#)
- [The Export Graph Dialog Box](#)
- [Send Graphs to PowerPoint](#)
- [Send Graphs to PowerPoint Dialog Box Settings](#)
- [View Graphs as a Slide Show](#)
- [The Slide Show of Graphs Dialog Box Settings](#)
- [Creating Graph Animations](#)
- [Printing Graphs, Layout Pages and Analytical Results](#)
- [The Print Dialog Box](#)
- [The Print Options Dialog Box](#)
- [Copying and Pasting Graphs inside Origin](#)
- [Inserting Graphs and Images into Worksheet Cells](#)
- [Tutorial: Creating a Custom Report Sheet](#)
- [Using the Layout Page Window](#)
- [Creating a Master Page Layout for Graphs](#)
19 Apps for Origin

Origin 2016 introduced **Origin Apps** -- tools that you could easily add to your Origin installation by dropping them onto your Origin workspace. This ever-expanding collection of add-on tools is extending Origin's already-powerful graphing and analysis capabilities.

Because an App is a self-contained easily-distributed tool aimed at solving a particular problem, it can be developed and deployed quickly, sidestepping the need to wait for a new Origin product release. In addition, an App can be developed by anyone with a basic knowledge of programming in Origin, making it attractive as a means to create and distribute tools for your company or user-community.

As of the spring of 2018, most Apps can be downloaded for free. Note that some Apps require OriginPro; this will be denoted in the App description by the **PRO** symbol.

19.1 Where Do I Find Apps?

Apps are listed on the [OriginLab File Exchange](https://fileexchange.OriginLab.com). While you can download Apps from the File Exchange using your web browser, it easier to obtain and manage your Apps from your Origin software.

Origin 2018 introduces the **App Center**. The App Center provides "one stop" App maintenance: Browse and download new and popular Apps, search for Apps, update existing Apps, request an App or submit an App via the OriginLab website.

To open the **App Center**, click the **Add Apps** button that appears on all tabs of the Apps Gallery.

Apps will appear in the App Center with one of three icons next to them:

- Those with an **Up-to-date Version** icon ✔ beside them will be installed and up-to-date.

- Those with a clickable **Download and Install** icon 🔗 beside them are not installed. Click this icon to install.

- Those with an **Update** icon 🔃 beside them have an available update that you can install. Click this icon to update.

- **New and Popular** tab for a quick look at what’s available. Downloads and direct updates available.

- **Search** tab to find Apps by **Category** and **Minimum Version**. Downloads and direct updates available.

- **Updates** tab notifications when an App update is available. Listed
improvements and direct updates available.

19.2 How Do I Install Apps?

If you install your Apps using the Download and Install button in the App Center dialog, you don't need to do anything else. The App is automatically downloaded and installed. When App updates become available, you can use the App Center's Update button to update an installed App.

If your workstation does not have internet access...

If your workstation does not have internet access, you will need to find a computer that does, then download the App from the OriginLab File Exchange to a thumb-drive and bring it back to your workstation.

1. On the internet-connected computer, open a browser window and browse to originlab.com/fileExchange.
2. Browse the list of Apps, go to the App's description and download page, then click the Download File button and copy the file to your thumb-drive.
3. Return to your workstation, plug in your thumb-drive and run Origin. Open Windows Explorer, browse to your thumb-drive and once you locate the App (it will have a .opx file extension), drag the App file to an empty portion of the Origin workspace. Make sure you are not running Origin as administrator or drag-and-drop operations will fail. The App will be installed and the App icon will appear in the Apps Gallery, docked to the right side of your Origin workspace.

If you have questions, click the How to Install link below the Download File button on the File Exchange App description and download page.

File Exchange > DataAnalysis > Sequential Fit

Download File

How to Install

19.3 How Do I Run an App?

• Upon installation, an App icon is placed in the Apps Gallery, docked to the right side of the Origin workspace.
• App operations may be window-specific. If the App is dimmed (grayed out), the active window cannot be operated on by the App. Check the required window type (hover on the dimmed App icon in the Apps Gallery).
• If the Origin window type (worksheet, graph, etc.) is matched to the App, you can launch the App by double-clicking on it in the Apps Gallery.
• If you prefer to launch the App from a toolbar button, open the Customize (Toolbars) dialog box (View: Toolbars), click the Button Groups tab, locate the App's toolbar button and drag the button to the OriginLab workspace or to an existing toolbar. Close the dialog box.
• Specific usage information is available on the description and download page for each App.
19.4 Managing Your Apps

Use the features of the Apps Gallery to manage your Apps:

- To add or update your Apps, click the **Add Apps** button in the Apps Gallery.

  ![Add Apps]

- Organize your Apps by adding tabs to the Gallery. Right-click in an empty portion of the Gallery and choose **New Tab**, then double-click on the default tab name and give the tab a useful name.

  ![New Tab]

- App-specific actions are performed by right-clicking directly on the App icon and choosing from the shortcut menu.
• **Show in Folder**: Opens the user’s \AppData\Local\OriginLab\Apps\ folder to the App installation folder.
• **Uninstall**: Uninstalls the selected App.
• **Open the File Exchange Page**: Opens the App’s description and download page on the OriginLab File Exchange.
• **Send Feedback...**: Opens a Rate App dialog box to provide feedback.
• **Show All**: Shows Apps from all Gallery tabs on the active tab.
• **Refresh**: Refreshes the tab view.
• **Tab Views**: Place or remove the checkmark beside the App to determine on which tab(s) the App shows.

### 19.5 Will I be Notified When Updates are Available?

Several things will indicate when an App update is available:

- A red dot appears in the upper-right corner of the **Add Apps** icon in your **Apps Gallery** (docked to the right side of your workspace). Additionally, the red dot shows on individual Apps when an update is available.

- In the **App Center**, the App will appear with a clickable “update” icon beside it.
• The App Center **Updates** tab will show a red dot with a number indicating how many App updates are available. The tab will list updated Apps and allow you to apply updates for individual Apps or all Apps.

You can verify the version of an installed App by hovering on the App in your Apps Gallery.

19.6 How Do I Uninstall an App?

Uninstalling an App is easy. Right-click on the App icon in the Apps Gallery and choose **Uninstall** from the shortcut menu.
19.7 How Do I Give Feedback on an App?

OriginLab relies heavily on customer input to improve our software products. We encourage you to give feedback on Apps by right-clicking on the App icon in the Apps Gallery and choosing Send Feedback... It takes just a few seconds!

19.8 Can I Request an App?

As previously mentioned, Apps can be developed by anyone with Origin programming knowledge. However, if you do not program but you find that you need some particular functionality that is not currently a part of the Origin product, you can request an App through the OriginLab website. OriginLab is continually building and posting new Apps to the File Exchange.

1. To request an App, open the App Center and click the Request App button. This opens a web page on www.originlab.com.
2. Verify that the Your Reason for Contacting Us drop down is set to Request an App.
3. Fill out the remaining required fields and click the Submit Inquiry button at the bottom of the form.
As you gain experience with Origin, you may want to access Origin features programmatically, add your own custom routines and tools, or communicate with Origin from other applications. This chapter outlines basic programming options available in Origin. For more detailed information, see the following Origin programming-related resources:

- Programming documentation including guides, language references, and examples are available from the Help menu in the product.
- Online programming documentation is available at [www.originlab.com/doc](http://www.originlab.com/doc).
- You can typically locate online programming pages by performing a web search from your browser using phrases such as: labtalk importing, originc interpolate, or labview origin send data.
- Sample files for LabTalk, Python, COM Server and Client, etc. can be found in the \Samples folder of your Origin software.
20.1 LabTalk

LabTalk is a scripting language that provides access to most of Origin’s functionality. With LabTalk you can access and change properties of Origin objects such as worksheets, columns, graph layers, and data plots. LabTalk script can include calls to X-Functions to perform advanced data processing and analysis.

There are many options for executing your LabTalk scripts. Multiple lines of script can be organized as sections in a file, and those individual sections can be executed from the user-interface at the command prompt in the Script Window or Command Window; from buttons added to worksheets and graphs; from included or custom-made toolbar buttons; or from custom menu commands.

The following "mini-tutorial" will demonstrate adding a button object to a worksheet, associating a short LabTalk script with the button, then using the button to execute the script and perform a basic statistical calculation while writing the results to the worksheet.

1. Run Origin and start a new project by clicking the New Project button on the Standard toolbar.
2. Click File: Import: Single ASCII and browse to the file \Samples\Graphing\Box Chart.dat. Select the file and click Open. The file is imported into the active worksheet window.
3. With the worksheet window active, click Format: Worksheet. In the Worksheet Properties dialog, click the Size tab and set Gap from Top to 25, then click OK. A gap is added to worksheet window.
4. Click the Text Tool on the Tools toolbar. Click inside the gap that you just added and type "Add Mean Label Row" into the text object. Click outside the text object to exit edit mode.
5. Right-click on the text label and select Properties.... Choose Programming Control tab, set Script Run After to Button Up. Copy and paste the following script into the text box:

   ```labtalk
   wks.userParam1 = 1;
   wks.userParam1$ = "Mean";
   for (int ii = 2; ii <= wks.ncols; ii++)
   {
   range rr = $(ii);
   Col($(ii))\[D1]\$ = $(mean(rr),.2*);
   }
   ```
7. Click **OK** to apply settings and close the **Text Object** dialog box. Note that your text object now looks like a button.

8. Click the button. Note that a new header row labelled "Mean" is added to the worksheet and the mean value of each column of data is written to the Mean row cell above the corresponding column.

**Note:** For more information on LabTalk, Origin's built-in scripting language, please consult your product documentation at **Help: Programming: LabTalk**.

Sample files can be found in the `\Samples\LabTalk Script Examples` folder of your Origin software.

### 20.2 Python

Origin provides an embedded Python environment so that you can run Python in Origin. Origin supports command line execution from the Script Window, or the running of .py files. To access Origin from Python, you can use the supplied **PyOrigin** module.

The current embedded Python in Origin is version 3.3.5 and version 2.7.8.

**Note:** For more information on integrated usage of Origin and Python, refer to the LabTalk Scripting Guide: **Help: Programming: LabTalk > LabTalk Scripting Guide > Working with Python**.

Sample files can be found in the `\Samples\Python` folder of your Origin software.

Origin 2018b now provides an API for calling Origin from Python.

### 20.3 R

Origin supports running R commands in the Origin environment. You can issue R commands in the Script Window or from the built-in R Console, or you can run .R files. All releases of R are supported.

From Origin, you can connect with R in two ways:

- **R.** Installed on your local computer.
- **Rserve.** Installed on a remote PC.

**Note:** For more information on integrating Origin and R, refer to the Origin Help file (**R Console** and **Rserve Console**) and the LabTalk Scripting Guide (**Running R in Origin**, **R Objects**, **Rserve Objects**).

Sample files can be found in the `\Samples\R` folder of your Origin software.
### 20.4 Origin C

**Origin C** is a full-featured high-level programming language based on the ANSI C programming language syntax. Origin C also supports a number of C++ features and a few C# features. Origin C provides access to all aspects of Origin including data import, data handling, graphing, analysis, and exporting. You can access Origin C functions from interface controls such as buttons, toolbars, and menu items, using LabTalk script.

Origin C is organized as a set of functions with support for passing arguments. Origin C functions are compiled to object code and then loaded and executed inside of Origin. Origin C provides increased reliability and manageability for developing and debugging code of greater scope and complexity.

Origin C also provides access to the **NAG Numerical Library** functions included in your Origin installation. NAG functions provide you with a large selection of algorithms for performing computations ranging from simple statistics and Fourier transforms to linear algebra and multivariate analysis.

**Note:** For more information on Origin C, please refer to the Origin C documentation:

**Help:** Programming: [Origin C](#)

There you will find usage information, a language reference, developer notes, examples, etc.

Sample files can be found in the \Samples\Origin C Examples folder of your Origin software.

### 20.5 X-Function

An X-Function is a self-contained XML file that can be loaded in Origin as a special type of global function. Origin C is the language used to create X-Functions. X-Functions provide a way to expand the functionality of Origin by adding custom data processing features. Many of the built-in tools in Origin are based on X-Functions. Once an X-Function has been created, it can be accessed from anywhere in the interface that allows for script execution, such as the script window, toolbar buttons, or custom menu items.

**Note:** For more information on X-Functions, please refer to your product documentation that is installed with your software:

**Help:** Programming: [X-Functions](#)

There, you will find information on creating and using X-Functions, a language reference, and tutorials.

### 20.6 Automation Server

Origin can be used as an **Automation Server**. Client applications such as National Instruments™ LabVIEW™, Microsoft Excel, or custom VB/VC/C# applications can exchange data with Origin, and can also send commands to be executed within Origin.

**Note:** For more information on Origin's Automation Server functionality, refer to the product documentation installed with your Origin software:

**Help:** Programming: [Automation Server](#)

There you will find examples and language reference information. Sample files can be found in the \Samples\COM Server and Client folder of your Origin software.
20.7 LabVIEW

National Instruments™ LabVIEW™ is widely used for data collection. For example, many instrument and sensor vendors provide LabVIEW drivers for acquiring data. Once the data is collected, the end user will need to graph and analyze the data, and create reports for presentation. Origin provides powerful data analysis and graphing tools, including the Analysis Template feature, which allows for repeat analysis on newly acquired data. The ability to communicate between LabVIEW and Origin can thus greatly improve the efficiency of post-acquisition analysis and presentation.

Origin ships with a collection of LabVIEW sub-VIs. LabVIEW users can simply incorporate these custom sub-VIs in their main LabVIEW application to communicate seamlessly with Origin.

**Note:** For more information on Origin-LabVIEW connectivity, see the product documentation installed with your Origin software:

**Help:** [LabVIEW VI](#)

Examples and tutorials are provided.

20.8 Orglab

Orglab is a freely distributed component DLL for directly creating or reading Origin Project (.opj) and other Origin file types (.ogg, .ogw and .ogm). It is available as a free download. An Origin license is not required to use Orglab. Typical use of Orglab is for instrument manufacturers and other third-party vendors to allow their frontend software to output data as Origin files.

The Orglab module is available for both 64-bit and 32-bit systems. To find out more about Orglab and to download the Orglab module, go to the **Products > Orglab** page of [www.originlab.com](http://www.originlab.com).
# 21 Customizing Origin

## 21.1 Customizing Default Settings

### 21.1.1 Setting Preferences with the Options Dialog Box

The multi-tabbed **Options** dialog box has controls for Origin global settings pertaining to numeric display, file and system paths, text fonts, Origin program opening and closing behaviors, etc.

To open the Options dialog box:

- Choose **Tools: Options** (any Origin window is active)
- If you are working with Excel in Origin choose **Window: Origin Options** (Excel workbook is active)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Controls For</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Axis Tab</strong></td>
<td>• Max number of ticks for numeric and date/time scales</td>
</tr>
<tr>
<td></td>
<td>• Distances from the tick labels to tick marks, axis titles</td>
</tr>
<tr>
<td></td>
<td>• Display of tick labels when using scientific notation</td>
</tr>
<tr>
<td><strong>Excel Tab</strong></td>
<td>• Use of default plot assignments</td>
</tr>
<tr>
<td></td>
<td>• Scan datasets for legend text</td>
</tr>
<tr>
<td></td>
<td>• Opening Excel files by drag-and-drop</td>
</tr>
<tr>
<td><strong>File Locations Tab</strong></td>
<td>• Set file paths to track last opened, last saved, last exported file</td>
</tr>
<tr>
<td></td>
<td>• Set default path and file extension for importing different file types</td>
</tr>
<tr>
<td></td>
<td>• Set file types in ASCII import dialogs.</td>
</tr>
<tr>
<td><strong>Graph Tab</strong></td>
<td>• Dash lines definitions, line to symbol gap, user-defined symbols, etc.</td>
</tr>
<tr>
<td></td>
<td>• 2D graph anti-aliasing</td>
</tr>
<tr>
<td></td>
<td>• Enable in-place editing of linked and embedded graphs</td>
</tr>
<tr>
<td></td>
<td>• Speed mode reminder watermark</td>
</tr>
</tbody>
</table>
## Controls For

<table>
<thead>
<tr>
<th>Tab</th>
<th>Controls For</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Miscellaneous Tab</strong></td>
<td>• Printing options&lt;br&gt;• Default templates for ASCII import&lt;br&gt;• Custom date/time formats&lt;br&gt;• Footnote size ratio for report sheet&lt;br&gt;• Use of dataset names in the Origin workspace</td>
</tr>
<tr>
<td><strong>Numeric Format Tab</strong></td>
<td>• Controls for displaying scientific notation&lt;br&gt;• Controls for displayed digits in data and report sheets&lt;br&gt;• Radians, degrees or gradians&lt;br&gt;• Separators for decimal places</td>
</tr>
<tr>
<td><strong>Open/Close Tab</strong></td>
<td>• Default window closing behaviors&lt;br&gt;• Project startup, backup and autosave options</td>
</tr>
<tr>
<td><strong>Page Tab</strong></td>
<td>• Control of page size for exported graphs</td>
</tr>
<tr>
<td><strong>Text Fonts Tab</strong></td>
<td>• Default fonts for text objects&lt;br&gt;• WYSIWYG and in-place editing mode behaviors&lt;br&gt;• Size and positioning of superscripts/subscripts</td>
</tr>
<tr>
<td><strong>System Path Tab</strong></td>
<td>• Change the location of the users files, autosave and group folders&lt;br&gt;• Locations of important Origin system folders</td>
</tr>
</tbody>
</table>

### 21.1.2 System Variables Dialog

System variables are internal Origin settings that allow for the fine-tuning of a wide range of Origin behaviors. Origin’s **Set Systems Variables** dialog box (Tools: System Variables...) can be used to view and set system variable values. In the dialog, there is a link named **System Variables List** which opens a web page with a list of all system variables, the default value, and description.

To customize a particular system variable:

1. Type the system variable name in the first column, without the @ symbol. For example, if you wanted to make a global change to the **Recalculate** mode of analysis dialog boxes, type: DAM
2. Click on the 2nd column to view the current value, and type in a new value. For example, with DAM, to set **Recalculate** to **Auto**, type the value: 1.
3. Add optional comments in the third column and click **OK** to close dialog.
This modified value will be remembered and applied in every Origin session.

You can quickly read or set the value of a writable system variable in the Script Window (Window: Script Window) by typing `@systemVariable=`, as, for example ...

```
@DAM=
```

... then pressing ENTER, but note that typing in the Script Window sets the variable value for the current session only.

### 21.1.3 3D OpenGL Settings Dialog

Origin uses OpenGL (Open Graphics Library) for rendering of 3D graphs. OpenGL provides enhanced performance including fast drawing, fast rotation and zoom, transparency, and lighting support.

For optimum performance, your card should support OpenGL version 3.0 or higher. To check your hardware’s support for OpenGL, run Origin and choose Tools: 3D OpenGL Settings.... Look under OpenGL Info for information on graphics hardware and the supported version of OpenGL.

If your graphics hardware is older, you may experience compatibility issues with things such as transparency settings and anti-aliasing. The controls under the Settings node in this dialog allow you do such things as disabling transparency. The dialog box also provides information on disabling OpenGL.

For more information on OpenGL in Origin, see the links under “Topics for Further Reading” at the end of this chapter.

### 21.2 Customizing Menus

#### 21.2.1 Custom Menu Organizer

If you have scripts that are frequently run, you can add them to the menu for quick access. With the Custom Menu Organizer you can...

- Create up to 3 main menus and corresponding sub-menus
- Assign LabTalk scripts and X-Functions to a menu item
- Restrict menu item access to specific window types
- Hide unused built-in menu items, streamlining your Origin workspace

To open the Custom Menu Organizer, choose Tools: Custom Menu Organizer... from the main menu. Then press F1 or click the button in the upper-right hand corner of the dialog box for instructions.

Once you create and save a new menu configuration (.omc) file, you can then select that configuration from the Format: Menu fly-out menu. Multiple configuration files can be created, allowing you to easily switch from one configuration to another. A Default configuration is also available in the fly-out, to revert to default menu settings. Configuration files can also be shared with colleagues.

#### 21.2.2 Displaying Bitmaps in Menus

You’ll note that form some menu commands, a bitmap is displayed to the left of the menu entry. The bitmap indicates that there is an equivalent toolbar button.

On some systems such as VirtualPC or Terminal Servers, such bitmaps may cause a long delay when opening menus. To turn off the display of menu command bitmaps:

1. Select Tools: Options to open the Options dialog box.
2. Select the Miscellaneous tab, clear Display Bitmaps in Menus, and click OK.
Beginning with Origin 2018b, you can modify the size of the Plot menu icons using the LabTalk system variable @PPS. To find out how to change the value of a system variable, see Customizing Origin Using System Variables.

### 21.3 Customizing Toolbars and Buttons

In addition to the standard Windows OS toolbar customizations, Origin provides some clever and easy-to-use tools for creating, programming and distributing custom toolbar buttons. If you or your staff are performing complex but repetitive Origin routines, you’ll want to explore creating and sharing custom toolbars.

#### 21.3.1 Displaying, Hiding or Moving Toolbar buttons

- Click the small down arrow at the end of any toolbar and select the **Add or Remove Buttons** context menu. Then select desired sub menu and check/uncheck to show/hide buttons. A **Reset** option is also available.
- Press ALT key and drag a button to any new toolbar location.
- Press ALT key and drag a button to blank Origin workspace to create a new toolbar.
- Press ALT key and drag a button to any window till X shows, then release to delete the toolbar.

#### 21.3.2 Customizing Toolbar Button Appearance

Use controls on the **Options** tab (**View:Toolbars**) to:

- Show toolbar screen tips and shortcut keys on hover
- Increase toolbar and toolbar button size
- Toggle between “flat” or 3D toolbar buttons

#### 21.3.3 Displaying or Hiding a Toolbar

- Double click the left/top end of any docked toolbar to undock. Double-click on title of floating toolbar to dock.
- In floating mode, click X button to hide the toolbar. Drag it to any new location to reposition. Drag it to edge of the Origin workspace to dock.
- In docked mode, drag the left/top end of a toolbar to reposition.
- To show/hide multiple toolbars together, choose **View: Toolbars...** from the main menu. Use the check boxes on Toolbars tab to show/hide toolbars. Click the **New** button to add a new toolbar, then drag buttons from the **Button Groups** tab to add buttons on the new toolbar.
- Use the **Reset, Reset All** buttons to reset toolbars.
21.3.4 Creating New Toolbars with New Bitmap Images

Origin supports creating new toolbar buttons with Labtalk script, both built-in or user-defined script to run when click it. Choose View: Toolbars... and create new button group on Button Group tab.

- Origin ships with three button groups starting with User Defined... with a bunch of bitmap images.
- Click any button and click Settings... button to link .ogs (Script) file section with the button.
- Drag the button to Origin workspace to create toolbar button.
- If you are feeling really creative, Origin allows you to define a new button group that uses your own 16 color, 16 x 16 pixel bitmaps.
- Export the button group as an .OPX file and share it with others. The person who gets the OPX can drag and drop the OPX file onto Origin workspace to install the toolbar.

Note: To learn more about creating and exporting user-defined toolbars, see:

Help: Origin: Origin Help > Customization and Automation > Customizing Toolbars

21.3.5 Add a Custom Button to the Window Title Bar

Origin supports adding a system button to the left of the minimize button on the window title bar. A custom LabTalk script can then be associated with this button.

Note: Please view the -tbb option of the LabTalk Page command in the Programming help file:


21.4 Customizing the Status Bar

Origin uses the Status bar at the bottom of the Origin workspace to report software hints, statistics and other useful information depending upon current action, selection, window, etc.

- Right-click on Status Bar to customize the display.
- Press ALT and drag items along the Status Bar to reorder.

21.5 Customizing the Origin Workspace

Origin also supports customizing dockable windows such as the Project Explorer, Quick Help and Messages Log windows.

- Right click on the window title bar to specify dock, hide, auto hide, and other settings.
- When auto-hide is unchecked, double click to float the window.
- Drag the window title to move or dock to a new location.
- Arrange dockable windows as multiple tabs along the edge of the workspace to save screen space.
- Choose View: Toolbars... from main menu. On the Toolbar tab:
The **Reinitialize** button resets menu, toolbar and dockable windows to default settings.

The **Export** button exports the current menu, toolbar and dockable window settings to an .OPX file. Drag and drop the OPX file onto another Origin installation to configure the workspace to match your customized settings.

Occasionally, an Origin workspace component goes "missing" -- The Data Display window, one of the panels in Project Explorer, etc. When this happens, you can reset your workspace by choosing **View: Toolbars: Reinitialize**. The downside has been that this also resets workspace customizations and toolbar configurations. Beginning with Origin 2018, clicking the **Reinitialize** button produces an attention message asking if you want to restore the workspace settings from your previous version or use the 2018 system defaults.

### 21.6 Templates and Themes

The hierarchy of Origin objects such as graph pages, combined with extensive object properties, lends itself to the creation of custom settings for repeat use. You can save your custom settings either as templates or themes, described briefly in the following sections.

**Note:** For detailed information please refer to Origin Help file, see:

**Help: Origin: Origin Help > Origin Basics > Origin Template Files (OTW, OTP, OTM)**

#### 21.6.1 Templates

The Origin template concept applies to graphs, workbooks, matrix books, and Analysis Templates™. Templates allow you to choose a set of properties or operations and save those for repeat use.

For instance, Origin ships with over 100 built-in graph templates that are used to create Origin’s many science and engineering graph types. Using one of these as a starting point, you can create your own graph, adding more layers, setting scale or dimensional relationships between layers, modifying data plot properties, etc., and then save your customizations as a user-defined graph template (.otp) file by clicking **File: Save Template as...**

You cannot overwrite built-in templates (graph or otherwise). If you customize a template, then choose **Save Template as...** and attempt to overwrite the built-in template (by saving the file with the same name), the custom template will be saved to your **User Files Folder (UFF)**. This UFF copy then takes the place of the built-in template and this template will be used when clicking the corresponding menu command or toolbar button. To reconnect a built-in template with these menu commands or toolbar buttons, you will need to delete (or remove) the customized template from your UFF.

An important subset of graph templates are what are called “cloneable” templates. These templates display a "sheep" icon next to the template name or preview image. Please note, when the sheep icon is blue, it indicates that this cloneable template is applicable for current active workbook/matrix; in opposite, the gray sheep icon means this template is not suitable for current data selection. For more information, see the section on cloneable templates in **Graph Template Basics** in your Origin Help file.
The template concept extends to workbooks and matrices, as well. You can save workbook or matrix book settings, such as the number of columns and sheets, column plot designations, fonts, colors, display formats, custom header rows, scripts associated with the sheet, or dimension and coordinate settings, to .otw (workbook template) or .otm (matrix template) files.

Another important Origin template concept is the Analysis Template™. Save data operations — even complex operations such as curve fitting with resulting custom report sheets — to an analysis template (.ogw or .opj) for repeat analysis with similar data. Analysis templates are explained in more detail in the Batch Analysis section of How to Handle Repetitive Tasks chapter of this guide.

21.6.2 Themes

An Origin Theme is a file containing a set of object properties or dialog settings. Thus for example, the customized settings of a graph window can be saved as a Theme, or the customized settings in an analysis dialog can be saved as a Theme.

A Graph Theme could be as simple as an axis tick mark direction setting, or as extensive as a collection of multiple graph object properties.

Themes allow you to quickly apply a new set of properties to an object, such as a graph. For example, you might apply a black-and-white Theme to a color graph in order to prepare it for publication. Or you might take the object properties of one graph and apply them to all the other graphs in the same project.

Right click on plot, layer, object, etc. in graph or right click with nothing selected in graph and choose Copy Format context menu to copy format. Depending where you right click, the corresponding selection’s format can be copied. Then right-click on corresponding selection or right click in target graph and click Paste Format to apply the copied settings to the target selection or graph. You can also choose Edit: Paste Format... to paste the Format to multiple target graphs.
The Theme Organizer dialog box is available from the Tools menu. Use this dialog to organize graph, worksheet, and dialog themes.

With this dialog you can apply a graph theme to multiple graphs to have consistent look. To combine multiple graph themes in the Theme Organizer dialog, hold down Ctrl while selecting the Themes, and then right-click to access the Combine context menu. The context menu in the tool provides an option to edit a Theme, allowing the user to add/delete properties to an existing theme. Set a theme as system theme will apply it to future newly created graphs automatically if the graph template allows system theme to override.
The Theme concept extends to dialog box settings, as well. For instance, you can choose a particular suite of settings in the **Linear Fit** dialog box (Analysis:Fitting:Linear Fitting), and then save those settings to disk as a named Theme file. You can save multiple Theme files for a given dialog box and then recall them from the dialog, as needed. Saving multiple Themes for a dialog box allows you to customize your analysis routines from different experiments, when each requires using a specific (and unique) group of settings.
Dialog themes are explained in more detail in the *How to Handle Repetitive Tasks* chapter of this guide.

**21.7 Topics for Further Reading**

- The 3D OpenGL Settings Dialog Box
- Creating Custom Menus
- The Custom Menu Organizer
- Analysis Themes
- How to Manage Multiple Menu Configuration (.OMC) Files
- Managing Collapsible Menus
- The User Files Folder
22 Sharing Origin Files

You may want to customize some aspect of your Origin installation and then share your customizations with other Origin users. Custom settings can be saved in many file types including graph templates (.otpu) and themes (.oth), analysis templates (.ogwu or .opju), dialog themes, curve fitting functions, import wizard filters, LabTalk script files (.ogs), and X-Functions.

22.1 Drag and Drop Sharing

A quick and easy way to share a file with another user is simply to send it as an email attachment. The recipient can then drag and drop the file into the Origin workspace.

Drag-and-drop is supported for most Origin file types. Origin project (.opju) and graph template (.otpu) files automatically open when dropped into the workspace. Other files are copied to the appropriate subfolders in the User Files Folder (UFF). For example, when you drop a fitting function (.fdf) file into the workspace, a dialog opens asking how you want to categorize the new fitting function.

22.2 Sharing Files with Multiple Machines for Single Users

If you are a single user and have installed Origin on multiple machines, you can share your custom settings across multiple installations. Set up the User Files Folder (UFF) on a shared location, such as a network drive, or even a USB flash drive, and use the same UFF path with each installation.
22.3 Sharing Files with Other Users in a Network

You can set up and use a group folder to share files among users. Multiple groups are allowed, and each group can have some power user(s) set as the group leader. The group leader can use the Group Folder Manager tool to publish custom files for sharing with other group members. When group member launches Origin, the published files will be copied to their Origin automatically and ready to use.

Note: For information on group folders, see:

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Sharing Files with Multiple Clients > Group Folder Manager

22.4 Packaging Files

Origin provides a Package Manager tool for packing multiple files into a single Origin Package (.opx) file. This is a convenient way to distribute custom applications that may contain multiple Origin files, such as templates, X-Functions, and LabTalk script files. The Package Manager includes options for running LabTalk scripts before and after installation.

To access the Package Manager, click Tools, and then click Package Manager...

To install an .opx file, simply drag and drop into the Origin workspace.

Note: For information on packaging files, see:

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Packaging Multiple Files as OPX

22.5 The Origin Viewer

The Origin Viewer is a freely distributed, standalone application that allows viewing and copying of information contained in Origin project files and window (graph, worksheet, matrix) files on computers that do not have Origin installed.

- The Origin Viewer is distributed as a single EXE file - no installation needed.
- Project Explorer-like folder view with graph previews on hover, icon or details windows views, X-large icon view option.
- Open a graph in a pop-up window for better viewing.
- Supports viewing and rotating Origin’s OpenGL 3D graphs.
- Available in 32- and 64-bit versions.
The new Viewer **9.5.5** allows you to save the new Unicode-compliant OPJU project files to the pre-2018 OPJ format for sharing of projects with users of older versions of Origin.

If you have Origin graphs or data that you wish to share with colleagues who are not currently using Origin, you might direct them to the Origin Viewer page (www.originlab.com/viewer) where they can find out more and download the EXE.

**22.6 Topics for Further Reading**

- [The User Files Folder](#)
- [Attaching Files to the Origin Project](#)
- [Package Manager](#)
- [Setting Up a Group Folder](#)
- [Exporting Custom Button Groups](#)
- [Exporting Toolbar Settings](#)
- [Apps for Origin](#)
23 Origin Toolbars

This is a list of Origin toolbars, and buttons by button group. Toolbars are shown in their default configurations. You will note that some buttons are missing from default toolbar configurations. This may be because a button has been deprecated (e.g. Open Excel), because it is duplicated on another toolbar, or simply because it is a lesser-used button.

To add or remove buttons from a toolbar:

1. Click View: Toolbars to open the Customize dialog box.
2. Click on the Button Groups tab and drag desired buttons to a toolbar or to an empty portion of the workspace.
3. To remove a button/toolbar, drag it from the toolbar back to the Buttons list or click the small "x" in the upper right-corner of the toolbar (removes entire toolbar from the workspace).

Note also that some toolbar buttons have a small downward pointing arrow next to them. Clicking the tool displayed on these "split buttons" carries out the action associated with the displayed tool. Clicking the arrow beside it opens a menu, allowing you to pick another tool. A split button displays the tool that was last used.

Finally, toolbar buttons will be inaccessible (dimmed) if the object that they act on is not active. For instance, the 3D-Rotation Toolbar is only available when a 3D graph is active.

23.1 Standard

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder]</td>
<td>New Project</td>
<td></td>
<td>![Folder]</td>
<td>New Folder</td>
<td></td>
</tr>
<tr>
<td>![Doc]</td>
<td>New Workbook</td>
<td></td>
<td>![Doc]</td>
<td>New Excel</td>
<td></td>
</tr>
<tr>
<td>![Graph]</td>
<td>New Graph</td>
<td></td>
<td>![Graph]</td>
<td>New Matrix</td>
<td></td>
</tr>
<tr>
<td>![Func]</td>
<td>New Function</td>
<td></td>
<td>![Func]</td>
<td>New 2D (Function) Plot</td>
<td></td>
</tr>
<tr>
<td>![Plot]</td>
<td>New 2D Parametric (Function) Plot</td>
<td></td>
<td>![Plot]</td>
<td>New 3D (Function) Plot</td>
<td></td>
</tr>
<tr>
<td>![Plot]</td>
<td>New 3D Parametric (Function) Plot</td>
<td></td>
<td>![Layout]</td>
<td>New Layout</td>
<td></td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Hotkey</td>
<td>Button</td>
<td>Description</td>
<td>Hotkey</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------</td>
<td>--------------</td>
<td>----------</td>
<td>------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td><img src="image1" alt="icon" /></td>
<td>New Notes</td>
<td></td>
<td><img src="image2" alt="icon" /></td>
<td>Digitize Image</td>
<td></td>
</tr>
<tr>
<td><img src="image3" alt="icon" /></td>
<td>Open</td>
<td>Ctrl+O</td>
<td><img src="image4" alt="icon" /></td>
<td>Open Template</td>
<td></td>
</tr>
<tr>
<td><img src="image5" alt="icon" /></td>
<td>Open Excel</td>
<td></td>
<td><img src="image6" alt="icon" /></td>
<td>Import Excel</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td><img src="image7" alt="icon" /></td>
<td>Save Project</td>
<td>Ctrl+S</td>
<td><img src="image8" alt="icon" /></td>
<td>Save Template</td>
<td></td>
</tr>
<tr>
<td><img src="image9" alt="icon" /></td>
<td>Recalculate Auto</td>
<td></td>
<td><img src="image10" alt="icon" /></td>
<td>Recalculate Manual</td>
<td></td>
</tr>
<tr>
<td><img src="image11" alt="icon" /></td>
<td>Import Wizard</td>
<td>Ctrl+3</td>
<td><img src="image12" alt="icon" /></td>
<td>Import Single ASCII</td>
<td>Ctrl+K</td>
</tr>
<tr>
<td><img src="image13" alt="icon" /></td>
<td>Import Multiple ASCII</td>
<td></td>
<td><img src="image14" alt="icon" /></td>
<td>Batch Processing</td>
<td></td>
</tr>
<tr>
<td><img src="image15" alt="icon" /></td>
<td>Zoom In and Out by</td>
<td></td>
<td><img src="image16" alt="icon" /></td>
<td>Print</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Percentage</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image17" alt="icon" /></td>
<td>Slide Show of Graphs</td>
<td></td>
<td><img src="image18" alt="icon" /></td>
<td>Send Graphs to PowerPoint</td>
<td></td>
</tr>
<tr>
<td><img src="image19" alt="icon" /></td>
<td>Open Video Builder</td>
<td></td>
<td><img src="image20" alt="icon" /></td>
<td>Refresh</td>
<td>F5</td>
</tr>
<tr>
<td><img src="image21" alt="icon" /></td>
<td>Duplicate</td>
<td></td>
<td><img src="image22" alt="icon" /></td>
<td>Custom Routine</td>
<td></td>
</tr>
<tr>
<td><img src="image23" alt="icon" /></td>
<td>Project Explorer</td>
<td>Alt + 1</td>
<td><img src="image24" alt="icon" /></td>
<td>Object Manager</td>
<td>Alt + 8</td>
</tr>
<tr>
<td><img src="image25" alt="icon" /></td>
<td>Results Log</td>
<td>Alt + 2</td>
<td><img src="image26" alt="icon" /></td>
<td>Command Window</td>
<td>Alt + 3</td>
</tr>
<tr>
<td><img src="image27" alt="icon" /></td>
<td>Code Builder</td>
<td>Alt + 4</td>
<td><img src="image28" alt="icon" /></td>
<td>Add New Columns</td>
<td></td>
</tr>
</tbody>
</table>
### 23.2 Import

```
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Import Wizard]</td>
<td>Import Wizard</td>
<td></td>
<td>![Import Single ASCII]</td>
<td>Import Single ASCII</td>
<td></td>
</tr>
<tr>
<td>![Import Multiple ASCII]</td>
<td>Import Multiple ASCII</td>
<td></td>
<td>![Import Excel]</td>
<td>Import Excel</td>
<td></td>
</tr>
<tr>
<td>![Re-import no Dialog]</td>
<td>Re-import no Dialog</td>
<td>CTRL + 4</td>
<td>![Re-import with Dialog]</td>
<td>Re-import with Dialog</td>
<td></td>
</tr>
<tr>
<td>![Clone Import]</td>
<td>Clone Import</td>
<td></td>
<td>![Batch Processing]</td>
<td>Batch Processing</td>
<td></td>
</tr>
</tbody>
</table>
```

### 23.3 Edit

```
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Cut]</td>
<td>Cut</td>
<td>Ctrl+X</td>
<td>![Copy]</td>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>![Paste]</td>
<td>Paste</td>
<td>Ctrl+V</td>
<td>![Undo]</td>
<td>Undo</td>
<td>Ctrl+Z</td>
</tr>
</tbody>
</table>
```
### 23.4 Graph

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button]</td>
<td>Enable/Disable Anti-Aliasing</td>
<td></td>
<td>![Button]</td>
<td>Rescale</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>![Button]</td>
<td>Rescale X</td>
<td></td>
<td>![Button]</td>
<td>Rescale Y</td>
<td></td>
</tr>
<tr>
<td>![Button]</td>
<td>Rescale XY</td>
<td></td>
<td>![Button]</td>
<td>Rescale Z</td>
<td></td>
</tr>
<tr>
<td>![Button]</td>
<td>Exchange the X and Y axes</td>
<td></td>
<td>![Button]</td>
<td>Enable/Disable Speed Mode</td>
<td></td>
</tr>
<tr>
<td>![Button]</td>
<td>Extract to Layers</td>
<td></td>
<td>![Button]</td>
<td>Extract to Graphs</td>
<td></td>
</tr>
<tr>
<td>![Button]</td>
<td>Add Bottom-X Left-Y Layer</td>
<td></td>
<td>![Button]</td>
<td>Add Top-X Layer</td>
<td></td>
</tr>
<tr>
<td>![Button]</td>
<td>Add Right-Y Layer</td>
<td></td>
<td>![Button]</td>
<td>Add Top-X Right-Y Layer</td>
<td></td>
</tr>
<tr>
<td>![Button]</td>
<td>Add Inset Graph</td>
<td></td>
<td>![Button]</td>
<td>Add Inset Graph With Data</td>
<td></td>
</tr>
<tr>
<td>![Button]</td>
<td>Zoom In</td>
<td></td>
<td>![Button]</td>
<td>Zoom Out</td>
<td></td>
</tr>
<tr>
<td>![Button]</td>
<td>Whole Page</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
23.5 2D Graphs

Note that a few plot types do not have a toolbar button. The most complete list of Origin plot types is found on the Plot menu.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Line" /></td>
<td>Line</td>
<td><img src="image" alt="Horizontal Step" /></td>
<td>Horizontal Step</td>
</tr>
<tr>
<td><img src="image" alt="Vertical Step" /></td>
<td>Vertical Step</td>
<td><img src="image" alt="Spline Connected" /></td>
<td>Spline Connected</td>
</tr>
<tr>
<td><img src="image" alt="Scatter" /></td>
<td>Scatter</td>
<td><img src="image" alt="Scatter Central" /></td>
<td>Scatter Central</td>
</tr>
<tr>
<td><img src="image" alt="Column Scatter" /></td>
<td>Column Scatter</td>
<td><img src="image" alt="Y Error" /></td>
<td>Y Error</td>
</tr>
<tr>
<td><img src="image" alt="X Y Error" /></td>
<td>X Y Error</td>
<td><img src="image" alt="Vertical Drop Line" /></td>
<td>Vertical Drop Line</td>
</tr>
<tr>
<td><img src="image" alt="Bubble" /></td>
<td>Bubble</td>
<td><img src="image" alt="Color Mapped" /></td>
<td>Color Mapped</td>
</tr>
<tr>
<td><img src="image" alt="Bubble + Color Mapped" /></td>
<td>Bubble + Color Mapped</td>
<td><img src="image" alt="Line + Symbol" /></td>
<td>Line + Symbol</td>
</tr>
<tr>
<td><img src="image" alt="Line Series" /></td>
<td>Line Series</td>
<td><img src="image" alt="2 Point Segment" /></td>
<td>2 Point Segment</td>
</tr>
<tr>
<td><img src="image" alt="3 Point Segment" /></td>
<td>3 Point Segment</td>
<td><img src="image" alt="Column" /></td>
<td>Column</td>
</tr>
<tr>
<td><img src="image" alt="Column + Label" /></td>
<td>Column + Label</td>
<td><img src="image" alt="Grouped Column-Indexed Data" /></td>
<td>Grouped Column-Indexed Data</td>
</tr>
<tr>
<td><img src="image" alt="Bar" /></td>
<td>Bar</td>
<td><img src="image" alt="Stacked Column" /></td>
<td>Stacked Column</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------</td>
<td>--------</td>
<td>------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Stacked Bar" /></td>
<td>Stacked Bar</td>
<td><img src="image" alt="100% Stacked Column" /></td>
<td>100% Stacked Column</td>
</tr>
<tr>
<td><img src="image" alt="100% Stacked Bar" /></td>
<td>100% Stacked Bar</td>
<td><img src="image" alt="Floating Column" /></td>
<td>Floating Column</td>
</tr>
<tr>
<td><img src="image" alt="Floating Bar" /></td>
<td>Floating Bar</td>
<td><img src="image" alt="3D Color Pie Chart" /></td>
<td>3D Color Pie Chart</td>
</tr>
<tr>
<td><img src="image" alt="2D B&amp;W Pie Chart" /></td>
<td>2D B&amp;W Pie Chart</td>
<td><img src="image" alt="Double Y Axis" /></td>
<td>Double Y Axis</td>
</tr>
<tr>
<td><img src="image" alt="3Ys Y-YY" /></td>
<td>3Ys Y-YY</td>
<td><img src="image" alt="3Ys Y-Y-Y" /></td>
<td>3Ys Y-Y-Y</td>
</tr>
<tr>
<td><img src="image" alt="4Ys Y-YYY" /></td>
<td>4Ys Y-YYY</td>
<td><img src="image" alt="4Ys YY-YY" /></td>
<td>4Ys YY-YY</td>
</tr>
<tr>
<td><img src="image" alt="Multiple Y Axes" /></td>
<td>Multiple Y Axes</td>
<td><img src="image" alt="Stacked Lines By Y Offsets" /></td>
<td>Stacked Lines By Y Offsets</td>
</tr>
<tr>
<td><img src="image" alt="Waterfall" /></td>
<td>Waterfall</td>
<td><img src="image" alt="Waterfall Y: Color Mapping" /></td>
<td>Waterfall Y: Color Mapping</td>
</tr>
<tr>
<td><img src="image" alt="Waterfall Z: Color Mapping" /></td>
<td>Waterfall Z: Color Mapping</td>
<td><img src="image" alt="3D Waterfall" /></td>
<td>3D Waterfall</td>
</tr>
<tr>
<td><img src="image" alt="3D Waterfall Y: Color Mapping" /></td>
<td>3D Waterfall Y: Color Mapping</td>
<td><img src="image" alt="3D Waterfall Z: Color Mapping" /></td>
<td>3D Waterfall Z: Color Mapping</td>
</tr>
<tr>
<td><img src="image" alt="Vertical 2 Panel" /></td>
<td>Vertical 2 Panel</td>
<td><img src="image" alt="Horizontal 2 Panel" /></td>
<td>Horizontal 2 Panel</td>
</tr>
<tr>
<td><img src="image" alt="4 Panel" /></td>
<td>4 Panel</td>
<td><img src="image" alt="9 Panel" /></td>
<td>9 Panel</td>
</tr>
<tr>
<td><img src="image" alt="Stack" /></td>
<td>Stack</td>
<td><img src="image" alt="Multiple Panels by Label" /></td>
<td>Multiple Panels by Label</td>
</tr>
<tr>
<td><img src="image" alt="Trellis Plot" /></td>
<td>Trellis Plot</td>
<td><img src="image" alt="Box Chart" /></td>
<td>Box Chart</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------------</td>
<td>--------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td></td>
<td>Grouped Box Charts-Indexed Data</td>
<td></td>
<td>Grouped Box Charts-Raw Data</td>
</tr>
<tr>
<td></td>
<td>Interval Plot</td>
<td></td>
<td>Histogram</td>
</tr>
<tr>
<td></td>
<td>Histogram + Probabilities</td>
<td></td>
<td>Stacked Histograms</td>
</tr>
<tr>
<td></td>
<td>Marginal Histograms</td>
<td></td>
<td>Marginal Boxes</td>
</tr>
<tr>
<td></td>
<td>2D Kernel Density</td>
<td></td>
<td>QC(X-bar R) Chart</td>
</tr>
<tr>
<td></td>
<td>Pareto Chart-Binned Data</td>
<td></td>
<td>Pareto Chart-Raw Data</td>
</tr>
<tr>
<td></td>
<td>Scatter Matrix</td>
<td></td>
<td>Probability Plot</td>
</tr>
<tr>
<td></td>
<td>Q-Q Plot</td>
<td></td>
<td>Area</td>
</tr>
<tr>
<td></td>
<td>Stack Area</td>
<td></td>
<td>Fill Area</td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
<td></td>
<td>Polar theta(X) r(Y)</td>
</tr>
<tr>
<td></td>
<td>Polar r(X) theta(Y)</td>
<td></td>
<td>Wind Rose-Binned Data</td>
</tr>
<tr>
<td></td>
<td>Wind Rose-Raw Data</td>
<td></td>
<td>Ternary</td>
</tr>
<tr>
<td></td>
<td>Piper</td>
<td></td>
<td>Smith Chart</td>
</tr>
<tr>
<td></td>
<td>Radar</td>
<td></td>
<td>Vector XYAM</td>
</tr>
</tbody>
</table>
### 23.6 Add Object to Graph

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Add Color Scale</td>
<td></td>
<td></td>
<td>Reconstruct Legend</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td></td>
<td>Add Asterisk Bracket</td>
<td></td>
<td></td>
<td>Add XY Scale</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Date &amp; Time</td>
<td></td>
<td></td>
<td>Project Path</td>
<td></td>
</tr>
<tr>
<td></td>
<td>New Link Table</td>
<td></td>
<td></td>
<td>Add Bubble Scale</td>
<td></td>
</tr>
</tbody>
</table>

### 23.7 3D and Contour Graph

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3D Scatter Plot</td>
<td></td>
<td>3D Trajectory</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------</td>
<td>--------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td></td>
<td>3D Scatter + Error Bar</td>
<td></td>
<td>3D Vector XYZ XYZ</td>
</tr>
<tr>
<td></td>
<td>3D Vector XYZ dXdYdZ</td>
<td></td>
<td>3D Bars</td>
</tr>
<tr>
<td></td>
<td>3D Stacked Bars</td>
<td></td>
<td>3D 100% Stacked Bars</td>
</tr>
<tr>
<td></td>
<td>XYY 3D Bars</td>
<td></td>
<td>XYY 3D Stacked Bars</td>
</tr>
<tr>
<td></td>
<td>XYY 3D 100% Stacked Bars</td>
<td></td>
<td>3D Ribbons</td>
</tr>
<tr>
<td></td>
<td>3D Walls</td>
<td></td>
<td>3D Waterfall</td>
</tr>
<tr>
<td></td>
<td>3D Waterfall Y: Color Mapping</td>
<td></td>
<td>3D Waterfall Z: Color Mapping</td>
</tr>
<tr>
<td></td>
<td>3D Color Fill Surface</td>
<td></td>
<td>Multiple Color Fill Surfaces</td>
</tr>
<tr>
<td></td>
<td>3D X Constant with Base</td>
<td></td>
<td>3D Y Constant with Base</td>
</tr>
<tr>
<td></td>
<td>3D Colormap Surface</td>
<td></td>
<td>Multiple Colormap Surfaces</td>
</tr>
<tr>
<td></td>
<td>3D Color Fill Surface with Error Bar</td>
<td></td>
<td>3D Colormap Surface with Error Bar</td>
</tr>
<tr>
<td></td>
<td>3D Wire Frame</td>
<td></td>
<td>3D Wire Surface</td>
</tr>
<tr>
<td></td>
<td>3D Colormap Surface with Projection</td>
<td></td>
<td>3D Ternary Colormap Surface</td>
</tr>
<tr>
<td></td>
<td>Contour - Color fill</td>
<td></td>
<td>Contour - B/W Lines + Labels</td>
</tr>
</tbody>
</table>
### 23.8 3D Rotation

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Button" /></td>
<td>Rotate counterclockwise</td>
<td><img src="image2" alt="Button" /></td>
<td>Rotate clockwise</td>
</tr>
<tr>
<td><img src="image3" alt="Button" /></td>
<td>Tilt left</td>
<td><img src="image4" alt="Button" /></td>
<td>Tilt right</td>
</tr>
<tr>
<td><img src="image5" alt="Button" /></td>
<td>Tilt down</td>
<td><img src="image6" alt="Button" /></td>
<td>Tilt up</td>
</tr>
<tr>
<td><img src="image7" alt="Button" /></td>
<td>Increase perspective</td>
<td><img src="image8" alt="Button" /></td>
<td>Decrease perspective</td>
</tr>
<tr>
<td><img src="image9" alt="Button" /></td>
<td>Fit frame to layer</td>
<td><img src="image10" alt="Button" /></td>
<td>Reset Rotation</td>
</tr>
<tr>
<td><img src="image11" alt="Button" /></td>
<td>Reset</td>
<td><img src="image12" alt="Button" /></td>
<td>Rotate on any direction</td>
</tr>
<tr>
<td><img src="image13" alt="Drop-down" /></td>
<td>Rotation Angle</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## 23.9 Worksheet Data

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Statistics on Column(s)" /></td>
<td>Statistics on Column(s)</td>
<td></td>
<td><img src="image" alt="Statistics on Row(s)" /></td>
<td>Statistics on Row(s)</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Sort" /></td>
<td>Sort</td>
<td></td>
<td><img src="image" alt="Set Column Values" /></td>
<td>Set Column Values</td>
<td>Ctrl+Q</td>
</tr>
<tr>
<td><img src="image" alt="Set All Column Values" /></td>
<td>Set All Column Values</td>
<td>Ctrl+F5</td>
<td><img src="image" alt="Row number" /></td>
<td>Row number</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Uniform random numbers" /></td>
<td>Uniform random numbers</td>
<td></td>
<td><img src="image" alt="Normal random numbers" /></td>
<td>Normal random numbers</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Add/Remove Data Filter" /></td>
<td>Add/Remove Data Filter</td>
<td></td>
<td><img src="image" alt="Enable/Disable Data Filter" /></td>
<td>Enable/Disable Data Filter</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Reapply Data Filter" /></td>
<td>Reapply Data Filter</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## 23.10 Column

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Set as X" /></td>
<td>Set as X</td>
<td><img src="image" alt="Set as Y" /></td>
<td>Set as Y</td>
</tr>
<tr>
<td><img src="image" alt="Set as Z" /></td>
<td>Set as Z</td>
<td><img src="image" alt="Set as Y Error Bars" /></td>
<td>Set as Y Error Bars</td>
</tr>
<tr>
<td><img src="image" alt="Set as Labels" /></td>
<td>Set as Labels</td>
<td><img src="image" alt="Set as Disregard" /></td>
<td>Set as Disregard</td>
</tr>
<tr>
<td><img src="image" alt="Set as Grouping" /></td>
<td>Set as Grouping</td>
<td><img src="image" alt="Set as Subject" /></td>
<td>Set as Subject</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------</td>
<td>----------</td>
<td>-----------------</td>
</tr>
<tr>
<td>⬅️</td>
<td>Move to First</td>
<td>⬇️</td>
<td>Move Left</td>
</tr>
<tr>
<td>⬆️</td>
<td>Move Right</td>
<td>⬇️</td>
<td>Move to Last</td>
</tr>
<tr>
<td>⬅️️</td>
<td>Swap Columns</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 23.11 Layout

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📊</td>
<td>Add Graph</td>
<td>📊</td>
<td>Add Worksheet</td>
</tr>
</tbody>
</table>

### 23.12 Mask

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📊</td>
<td>Mask Range</td>
<td>📊</td>
<td>Unmask Range</td>
</tr>
<tr>
<td>📊</td>
<td>Change mask color</td>
<td>📊</td>
<td>Hide/Show masked points</td>
</tr>
<tr>
<td>📊</td>
<td>Swap mask</td>
<td>📊</td>
<td>Disable/Enable masking</td>
</tr>
</tbody>
</table>
## 23.13 Tools

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pointer" /></td>
<td>Pointer</td>
<td></td>
<td><img src="image" alt="Scale In" /></td>
<td>Scale In</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Scale Out" /></td>
<td>Scale Out</td>
<td></td>
<td></td>
<td>Screen Reader</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Reader" /></td>
<td>Reader</td>
<td></td>
<td><img src="image" alt="Annotation" /></td>
<td>Annotation</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Data Cursor" /></td>
<td>Data Cursor</td>
<td></td>
<td><img src="image" alt="Data Selector" /></td>
<td>Data Selector</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Selection on Active Plot" /></td>
<td>Selection on Active Plot</td>
<td></td>
<td><img src="image" alt="Selection on All Plots" /></td>
<td>Selection on All Plots</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Mask Points on Active Plot" /></td>
<td>Mask Points on Active Plot</td>
<td></td>
<td><img src="image" alt="Mask Points on All Plots" /></td>
<td>Mask Points on All Plots</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Unmask Points on Active Plot" /></td>
<td>Unmask Points on Active Plot</td>
<td></td>
<td><img src="image" alt="Unmask Points on All Plots" /></td>
<td>Unmask Points on All Plots</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Draw Data" /></td>
<td>Draw Data</td>
<td></td>
<td><img src="image" alt="Text Tool" /></td>
<td>Text Tool</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Arrow Tool" /></td>
<td>Arrow Tool</td>
<td></td>
<td><img src="image" alt="Curved Arrow Tool" /></td>
<td>Curved Arrow Tool</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Line Tool" /></td>
<td>Line Tool</td>
<td></td>
<td><img src="image" alt="Polyline Tool" /></td>
<td>Polyline Tool</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Freehand Draw Tool" /></td>
<td>Freehand Draw Tool</td>
<td></td>
<td><img src="image" alt="Rectangle Tool" /></td>
<td>Rectangle Tool</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Circle Tool" /></td>
<td>Circle Tool</td>
<td></td>
<td><img src="image" alt="Polygon Tool" /></td>
<td>Polygon Tool</td>
<td></td>
</tr>
</tbody>
</table>
### Region Tool

- **Hotkey:** Hold "A"

### Insert Equation

### Insert Excel Object

### Rescale Tool

- **Hotkey:** Hold "Z": Zoom; Hold "X": Pan

### Rotate Tool

- **Hotkey:** Hold "R"

### Insert Graph

### Insert Word Object

### Insert Object

### Insert Worksheet

---

### 23.14 Object Edit

#### Object Edit

- **Left**

- **Right**

- **Top**

- **Bottom**

- **Vertical**

- **Horizontal**

- **Uniform Width**

- **Uniform Height**

- **Group**

- **Ungroup**

- **Distribute Selected Layers/Graphic Objects Evenly in Vertical Dimension**

- **Distribute Selected Layers/Graphic Objects Evenly in Horizontal Dimension**
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Button" /></td>
<td>Front</td>
<td><img src="image2.png" alt="Button" /></td>
<td>Back</td>
</tr>
<tr>
<td><img src="image3.png" alt="Button" /></td>
<td>Forward</td>
<td><img src="image4.png" alt="Button" /></td>
<td>Backward</td>
</tr>
<tr>
<td><img src="image5.png" alt="Button" /></td>
<td>Front(data)</td>
<td><img src="image6.png" alt="Button" /></td>
<td>Back(data)</td>
</tr>
</tbody>
</table>

### 23.15 Arrow

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image7.png" alt="Button" /></td>
<td>Horizontal Alignment</td>
<td><img src="image8.png" alt="Button" /></td>
<td>Vertical Alignment</td>
</tr>
<tr>
<td><img src="image9.png" alt="Button" /></td>
<td>Widen Head</td>
<td><img src="image10.png" alt="Button" /></td>
<td>Narrow Head</td>
</tr>
<tr>
<td><img src="image11.png" alt="Button" /></td>
<td>Lengthen Head</td>
<td><img src="image12.png" alt="Button" /></td>
<td>Shorten Head</td>
</tr>
</tbody>
</table>

### 23.16 Style

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image13.png" alt="Button" /></td>
<td>Fill Color</td>
<td></td>
<td><img src="image14.png" alt="Button" /></td>
<td>Line/Border Color</td>
<td></td>
</tr>
<tr>
<td><img src="image15.png" alt="Button" /></td>
<td>Lighting Control Dialog</td>
<td></td>
<td><img src="image16.png" alt="Button" /></td>
<td>Palette</td>
<td></td>
</tr>
<tr>
<td><img src="image17.png" alt="Button" /></td>
<td>Line/Border Style</td>
<td>0.5</td>
<td></td>
<td>Line/Border Width</td>
<td></td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Hotkey</td>
<td>Button</td>
<td>Description</td>
<td>Hotkey</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>--------</td>
<td>--------</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>Fill Pattern</td>
<td></td>
<td></td>
<td>Fill Pattern Width</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pattern Color</td>
<td></td>
<td></td>
<td>Clear Borders</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Left Border</td>
<td></td>
<td></td>
<td>Top Border</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Right Border</td>
<td></td>
<td></td>
<td>Bottom Border</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Frame Borders</td>
<td></td>
<td></td>
<td>Inside Horizontal Borders</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inside Vertical Borders</td>
<td></td>
<td></td>
<td>Inside Horiz and Vert Borders</td>
<td></td>
</tr>
<tr>
<td></td>
<td>All Horizontal Borders</td>
<td></td>
<td></td>
<td>All Vertical Borders</td>
<td></td>
</tr>
<tr>
<td></td>
<td>All Borders</td>
<td></td>
<td></td>
<td>Merge cells</td>
<td>Ctrl+R</td>
</tr>
</tbody>
</table>

### 23.17 Format

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Font</td>
<td></td>
<td></td>
<td>Font size</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bold</td>
<td>Ctrl+&quot;B&quot;</td>
<td></td>
<td>Italic</td>
<td>Ctrl+&quot;I&quot;</td>
</tr>
<tr>
<td></td>
<td>Underline</td>
<td>Ctrl+&quot;U&quot;</td>
<td></td>
<td>Superscript</td>
<td>Ctrl+&quot;^&quot;</td>
</tr>
</tbody>
</table>

282
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>x₂</td>
<td>Subscript</td>
<td>Ctrl+&quot;=&quot;</td>
<td>x₁</td>
<td>Superscript</td>
<td>Ctrl+&quot;.&quot;</td>
</tr>
<tr>
<td>A⁺</td>
<td>Increase Font</td>
<td>Ctrl+&quot;&gt;&quot;</td>
<td>A⁻</td>
<td>Decrease Font</td>
<td>Ctrl+&quot;&lt;&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ctrl+Shift+&quot;,&quot;</td>
<td></td>
<td></td>
<td>Ctrl+Shift+&quot;,&quot;</td>
</tr>
<tr>
<td>αβ</td>
<td>Greek</td>
<td>Ctrl+&quot;G&quot;</td>
<td></td>
<td>Left</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Center Horizontal</td>
<td></td>
<td></td>
<td>Right</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Top</td>
<td></td>
<td></td>
<td>Center Vertical</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bottom</td>
<td></td>
<td></td>
<td>Font Color</td>
<td></td>
</tr>
</tbody>
</table>

### 23.18 Auto Update

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Block Auto Update</td>
</tr>
</tbody>
</table>
23.19 Database Access

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="SQL Editor" /></td>
<td>Open SQL Editor</td>
<td><img src="image" alt="Query Builder" /></td>
<td>Open Query Builder</td>
</tr>
<tr>
<td><img src="image" alt="ODQ File" /></td>
<td>Load ODQ File</td>
<td><img src="image" alt="Preview" /></td>
<td>Preview Import</td>
</tr>
<tr>
<td><img src="image" alt="Import" /></td>
<td>Import data</td>
<td><img src="image" alt="Remove SQL" /></td>
<td>Remove SQL</td>
</tr>
</tbody>
</table>

23.20 Markers & Locks

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add" /></td>
<td>Add Data Markers</td>
<td>Ctrl+Alt+M</td>
<td><img src="image" alt="Clear" /></td>
<td>Clear Data Markers</td>
<td>Ctrl+Alt+N</td>
</tr>
<tr>
<td><img src="image" alt="Size" /></td>
<td>Marker Size</td>
<td></td>
<td><img src="image" alt="Hide/Show" /></td>
<td>Marker Hide Show</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Lock" /></td>
<td>Lock Positions</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Index

2D Integration ................................................ 179
3D Graphing, Hardware Compatibility ........253, 255
3D Surface Fitting ............................................. 13
A
AB? ........................................................... 39, 45
ABF ........................................................... 39, 45
Active Dataset ........................................183, 186
Add Plot to Layer........................................91, 103
Analysis Markers ......................................183, 190
Analysis Reports .................................. 217, 225
Analysis Templates ....................49, 71, 217, 220, 225
Analysis Themes .................................... 253, 259
Annotating Graphs................................. 231, 237
Annotation Tool ....................................... 161, 168
ANOVA.................................................... 207, 212
Apps for Origin ........................................ 241
Apps Gallery ........................................... 21, 28
ASCII Data ................................................. 39, 40
ASCII Data, Import to Graph .................91, 106
Auto Recalculate ......................................... 217
Automating Origin .................................... 217, 229
Automation Server, Origin as ............. 247, 250
Axis Dialog Box .........................................129, 132, 138
B
Batch Plotting .................................... 217, 221
Batch Processing .................................. 217
BDF ........................................................... 39, 45
Binary 2D Array, Import ..............39, 45
Binary Data ........................................... 39, 42
BRUKER OPUS ............................................ 45
Buttons, Adding Programmable to Origin Windows253, 257
C
CDF ........................................................... 39, 45
CGM ........................................................... 39, 45
Child Windows ......................................... 21, 29
Clipboard Data, Importing .........39, 43
Code Builder ........................................ 21, 34
Collapsible Menus .................................... 21, 22
Column Label Rows, Worksheet ..........49, 54
Column Plot Designations .................. 91, 102
Column Properties Dialog Box ........... 49
Column Values, Setting ................. 49, 62
Columns, Naming ................................... 49, 50
Command Window ................................ 21, 31
Concurrent Network .................................. 3, 5
Consulting ............................................... 9
Contour Profile ....................................... 179
Convolution ......................................... 183, 204
Coordinate Values, Reading/Annotating .... 179
Coordinates, Reading/Labeling .......... 161, 173
Copy/Paste Graphs ................................ 231, 234
CSV Files ................................................. 39, 42
Curve Fit, Linear and Polynomial ..........183, 199
Curve Fit, Nonlinear ........................ 183, 199
Curve Fitting ............................................ 179
Custom Menu Organizer ..................... 253, 255
Customizing Graphs ............................. 129
Customizing Menus .................................. 253
Customizing Origin .................................. 253
Customizing Origin, Global Settings .... 253
Customizing Toolbars and Buttons ...... 253, 256
D
DAT ........................................................... 39, 45
Data Analysis ....................................... 183
Data Cursor Tool .................................. 161, 170
Data Display ......................................... 161, 170
Data Filters for Repetitive Tasks ..................................... 217
Data Info Window ...................................................................... 161, 172
Data Markers ........................................................................ 183, 189, 190
Data Points, Deleting .................................................................. 183, 194
Data Points, Drawing .................................................................. 183, 194
Data Range .................................................................................. 91
Data Reader ................................................................................. 161, 170
Data Reduction, Graphs ................................................................. 91, 109
Data Reduction, Worksheets .......................................................... 49, 71
Datasets, Creating ....................................................................... 49, 60
DCF ................................................................................................ 39, 45
Deactivate License ........................................................................ 3, 7
Derivatives, Plot .......................................................................... 179
Descriptive Statistics ................................................................... 179, 207
Developer Kit ............................................................................... 247
Dialog Box Themes ..................................................................... 217, 218, 253, 259
Differentiation .............................................................................. 179
Digitizing Scatter Plots ................................................................. 39, 46
Drag and Drop Plotting ................................................................. 91, 104
Drag-and-Drop Origin File Sharing .............................................. 263
Drag-and-Drop, Importing by ...................................................... 39, 45
DX ................................................................................................ 39, 45
DX1 ............................................................................................... 39, 45
EarthProbe ................................................................................... 39, 45
EDF ................................................................................................. 39, 45
Embed Graphs, 3rd Party Applications ........................................... 231, 234
Embed Graphs, Origin Templates ................................................. 217, 220
EPA ................................................................................................. 39, 45
ETAS INCA ..................................................................................... 39, 45
Excel ............................................................................................. 21, 30, 39, 44, 129, 247, 250, 253
Exporting a Matrix ....................................................................... 231, 239
Exporting Graphs/Layout Pages ................................................... 231, 235
Exporting Worksheets ................................................................. 231, 238
Famos ............................................................................................ 39, 45
FAQs .............................................................................................. 9
FFT ................................................................................................. 179, 183, 203
File Types, Origin ......................................................................... 37
Filtering, Origin ........................................................................... 183, 203
FLEXnet ......................................................................................... 3, 5
Full Menus .................................................................................... 21, 22
Function Plots, 2D and 3D ............................................................. 91, 95
G
Gadgets ......................................................................................... 13, 15, 161, 173, 179, 217
Graph Gallery .................................................................................. 9, 11
Graph Layer ................................................................................... 91, 97
Graph Layer Frame ....................................................................... 91, 97
Graph Page .................................................................................... 91, 97
Graph Types .................................................................................. 91, 111
Graphical Exploration of Data ...................................................... 161
Graphical Exploration Tools, Annotation ...................................... 161, 172
Graphical Exploration Tools, Data Cursor .................................. 161, 172
Graphical Exploration Tools, Data Info Window .......................... 161, 172
Graphical Exploration Tools, Data Reader .................................. 161, 172
Graphing ....................................................................................... 91
Graphing Matrix Data ................................................................... 91, 94
Graphing Virtual Matrix Data ....................................................... 91
Graphing Worksheet Data ............................................................. 91
Graphing, Functions ..................................................................... 91, 95
Graphs, Add Data by Drag and Drop ......................................... 91
Graphs, Add Plot to Layer ............................................................. 91
Graphs, Adding or Removing Plots .............................................. 91, 103
Graphs, Adding Text & Drawing Objects .................................... 129, 146
Graphs, Animating ....................................................................... 231, 237
Graphs, Cloning with New Data ................................................. 217, 221
Graphs, Copy/Paste Format ....................................................... 129, 158, 253, 259
Graphs, Copy/Paste or Embedding ............................................. 231, 234
Graphs, Creating ......................................................................... 91
Graphs, Customizing Axes ......................................................... 129, 132, 138, 140
Graphs, Customizing Data Points .............................................. 129, 137
Graphs, Customizing Grouped Plots .......................................... 129, 136
Graphs, Direct ASCII Import ..................................................... 91
Graphs, Distance Between Two Points ...................................... 161, 170
LabVIEW ........................................................ 247
LabVIEW™ .............................................. 247, 251
Layer Contents Dialog Box ................. 91, 104, 109
Layer Icon, Graph ................................... 91, 97
Layers, Graph ......................................... 91, 97
Layout Pages, Exporting ......................... 231, 235
Legend, Active Dataset ............................ 129
Legend, Auto Refresh ............................... 129
Legend, Box Charts .................................. 129, 142
Legend, Bubble Scales ............................. 129, 143
Legend, Categorical Data .......................... 129
Legend, Color Scales ............................... 129, 143
Legend, Customizing .............................. 129, 132, 140
Legend, Enhanced .................................... 129
Legend, Update vs. Reconstruct ............... 129, 142
License Management ............................... 3
License, Concurrent Network .................... 3
License, Dongle ...................................... 3, 5
License, Maintenance ............................. 3, 6
License, Node-locked ............................. 3, 5
License, System Transfers ...................... 3, 7
Limitations, Matrix ............................... 75
Limitations, Workbook ............................ 49, 57
Limitations, Workbooks ........................... 49
Lock, Recalculate ................................... 217
Magnifying Graphs ................................. 161, 162
Manual Recalculate ................................ 217
Masking Data, Graphs ............................. 183, 193
Masking Data, Remove or Disable Mask 183, 192, 194
Masking Data, Worksheets ...................... 183, 192
Mat ....................................................... 39, 45
Math Tools, Area/Volume ....................... 183, 198
Math Tools, Basic ................................. 183, 196
Math Tools, Interpolation ........................ 183, 197
MATLAB ............................................... 39, 45
Matrix Books, Naming ......................... 75, 76
Matrix Image Thumbnails ........................ 75, 82
Matrix Objects ...................................... 75, 79
Matrix Objects, Naming ......................... 75, 76
Matrix Organizer .................................... 75, 82
Matrix Sheets, Naming ........................... 75, 76
Matrix Templates ................................. 75, 82
Matrix, Converting to Worksheet .............. 75, 87
Matrix, Converting Worksheet Data ............. 75, 85
Matrix, Data Mode vs. Image Mode .......... 75, 77
Matrix, Exporting ................................ 231, 239
Matrix, Manipulating Data ...................... 75, 83
Matrix, Profiling .................................... 75, 88
Matrix, Script Panel ............................... 75, 82
Matrix, Set Values ............................... 75, 83
Matrix, Virtual ...................................... 75, 81
MDF ..................................................... 39, 45
Menus ................................................... 21, 22
Menus, Customizing .............................. 253
Menus, Organizer ................................. 21, 23
Messages Log ....................................... 21, 34
Minitab ............................................... 39, 45
MOCA .................................................. 247
Modifying Toolbars .................... 253, 256
Movies, Animating Graphs ..................... 231, 237
MPJ ..................................................... 39, 45
MTW ................................................... 39, 45
Multivariate Analysis ............................ 13, 14
Multivariate Statistics ......................... 207, 214
mzData ................................................ 39, 45
mzML .................................................. 39, 45
mzXML ............................................... 39, 45
NAG Numerical Library ....................... 247, 250
Naming Columns .................................... 49, 50
Naming Matrix Books ......................... 75, 76
Naming Matrix Objects ......................... 75, 76
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Naming Matrix Sheets</td>
<td>75, 76</td>
</tr>
<tr>
<td>Naming Workbooks</td>
<td>49, 50</td>
</tr>
<tr>
<td>Naming Worksheets</td>
<td>49, 50</td>
</tr>
<tr>
<td>National Instruments</td>
<td>39, 45</td>
</tr>
<tr>
<td>National Instruments™ LabVIEW™</td>
<td>247, 251</td>
</tr>
<tr>
<td>NC</td>
<td>39, 45</td>
</tr>
<tr>
<td>NetCDF</td>
<td>39, 45</td>
</tr>
<tr>
<td>Networks, Concurrent</td>
<td>3, 5</td>
</tr>
<tr>
<td>Networks, Installation</td>
<td>3, 5, 263, 264</td>
</tr>
<tr>
<td>Networks, Multi-seat Node-locked</td>
<td>3</td>
</tr>
<tr>
<td>Networks, Sharing Files</td>
<td>263</td>
</tr>
<tr>
<td>New Features</td>
<td>17</td>
</tr>
<tr>
<td>NI DIAdem</td>
<td>39, 45</td>
</tr>
<tr>
<td>NI TDM</td>
<td>39, 45</td>
</tr>
<tr>
<td>Node-locked, Multi-seat</td>
<td>3</td>
</tr>
<tr>
<td>Non-parametric Statistics</td>
<td>207, 213</td>
</tr>
<tr>
<td>Numbers in Origin</td>
<td>21, 35</td>
</tr>
<tr>
<td>Object Linking and Embedding (OLE)</td>
<td>231, 234</td>
</tr>
<tr>
<td>Object Manager</td>
<td>21, 29, 91, 98, 106</td>
</tr>
<tr>
<td>OGG Files</td>
<td>37</td>
</tr>
<tr>
<td>OGM Files</td>
<td>37</td>
</tr>
<tr>
<td>OGS Files</td>
<td>37</td>
</tr>
<tr>
<td>OGW Files</td>
<td>37</td>
</tr>
<tr>
<td>OIF Files</td>
<td>37</td>
</tr>
<tr>
<td>OpenGL</td>
<td>253, 255, 263, 264</td>
</tr>
<tr>
<td>OPJ Files</td>
<td>37</td>
</tr>
<tr>
<td>Options Dialog Box</td>
<td>253</td>
</tr>
<tr>
<td>OPX Files</td>
<td>263</td>
</tr>
<tr>
<td>Orglab</td>
<td>247, 251</td>
</tr>
<tr>
<td>Origin C</td>
<td>247, 250</td>
</tr>
<tr>
<td>Origin C, IDE</td>
<td>21, 34</td>
</tr>
<tr>
<td>Origin File Types</td>
<td>37</td>
</tr>
<tr>
<td>Origin Resources</td>
<td>9</td>
</tr>
<tr>
<td>Origin Toolbars</td>
<td>267</td>
</tr>
<tr>
<td>Origin Viewer</td>
<td>263, 264</td>
</tr>
<tr>
<td>Origin Workspace</td>
<td>21</td>
</tr>
<tr>
<td>Origin, Display Language</td>
<td>3, 7</td>
</tr>
<tr>
<td>Origin, License Deactivation</td>
<td>3, 7</td>
</tr>
<tr>
<td>Origin, Licensing</td>
<td>3</td>
</tr>
<tr>
<td>Origin, New Features</td>
<td>3</td>
</tr>
<tr>
<td>Origin, Registering</td>
<td>3, 5</td>
</tr>
<tr>
<td>Origin, Service Releases</td>
<td>3, 6</td>
</tr>
<tr>
<td>Origin, Sharing Files</td>
<td>263</td>
</tr>
<tr>
<td>Origin, System Transfers</td>
<td>3, 7</td>
</tr>
<tr>
<td>Origin, Uninstalling</td>
<td>3, 7</td>
</tr>
<tr>
<td>Origin, Upgrading</td>
<td>3</td>
</tr>
<tr>
<td>OriginPro</td>
<td>13</td>
</tr>
<tr>
<td>OriginPro, Features</td>
<td>13</td>
</tr>
<tr>
<td>Orthogonal Regression</td>
<td>13</td>
</tr>
<tr>
<td>OTM Files</td>
<td>37</td>
</tr>
<tr>
<td>OTP Files</td>
<td>37</td>
</tr>
<tr>
<td>OTW Files</td>
<td>37, 49, 57</td>
</tr>
<tr>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Package Manager</td>
<td>263</td>
</tr>
<tr>
<td>Packaging Origin Files</td>
<td>263</td>
</tr>
<tr>
<td>Page, Graph</td>
<td>91, 97</td>
</tr>
<tr>
<td>Panning Graphs</td>
<td>161, 162</td>
</tr>
<tr>
<td>parametric function plots</td>
<td>91, 95</td>
</tr>
<tr>
<td>Parametric Function Plots</td>
<td>91</td>
</tr>
<tr>
<td>Parametric Function Plots, 2D and 3D</td>
<td>91, 95</td>
</tr>
<tr>
<td>pClamp</td>
<td>39, 45</td>
</tr>
<tr>
<td>pCLAMP</td>
<td>39, 45</td>
</tr>
<tr>
<td>Peak Analysis</td>
<td>13, 14, 179, 183, 201</td>
</tr>
<tr>
<td>Pivot Tables</td>
<td>49, 70</td>
</tr>
<tr>
<td>Plot Designation</td>
<td>49, 91, 93</td>
</tr>
<tr>
<td>Plot Details Dialog Box</td>
<td>91, 98, 129, 133</td>
</tr>
<tr>
<td>Plot Setup Dialog Box</td>
<td>91, 99, 105, 109</td>
</tr>
<tr>
<td>Plot Type, Changing</td>
<td>91</td>
</tr>
<tr>
<td>Plots, Adding/Removing/Hiding</td>
<td>91</td>
</tr>
<tr>
<td>Plots, Exchanging</td>
<td>91, 102</td>
</tr>
<tr>
<td>Plotting Functions</td>
<td>91</td>
</tr>
<tr>
<td>Plotting Matrix Data</td>
<td>91</td>
</tr>
<tr>
<td>Plotting Virtual Matrix Data</td>
<td>91, 94</td>
</tr>
</tbody>
</table>
Plotting Worksheet Data ......................... 91, 93
PowerPoint, Exporting to ....................... 231, 236
Princeton Instruments ......................... 39, 45
Prism .................................................. 39, 45
Profiling Images .................................. 75, 88
Profiling Matrix Data ........................... 75, 88
Programming in Origin ......................... 247
Programming Origin ......................... 217, 229, 247
Programming Origin, LabTalk .................. 247, 248
Programming Origin, Origin C ............... 247
Programming Origin, Python ................. 247, 249
Programming Origin, R ....................... 247
Programming Origin, X-Functions ............ 247, 250
Programming, Developer Kit .................. 247
Programming, MOCA ............................ 247
Project Explorer ................................ 21, 24
Publishing and Export ......................... 231
PXP ................................................... 39, 45
PyOrigin Module ................................ 247
Python ............................................. 247, 249
PZFX .................................................. 39, 45
Q
QDA .................................................... 39, 45
Query Builder .................................... 39, 46
R
R 247, 249
Range, Worksheet Data ......................... 91
RAW .................................................. 39, 45
REC .................................................. 39, 45
Recalculate ....................................... 217
Recalculation of Results ...................... 217
Region of Interest ............................. 75, 77
Region of Interest (ROI) 161, 173, 174, 179, 183, 196, 197, 198, 200, 201, 217, 224
Regional Data Selector ......................... 183, 188
Re-Importing .................................... 39, 47
Repetitive Tasks, Filters for ................. 217, 227
Reports, Analysis .............................. 217, 225
Rescaling Graphs ............................... 161, 162
Results Log ...................................... 21, 34
Rise Time ........................................ 179
ROC Curve ....................................... 207, 215
Screen Reader .................................. 161, 169
Scripting ......................................... 247, 248
Selecting Data, for Plotting ................. 91
Selecting Data, Graph ....................... 183, 186, 188
Selecting Data, Worksheet ................... 91, 183
Set Column Values, Worksheet ............. 49, 62
Set Matrix Values ................................ 75, 83
Sharing Files with Multiple Users .......... 263, 264
Sharing Origin Files ......................... 263, 264
SIE .................................................. 39, 45
SigmaPlot .......................................... 39, 45
Sigmoidal Fit ..................................... 179
Signal Processing .............................. 13, 14
Signal Processing, Coherence ............... 183, 205
Signal Processing, Correlation ............. 183, 204
Signal Processing, Decimation .............. 183, 205
Signal Processing, Envelope Curves ........ 183, 205
Signal Processing, Filtering ............... 183, 203
Signal Processing, Rise Time ............... 183, 205
Signal Processing, Smoothing .............. 183, 203
Signal Processing, Transforms ............. 183, 202
Slide Show of Graphs ....................... 231, 237
Smart Hints ..................................... 21, 32
Smoother .......................................... 183, 203
Somat ............................................. 39, 45
Sorting Worksheet Data ...................... 49, 70
sparkline .......................................... 49
Sparklines ....................................... 49, 55
Index

SPC ........................................................... 39, 45
SPE ........................................................... 39, 45
Speed Mode...................................................... 91
SPSS ......................................................... 39, 45
SQL Data ................................................... 39, 46
Statistics ....................... 13, 14, 161, 173, 179, 207
Statistics, ANOVA ............................................ 207
Statistics, Basic.............................................. 207
Statistics, Charts................................. 207, 210
Statistics, Data Selection...................... 207, 208
Statistics, Descriptive ...................... 207
Statistics, Multivariate ...................... 13, 14, 207
Statistics, Non-parametric .................... 207
Statistics, Report to Script/Command Window 207, 209
Statistics, Report to Status Bar .............. 207, 208
Statistics, ROC Curve ......................... 207, 209
Statistics, Survival Analysis .................. 207
Statistics, t-Tests ............................................ 207
Status Bar .................................................. 21, 32
Surface Fit.............................. 183, 199
Surface Fitting, 3D ............................................ 13
Survival Analysis ......................... 207, 214
System Transfer................................. 3, 7
System Variables ......................... 253, 254

T
TDM .......................................................... 39, 45
TDMS ........................................................ 39, 45
Technical Support................................. 39, 45
Technical Support......................................... 9
Tektronix .................................................... 9
Templates ............................................... 253, 258
Templates, Analysis........ 49, 71, 217, 220, 225
Templates, Default Workbook .................. 49, 59
Templates, File Types ......................... 39, 45
Templates, Matrix ......................... 75, 82
Templates, Project ......................... 217, 219
Templates, Workbook ............ 49, 57, 217, 219
The Origin Interface ......................... 49, 57, 217, 219

Theme Organizer ..................... 129, 133, 159, 253, 260
Themes ................................................... 253, 255
Themes, Dialog Box ..................... 207, 218
Themes, File Types ......................... 37, 39, 45
Thermo .................................................. 39, 45
Toolbar Bitmaps, in Menus .......... 253, 255
Toolbar Buttons, Custom .............. 253, 257
Toolbars and Buttons, Customizing .. 253, 256
Toolbars, Customizing ...................... 21, 23
Tools
  Options.................................................. 253
Training............................................. 9
Transfer User Files ......................... 3, 5
T-tests ................................................... 207, 212
Tutorials, Help File ......................... 9
Tutorials, Video ................................ 9, 10

U
Update Legend ......................... 129, 132
Upgrading Origin ....................... 3
User Files Folder (UFF) .................. 3, 4, 263
User Files, Transferring .................... 3
User Forum ........................................ 9

V
Video Builder...................................... 231, 237
Video Tutorials ................................ 9
Virtual Matrix ............................. 75, 81
Visual Basic/Visual C/C#................ 247, 250

W
WAV........................................................... 39, 45
Wavelet Analysis ......................... 183, 204
What’s New in 2017 ......................... 17
Windows, Dock/Float/Auto-Hide .... 21, 34
Workbook Organizer ......................... 49, 56
Workbook Templates ......................... 49, 57
Workbooks Worksheets Columns ........ 49
Workbooks, Naming ......................... 49, 50
Worksheet Column Label Rows .......... 49, 54
Origin User Guide

Worksheet Column Properties ....................... 49, 54
Worksheet Plot Designations ......................... 91, 97
Worksheets, Converting from Matrix ............... 75, 87
Worksheets, Converting to Matrix ................. 75, 85
Worksheets, Exporting.............................. 231, 238
Worksheets, Naming .................................. 49, 50
Worksheets, Processing Data ....................... 49, 70
Worksheets, Set Column Values ..................... 49, 62
Worksheets, Sorting Data ............................ 49, 70
Worksheets, Transposing Data ...................... 49, 70
X
X-Functions ........................................... 247
XML ..................................................... 39, 45
Z
Zooming Graphs ..................................... 161, 162